PanelView Plus 7 Performance Terminals

Important User Information

Read this document and the documents listed in the additional resources section about installation, configuration, and operation of this equipment before you install, configure, operate, or maintain this product. Users are required to familiarize themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

---

**WARNING:** Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to personal injury or death, property damage, or economic loss.

**ATTENTION:** Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

**IMPORTANT** Identifies information that is critical for successful application and understanding of the product.

These labels may also be on or inside the equipment to provide specific precautions.

**SHOCK HAZARD:** Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may be present.

**BURN HAZARD:** Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach dangerous temperatures.

**ARC FLASH HAZARD:** Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE).

The following icon may appear in the text of this document.

Identifies information that is useful and can help to make a process easier to do or easier to understand.
# Table of Contents

## Preface
- Summary of Changes .................................................. 9
- Package Contents .................................................... 9
- Product Firmware and Release Notes .......................... 10
- Additional Resources ............................................... 11

## Chapter 1
**Overview**
- About the PanelView Plus 7 Performance Terminals .......... 13
- Hardware Features .................................................. 14
- Operator Control .................................................... 16
  - Touch Gestures .................................................. 17
- Software Support .................................................... 17
- Windows Operating System ..................................... 18
- Open Versus Closed System .................................... 19
  - Series A Terminals ............................................. 19
  - Series B Terminals ............................................. 19
- Desktop Access ..................................................... 19
  - Series A Terminals ............................................. 19
  - Series B Terminals ............................................. 19
- Start-up Options ................................................... 20
- EtherNet/IP Communication ................................... 20
- Typical Configuration ............................................. 20
- Catalog Number Explanation ................................. 21
- Product Selections ............................................... 22
- Accessories ........................................................ 23
- Ethernet Cables ................................................... 24

## Chapter 2
**Install the PanelView Plus 7 Performance Terminal**
- Hazardous Locations ............................................. 27
  - Required Circuit Port Parameters for USB Peripheral Devices. 28
- Mounting Considerations ...................................... 29
- Mounting Clearances ............................................. 30
- Panel Guidelines .................................................. 30
  - Panel Cutout Dimensions .................................... 30
- Prepare For Panel Mounting .................................. 31
- Mount the Aluminum Terminal in a Panel .................. 35
- Mount the Stainless Steel Terminal in a Panel ........... 38
- Outdoor Installation ............................................. 41
- Remove and Replace Power Terminal Block .................. 42
- Connect to DC Power ............................................. 43
- Connect to AC Power ............................................. 44
- Connect to a Network ............................................ 45
  - Ethernet Ports .................................................. 45
  - Device Level Ring Network Topology ...................... 48
  - Linear Network Topology .................................... 49
Table of Contents

Star Network Topology ........................................ 50
Initial Startup — Series A Terminals .......................... 50
Initial Startup — Series B Terminals ....................... 52
Calibrate the PanelView Terminal ............................. 52
Update the System Firmware .................................. 57
Enter a Password ............................................... 69
Transfer Runtime Files (.mer) .................................. 71

Chapter 3

Configure Terminal Settings

FactoryTalk View ME Station .................................... 73
Terminal Settings ............................................... 76
Soft Keyboard .................................................. 77
Load and Run Application ..................................... 78
Windows CE Desktop Access — Series A Terminals .... 79
  Enable Desktop Access ...................................... 79
  Disable Desktop Access ..................................... 80
  Set a Desktop Password ..................................... 82
  Reset the Desktop Password ............................... 83
Configure Start-up Options ................................... 84
  Disable FactoryTalk View ME Station on Startup .... 84
  Enter Configuration Mode on Startup ................... 85
  Run the Loaded Application on Startup ................. 86
Configure Controller Address ................................ 87
Configure Ethernet Settings .................................. 87
  Set the Ethernet Address of the Terminal ............ 88
  Set the Ethernet Link Speed ............................... 89
  Define Name Server Addresses ......................... 90
  Configure the Ethernet Ports ......................... 90
  View the Network Diagnostic Data ...................... 91
Modify Device Name of Terminal ........................... 92
Copy Files on Terminal ........................................ 93
Delete Files from Terminal ................................... 94
  Delete Log Files ........................................... 94
Display Settings .............................................. 95
  Adjust Display Intensity ................................. 95
  Configure the Screen Saver ............................... 95
  Disable the Screen Cursor ............................... 96
Input Device Settings ......................................... 97
  Configure Keyboard or Keypad Settings ............. 97
  Calibrate the Touch Screen .............................. 98
  Set the Double-tap Sensitivity for a Touch Screen .. 99
  Change the Popup for String Entry .................... 99
  Change Popup Input Color Settings .................... 100
Configure Print Options ...................................... 102
Configure Diagnostics ........................................ 105
Check Integrity of Application Files ................. 106
View and Clear the System Event Log ..................... 107
Enable or Disable the Alarm Display ........................................ 107
Display System Information ............................................. 108
  View Terminal Information ............................................ 108
  View FactoryTalk View ME Station Information ................. 110
Time and Date Settings .................................................. 111
  Change the Time Zone on Terminal ............................... 111
  Change the Current Date on Terminal ........................... 112
  Change the Current Time on Terminal ........................... 112
Regional Settings ......................................................... 113
  Change the Decimal Separator ...................................... 113
  Change the Time Format for a Language ........................ 114
  Change the Short Date Format for a Language ................. 115
  Change the Long Date Format for a Language ................. 115
KEPServer Driver Configuration (Series B Only) ................. 116
Certificate Management (Series B Only) ........................... 118

Chapter 4
Windows CE Operating System — Series A Terminals
  Operating System Features ........................................... 121
    Application Support .................................................. 122
    Scripting Support ..................................................... 122
    Network Support ....................................................... 122
    Server Support .......................................................... 123
    Extended Features ..................................................... 123
  Windows Explorer ..................................................... 124
  Taskbar ................................................................. 124
  Soft Input Panels ...................................................... 124
  Windows Control Panel ............................................... 125
  Backup and Restore ................................................... 126
    Perform a Backup ..................................................... 126
    Restore a Back-up Image ........................................... 128
  Display Properties ................................................... 129
    Desktop Background .................................................. 129
    Desktop Appearance .................................................. 130
    Backlight Intensity ................................................... 130
    Screen Saver ........................................................... 130
    Cursor ................................................................. 131
    Screen Rotation ........................................................ 131
  Hardware Monitor ..................................................... 132
    Processes ............................................................... 132
    System Event Log ........................................................ 132
    Monitors ............................................................... 133
  Logo Manager ........................................................... 134
  User Accounts ........................................................... 136
  Services ................................................................. 137
  Network Server Configuration ........................................ 138
    VNC Server Configuration ........................................... 138
    Web Server Configuration ........................................... 146
    FTP Server Configuration ........................................... 148
Table of Contents

File Server ................................................................. 151
KEPServer Configuration ........................................... 152
System Information .................................................. 152
  General Information .............................................. 152
  Startup Options .................................................. 153
  Device Name ....................................................... 155
Touch Properties ...................................................... 156
  Calibration ......................................................... 156
  Double-tap .......................................................... 156
PDF Reader ............................................................ 157
  Command Prompt Parameters ................................. 158

Chapter 5
Windows 10 IOT Core Operating System — Series B Terminals
  System Features .................................................... 159
  Windows Control Panel .......................................... 160
    Menu Icons ....................................................... 160
    Navigation Icons .............................................. 161
    Start Menu ..................................................... 162
    Device Info Menu ............................................. 165
    Web Browser Menu ............................................ 166
    Account Management Menu .................................. 167
    Menu Settings Screen ....................................... 168
    System Screen ................................................ 169
    Network & Wi-Fi Screen ..................................... 170
    Firmware Updates Screen .................................. 171
    Power Options Screen ....................................... 172
    Touch Screen .................................................. 173
    Services Screen .............................................. 174
    Event Log Screen ............................................. 175

Chapter 6
Install and Replace Components
  Connect to USB Ports ........................................... 178
  USB Cables ......................................................... 179
  Install a USB Printer .......................................... 179
    Series A Terminals ........................................... 179
    Plug-and-Play Installation ................................. 180
    Manual Printer Installation ............................... 181
    Series B Terminals ........................................... 182
  Insert an SD Card ................................................ 183
  Connect a Speaker ............................................... 184
  Replace the Battery ............................................. 185
  Install a Protective Overlay .................................. 187
    Clean the Overlay ........................................... 189
    Remove the Overlay .......................................... 189
  Replace the Stainless Steel Terminal Gasket ............. 189
### Table of Contents

#### Chapter 7

**Update Firmware**
- Terminal Firmware .................................................. 193
- Download Firmware Files (Series A Terminals Only) .......... 194
- Firmware Upgrade Wizard (Series A Terminals Only) ........ 195
- Upgrade Terminal Firmware from a Storage Device (Series A Terminals Only) .................................................. 195
  - Create a Firmware Update Card .................................. 195
  - Update Terminal Firmware by Using Firmware Update Card 198
- Update Terminal Firmware Over the Network (Series A Terminals Only) ................................................................. 199
- Update System Firmware (Series B Terminals Only) ........ 203
  - USB Storage Device .................................................. 203
  - ControlFLASH Client ............................................... 205
  - Using ControlFLASH Plus ......................................... 207
- Update DLR Network Switch Firmware (Series B Terminals Only) ................................................................. 213

#### Chapter 8

**Troubleshooting**
- View System Information ........................................... 217
- Status Indicators .......................................................... 218
- View Network Status Information .................................. 219
  - Series A Terminals Only ......................................... 219
  - Series A and Series B Terminals (Series C for Stainless Steel terminals) .................................................. 220
- Terminal Does Not Start Up ........................................... 220
- Terminal Restarts Intermittently .................................... 220
- Touch Screen Issues ...................................................... 221
- Display Issues ............................................................ 221
- Ethernet Issues ........................................................... 222
- Performance Is Slow .................................................... 222
- Resistance to Chemicals ............................................... 222
- Clean the Terminal Display .......................................... 223
  - Remove Paint and Grease ......................................... 223
  - Equipment Wash Downs ........................................... 223
- Ship the Terminal .......................................................... 224
- Maintenance Mode Operations — Series A Terminals ........ 224
- Maintenance Mode Operations — Series B Terminals ........ 225

#### Appendix A

**Fonts Resident on Terminal**
- True Type Fonts ......................................................... 227

#### Appendix B

**Languages Supported**
- Available Languages .................................................. 231
Summary of Changes

This manual describes how to install, configure, operate, and troubleshoot the PanelView™ Plus 7 Performance terminals. It does not provide procedures on how to create applications that run on the terminals or ladder logic that runs in the controller.

This manual contains new and updated information as indicated in the following table.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Updated the Additional Resources table.</td>
<td>11</td>
</tr>
<tr>
<td>Added an Important note to the section entitled Update the Firmware Using ControlFLASH.</td>
<td>66</td>
</tr>
</tbody>
</table>

Other tasks that you must do include:

- Create a human machine interface (HMI) application for the terminal by using FactoryTalk® View Machine Edition (ME) software, version 8.x or later.
- Create ladder logic for the controller by using the Studio 5000 Logix Designer® application.

Note: This document does not provide instructions on how to install and configure components of the ArmorView Plus 7 product. For instructions on how to do that, see the ArmorView Plus 7 Installation Instructions, publication 2711P-IN013.

Package Contents

This product is shipped with these items:

- PanelView Plus 7 Performance terminal
- Series A: With FactoryTalk View ME Station runtime software installed and activated
- Series B: With factory default firmware (must be updated with FactoryTalk View ME Station runtime software prior to deploying to production network)
- Removable power terminal block
- Product information
- Cutout template
- Quick start guide (Series B only(1))
- Mounting levers for panel installation (for aluminum terminals)
- Mounting clamps for panel installation (for stainless steel terminals)
- Backing plate (for stainless steel terminals)
- Hygienic gasket, blue (for stainless steel terminals)

For information on what is shipped with the ArmorView Plus 7 terminal, see the ArmorView Plus 7 Installation Instructions, publication 2711P-IN013.

(1) Series C for PanelView Plus 7 Performance Stainless Steel terminals.
Product Firmware and Release Notes

Product firmware and release notes are available online within the Product Compatibility and Download Center.


2. In the Search field, type the name of your product, and then click the Search icon to search for your product.

3. On the search results page, find the firmware and release notes for your product.

4. See the Product Compatibility and Download Center Quick Start Guide, publication PCDC-QS001, for instructions on how to find and download firmware and release notes for the terminal.
**Additional Resources**

These documents contain additional information concerning related products from Rockwell Automation.

<table>
<thead>
<tr>
<th>Resource</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PanelView Plus 7 Performance Specifications, publication 2711P-TD009</td>
<td>Provides technical specifications, environmental specifications, and certifications for the performance models of the PanelView Plus 7 Performance terminals.</td>
</tr>
<tr>
<td>PanelView Plus 7 Performance Series B Terminals Quick Start, publication 2711P-QS002</td>
<td>Provides instructions on how to configure and install the PanelView Plus 7 Performance Series B terminals. Also describes how to update the firmware for these terminals.</td>
</tr>
<tr>
<td>PanelView Plus 7 Performance Series B Terminals Important Information, publication 2711P-RN005</td>
<td>Lists the functions of the PanelView Plus 7 Performance Series A terminals that are not included in the initial version of the PanelView Plus 7 Performance Series B terminals. Also indicates which of these functions will be available in a future release.</td>
</tr>
<tr>
<td>EtherNet/IP Device Level Ring Application Technique, publication ENET-AT007</td>
<td>Provides information on how to install, configure, and maintain linear and Device Level Ring (DLR) networks using Rockwell Automation® EtherNet/IP devices with embedded switch technology.</td>
</tr>
<tr>
<td>ArmorView Plus 7 Installation Instructions, publication 2711P-IN013</td>
<td>Provides instructions on how to install, configure, troubleshoot, and maintain the ArmorView Plus 7 terminal.</td>
</tr>
<tr>
<td>Industrial Automation Wiring and Grounding Guidelines, publication 1770-4.1</td>
<td>Provides general guidelines for installing a Rockwell Automation industrial system.</td>
</tr>
<tr>
<td>Guidelines for Handling Lithium Batteries Technical Data, publication AG-5.4</td>
<td>Provides guidelines for how to store handle, install, and dispose of lithium batteries.</td>
</tr>
<tr>
<td>Product Certifications website: rok.auto/certifications</td>
<td>Provides declarations of conformity, certificates, and other certification details.</td>
</tr>
</tbody>
</table>

Notes:
Chapter 1

Overview

About the PanelView Plus 7 Performance Terminals

The PanelView™ Plus 7 Performance terminals are operator interface devices. They monitor and control devices that are attached to ControlLogix® and CompactLogix™ controllers on an EtherNet/IP™ network. Animated graphic and text displays provide operators a view into the operating state of a machine or process. Operators interact with the control system by using touch screen or keypad input.

Features include the following:

- FactoryTalk® View Machine Edition software provides a familiar environment for creating HMI applications.
- Microsoft® Windows® operating system:
  - Series A (and Stainless Steel Series A and B): Windows CE 6.0
  - Series B (and Stainless Steel Series C): Windows 10 IoT Core
- Ethernet communication that can support Device Level Ring (DLR), linear, or star network topologies.
- Web browser, Microsoft file viewers, text editor, PDF viewer, remote connection capabilities.
- Conformal-coating available for all DC power, touch-only terminals and the 15-inch DC power, touch and keypad terminal.
• Stainless steel, hygienic, brandless, DC-power, and conformal-coating are available for the 9-in. wide-screen, touch-only units and the 12-in. wide-screen, touch-only units.
• On-machine mounting available for the 12-in. terminal. For information on the options available, see the ArmorView™ Plus 7 Installation Instructions, publication 2711P-IN013.

Hardware Features

The PanelView Plus 7 Performance terminals feature fixed hardware configurations with a range of display sizes and operator input options.

Stainless steel terminals use mounting clips. All other hardware features are the same as the aluminum terminals.

Table 1 - Hardware Features(1)

<table>
<thead>
<tr>
<th>Item</th>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Display/Keypad | TFT color graphic displays with a touch screen and navigation button in a range of sizes. Some models also have a keypad and function keys providing additional operator input options:  
• 6.5-in. touch, or touch with keypad  
• 9-in. widescreen touch  
• 10.4-in. touch, or touch with keypad  
• 12.1-in. widescreen touch  
• 15-in. touch, or touch with keypad  
• 19-in. touch |
| 2    | Power | AC or DC(3) power input:  
• 18…30V DC (isolated), aluminum and stainless steel terminals  
• 100…240V AC (nom), only aluminum terminals (Series A terminals only) |
| 3    | Mounting slot (aluminum terminals) | Slots on top, bottom, and sides of terminal are for mounting levers to mount the device to a panel or enclosure. The number of slots varies by terminal size. |
| 3    | Mounting slot (stainless steel terminals) | Slots on top, bottom, and sides of terminal are for mounting clips to mount the device to a panel or enclosure. The number of slots varies by terminal size. |
| 4    | Ethernet ports | Two 10/100Base-T, Auto MDI/MDI-X, Ethernet ports for controller communication supporting Device Level Ring (DLR) network topology. |
Table 1 - Hardware Features (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>USB host ports</td>
<td>Series A: Two 2.0 USB ports Series B (Series C for Stainless Steel terminals): One 2.0 USB port and one 3.0 USB port</td>
</tr>
<tr>
<td>6</td>
<td>USB device port</td>
<td>IMPORTANT: The device port is not functional. Do not use this port.</td>
</tr>
<tr>
<td>7</td>
<td>Audio out (2)</td>
<td>One audio out port supports connection to a 4 Ω or 8 Ω speaker or amplifier (not initially supported on Series B (Series C for Stainless Steel terminals), however USB audio is supported).</td>
</tr>
<tr>
<td>8</td>
<td>Maintenance Mode button</td>
<td>Only available on Series B terminals (Series C for Stainless Steel terminals), this button allows you to enter maintenance menu mode, which is used to restore factory defaults, backup and restore terminal settings, and calibrate the touchscreen, etc.</td>
</tr>
<tr>
<td>9</td>
<td>Status indicators</td>
<td>Light-emitting diodes on the back of the terminals provide status and fault conditions.</td>
</tr>
<tr>
<td>10</td>
<td>Secure Digital (SD) card slot</td>
<td>One SD card slot supports catalog number 1784-SDx and 1784-SDHCx, hot-swappable, SD card for external storage.</td>
</tr>
</tbody>
</table>

(1) For information about the hardware features of the ArmorView Plus 7 terminal, see the ArmorView Plus 7 Installation Instructions, publication 2711P-IN013.

(2) Series A: The speaker works in the Windows CE operating system (Windows Media Player). FactoryTalk View ME Station software does not support the speaker. Series B (Series C for Stainless Steel terminals): The USB audio works in the Windows 10 IoT operating system through the Edge web browser.

(3) Series A terminals are available with AC or DC power. Series B terminals (Series C for Stainless Steel terminals) are available only with DC power.
Operator Control

All terminals have a color display with a touch screen, or touch screen and keypad, for operator control.

- Analog resistive touch screens provide accurate and durable touch control for industrial applications.
- Keypad models are similar except for the number of function keys to the left and right of the display. Larger models have more keys.

**ATTENTION:** The keypad and touch screen accept input from a finger, stylus, and gloved-hand for operation in dry or wet environments. The plastic stylus must have a minimum tip radius of 1.3 mm (0.051 in.). Any other object or tool can damage the keypad or touch screen.

**ATTENTION:** To help prevent unintended operation, do not conduct multiple operations simultaneously.
- Touch only one operating element on the touch screen with one finger at one time.
- Press only one key on the terminal at one time.

Table 2 - Terminal Keypad

<table>
<thead>
<tr>
<th>Item</th>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Numeric keypad</td>
<td>Contains numeric, decimal, minus, and the following keys:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Backspace - deletes the character to the left of the insertion point.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Enter - inputs the currently highlighted key or enters a blank line if</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the insertion point is in the text box of the virtual keyboard.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tab-left, Tab-right - selects the previous or next control or input element.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Esc - cancels or dismisses a dialog.</td>
</tr>
<tr>
<td>2</td>
<td>Navigation keys</td>
<td>Provides navigation control.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Arrow keys - selects a key on the virtual keyboard that is above, below,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>left, or right of the selected key. Moves the cursor in selected direction</td>
</tr>
<tr>
<td></td>
<td></td>
<td>if in the text box.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Home/End - moves the insertion point to the beginning or end of a text or</td>
</tr>
<tr>
<td></td>
<td></td>
<td>numeric entry field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Page up/Page down - goes to the next or previous pages of a list.</td>
</tr>
<tr>
<td>3</td>
<td>Function keys</td>
<td>Performs specific commands if events are configured for a screen or any of</td>
</tr>
<tr>
<td></td>
<td>6.5-in. terminal</td>
<td>its graphic elements. For example, F1 can be configured to navigate to</td>
</tr>
<tr>
<td></td>
<td>10-in. terminal</td>
<td>another screen.</td>
</tr>
<tr>
<td></td>
<td>15-in. terminal</td>
<td>• F1…F6 and F7…F12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• F1…F8 and F9…F16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• F1…F10 and F11…F20</td>
</tr>
</tbody>
</table>
**Touch Gestures**

The touch screen supports touch gestures to interact with screen elements during runtime. Standard touch gestures include:

- **Tap** – Briefly touch the target on the screen with your fingertip.
- **Double-tap** – Touch the target on the screen twice quickly with your fingertip.
- **Drag** – Touch the target and move your fingertip across the screen without losing contact.
- **Long press** – Touch and hold the target on the screen for several seconds.

**Software Support**

**IMPORTANT** It is the responsibility of the customer to be sure that any third-party software, updates, patches, or firmware that is installed is free of malicious programs, spyware, and so on.

<table>
<thead>
<tr>
<th>Software</th>
<th>Description</th>
<th>Version</th>
</tr>
</thead>
</table>
| FactoryTalk View Machine Edition (ME) Station | Runtime environment of terminal:  
  - Runs FactoryTalk View ME applications.  
  - Provides options to view and configure terminal settings.  
  Machine Edition Station is pre-loaded on each terminal and does not require activation. | 8.x or later |
| FactoryTalk View Studio for Machine Edition   | Software for developing HMI applications that run on terminal. RSLinx® software is included with FactoryTalk View Studio software and loaded during installation. | 8.x or later |
| FactoryTalk ViewPoint                         | A web server application that lets remote users access and control the HMI application running on a terminal by using an internet browser.  
One license is embedded with each terminal to support one client connection to a terminal. | 8.x or later |
Chapter 1

Windows Operating System

Series A terminals run the Windows CE 6.0 operating system, and Series B\(^{(1)}\) terminals run the Windows 10 IoT Core operating system. These terminals both run the same FactoryTalk View Machine Edition applications.

Table 4 - Features

<table>
<thead>
<tr>
<th>Standard Features</th>
<th>Series A</th>
<th>Series B(^{(3)})</th>
</tr>
</thead>
<tbody>
<tr>
<td>FTP server</td>
<td>--</td>
<td>Yes</td>
</tr>
<tr>
<td>Secure FTP server</td>
<td>--</td>
<td>No</td>
</tr>
<tr>
<td>VNC client and server</td>
<td>--</td>
<td>Yes</td>
</tr>
<tr>
<td>Secure VNC server</td>
<td>--</td>
<td>No</td>
</tr>
<tr>
<td>ActiveX controls (^{(1)})</td>
<td>--</td>
<td>Yes</td>
</tr>
<tr>
<td>Third-party controller support</td>
<td>--</td>
<td>Yes</td>
</tr>
<tr>
<td>PDF reader</td>
<td></td>
<td>FoxIt</td>
</tr>
<tr>
<td>Web browser</td>
<td></td>
<td>Internet Explorer 6</td>
</tr>
<tr>
<td>Remote desktop client</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Media player</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Microsoft Office file viewers</td>
<td></td>
<td>Yes (^{(4)})</td>
</tr>
<tr>
<td>- PowerPoint</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>- Excel</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>- Word</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>- Image viewer</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>WordPad text editor</td>
<td></td>
<td>Yes</td>
</tr>
</tbody>
</table>

\(^{(1)}\) For a complete list of ActiveX controls, go to [https://rockwellautomation.custhelp.com](https://rockwellautomation.custhelp.com) and search the Knowledgebase for keywords ‘ActiveX Support for PanelView Plus Terminals.’

\(^{(2)}\) See [View FactoryTalk View ME Station Information on page 110](#) to view a list of ActiveX controls installed on terminal.

\(^{(3)}\) Series C for Stainless Steel terminals.

\(^{(4)}\) Not available on the initial release.
Chapter 1

Open Versus Closed System

Series A Terminals

On Series A terminals, you can configure a terminal to run an open or closed desktop environment:

- An open system launches the Windows CE desktop on startup.

Desktop access is restricted.

Series A terminals are shipped as closed systems with desktop access disabled. The first time that you start the system, the terminal launches FactoryTalk View ME Station Configuration mode. At this point, you can change the startup option and allow desktop access.

Series B Terminals

Series B terminals are shipped as closed systems and there is no desktop available on the Windows 10 IoT Core operating system.

Desktop Access

Series A Terminals

On Series A terminals, you can allow or restrict access to the Windows desktop on the terminal. From the desktop, you can perform system and control panel operations, use Microsoft file viewers, run third-party applications, and launch the web browser. You can also provide temporary access to perform specific tasks, then disable desktop access to help prevent unauthorized changes.

TIP All terminals are initially shipped with desktop access disabled.

See Windows CE Desktop Access — Series A Terminals on page 79 for details on how to modify desktop access.

Series B Terminals


(1) Series C for Stainless Steel terminals.
Start-up Options

The terminal can perform one of three actions at startup:

- Launch FactoryTalk View Machine Edition Station in Configuration mode. This mode lets you configure terminal settings and start-up options, load applications to run, and so on.
- Launch the Windows desktop (available on Series A terminals only).

The factory default state and start-up option following a firmware update is to launch the terminal in Configuration mode. See Configure Start-up Options on page 84 for details on how to change the start-up option.

For a list of actions you can perform using touch gestures, see the FactoryTalk View Machine Edition help.

EtherNet/IP Communication

The PanelView Plus 7 Performance terminals use an EtherNet/IP embedded switch. These terminals communicate with ControlLogix and CompactLogix controllers over an Ethernet connection with DLR, linear, or star network topologies.

The terminals can reside on EtherNet/IP networks that run integrated motion and CIP Sync™ applications without affecting performance. The terminal is not a consumer or producer of CIP Sync or motion packets.

Typical Configuration

Traditional DLR, linear, and star network topologies are supported. See these topics for examples:

- Device Level Ring Network Topology on page 48
- Linear Network Topology on page 49
- Star Network Topology on page 50
Chapter 1

Catalog Number Explanation

This section provides an explanation of the catalog numbers.

<table>
<thead>
<tr>
<th>Bulletin</th>
<th>Input Type</th>
<th>Display Size</th>
<th>Display Type</th>
<th>Network</th>
<th>Power</th>
<th>Operating System</th>
<th>Model</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>2711P-</td>
<td>T = Touch</td>
<td>7 = 6.5-in.</td>
<td>C = Color</td>
<td>22 = Ethernet DLR ports</td>
<td>A = AC (Series A only)</td>
<td>9 = Windows CE 6.0 (Series A and Series B for Stainless Steel) or 9 = Windows 10 IoT Core (Series B and Series C for Stainless Steel Terminals)</td>
<td>P = Performance</td>
<td>B = No brand identity</td>
</tr>
</tbody>
</table>

- B = Key and Touch
- 9 = 9-in.
- W = Wide aspect ratio color
- D = DC
- BSHK (1) = No brand identity, stainless steel, hygienic, conformal coated
- K = Conformal coated
- BM001–BM016 (2) = ArmorView Plus 7 terminal

10 = 10.4-in.
12 = 12.1-in.
15 = 15-in.
19 = 19-in.

(1) The -BSHK terminals are available in 9-in. and 12.1-in. touch screen terminals, with DC power, and without the Allen-Bradley logo.

(2) The ArmorView Plus 7 product includes a 12.1-in. PanelView Plus 7 Performance terminal and a 1732E ArmorBlock® EtherNet/IP I/O module. Both products are enclosed in a cast aluminum assembly that can be mounted on a machine, an arm mount system, a VESA-compatible bracket (with the optional VESA kit), or a pedestal. To order an ArmorView Plus 7 terminal, add BM001 . . . BM016 to the 12.1-in. PanelView Plus 7 Performance touch terminal, 2711P-T12W22D9P. For explanations of the ArmorView Plus 7 catalog numbers, see the ArmorView Plus 7 Installation Instructions, publication 2711P-IN013.
### Table 5 - PanelView Plus 7 Performance Terminal Product Selections

<table>
<thead>
<tr>
<th>Cat. No.</th>
<th>Display</th>
<th>Ethernet</th>
<th>Power</th>
<th>Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>2711P-T7C22D9P</td>
<td>6.5-in. VGA TFT Color</td>
<td>Yes</td>
<td>AC or DC</td>
<td>512 MB</td>
</tr>
<tr>
<td>2711P-T9W22D9P</td>
<td>9-in. (wide) WVGA TFT Color</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2711P-T10C22D9P</td>
<td>10.4-in. SVGA TFT Color</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2711P-T12W22D9P</td>
<td>12.1-in. WXGA TFT Color</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2711P-T15C22D9P</td>
<td>15-in. XGA TFT Color</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2711P-T19C22D9P</td>
<td>19-in. SXGA TFT Color</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

(1) Add -B to the end of a catalog number to order a terminal without the Allen-Bradley logo and product identification, for example, 2711P-T7C22D9P-B.

(2) This terminal includes conformal coating.

(3) To order an ArmorView Plus 7 terminal, add BM001…BM016 to the 12.1-in. PanelView Plus 7 Performance touch terminal, 2711P-T12W22D9P. For explanations of the ArmorView Plus 7 catalog numbers, see the ArmorView Plus 7 Installation Instructions, publication 2711P-IN013.

(4) AC power is only available on Series A terminals.

(5) Series C for stainless steel terminals.

(6) Memory available for user to store applications.
Table 6 through Table 10 list accessories for the PanelView Plus 7 Performance terminals.

For a list of accessories that are available for the ArmorView Plus 7 terminal, see the Visualization Solutions Selection Guide, publication VIEW-SG001.

**Table 6 - Protective Overlays**

<table>
<thead>
<tr>
<th>Cat. No.</th>
<th>Display Size</th>
<th>Operator Input</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>2711P-RGT7SP</td>
<td>6.5-in.</td>
<td>Touch</td>
<td></td>
</tr>
<tr>
<td>2711P-RGB7P</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>2711P-RGT9SP</td>
<td>9-in. (wide)</td>
<td>Touch</td>
<td></td>
</tr>
<tr>
<td>2711P-RGT10SP</td>
<td>10.4-in.</td>
<td>Touch</td>
<td>3</td>
</tr>
<tr>
<td>2711P-RGB10P</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>2711P-RGT12SP</td>
<td>12.1-in. (wide)</td>
<td>Touch</td>
<td></td>
</tr>
<tr>
<td>2711P-RGT15SP</td>
<td>15-in.</td>
<td>Touch</td>
<td></td>
</tr>
<tr>
<td>2711P-RGB15P</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>2711P-RGT19P</td>
<td>19-in.</td>
<td>Touch</td>
<td></td>
</tr>
</tbody>
</table>

(1) The use of protective overlays may not be compatible in all hygienic applications. Consult the standards and protocols for your hygienic applications before you use a protective overlay on a stainless steel terminal.

**Table 7 - Power Supplies and Power Terminal Blocks**

<table>
<thead>
<tr>
<th>Cat. No.</th>
<th>Description</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1606-XLP95E</td>
<td>DIN rail power supply, 24...28V DC output voltage, 95 W</td>
<td>1</td>
</tr>
<tr>
<td>1606-XLP100E</td>
<td>DIN rail power supply, 24...28V DC output voltage, 100 W</td>
<td>1</td>
</tr>
<tr>
<td>2711P-RSACDIN</td>
<td>DIN rail power supply, AC-to-DC, 85...265V AC, 47...63 Hz</td>
<td>1</td>
</tr>
<tr>
<td>2711P-RTBAP</td>
<td>3-pin AC power terminal block (gray with black labels for L1, L2N, and</td>
<td>10</td>
</tr>
<tr>
<td>2711P-RTBDSP</td>
<td>- +, –, and GND)</td>
<td></td>
</tr>
<tr>
<td>2711P-RTBDS</td>
<td>3-pin DC power terminal block (black with white labels for +, –, and GND)</td>
<td>10</td>
</tr>
</tbody>
</table>

**Table 8 - Mounting Hardware**

<table>
<thead>
<tr>
<th>Cat. No.</th>
<th>Description</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>2711P-RMCP(1)</td>
<td>Mounting levers (black)</td>
<td>16</td>
</tr>
<tr>
<td>2711P-RTMC(2)</td>
<td>Mounting clips</td>
<td>8</td>
</tr>
</tbody>
</table>

(1) Catalog number 2711P-RMCP mounting levers are used with PanelView Plus 7 Performance terminals. Do not use gray mounting levers; they are not compatible with PanelView Plus 7 Performance terminals.

(2) Catalog number 2711P-RTMC mounting clips are used for stainless steel terminals, catalog numbers 2711P-T9W22D9P-BSHK, or 2711P-T12W22D9P-BSHK. Catalog number 2711P-T12W22D9P-BSHK requires 10 mounting clips. If you need more than eight clips, order two 2711P-RTMC mounting clip kits.
Table 9 - Secure Digital (SD) Cards(1)

<table>
<thead>
<tr>
<th>Cat. No.</th>
<th>Description</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1784-SD1</td>
<td>1 GB SD card</td>
<td>1</td>
</tr>
<tr>
<td>1784-SD2</td>
<td>2 GB SD card</td>
<td>1</td>
</tr>
<tr>
<td>1784-SDHC8</td>
<td>8 GB High Capacity SD card</td>
<td>1</td>
</tr>
<tr>
<td>1784-SDHC32</td>
<td>32 GB High Capacity SD card</td>
<td>1</td>
</tr>
<tr>
<td>2711C-RCSD</td>
<td>USB to SD adapter for SD card</td>
<td>1</td>
</tr>
</tbody>
</table>

(1) To help reduce the chance of corruption when you use SD Cards or USB drives with the terminal, Rockwell Automation recommends that you use only the above SD card catalog numbers.

Table 10 - Battery Replacement

<table>
<thead>
<tr>
<th>Cat. No.</th>
<th>Description</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>2711P-RY2032</td>
<td>Lithium coin-cell battery, CR2032 equivalent</td>
<td>1</td>
</tr>
</tbody>
</table>

Table 11 - Hygienic Gasket Replacement Kits for Stainless Steel Terminals

<table>
<thead>
<tr>
<th>Cat. No.</th>
<th>Description (1)</th>
<th>Terminal Series</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>2711P-RGST9W</td>
<td>Hygienic gasket, blue silicone For 9-in. Series A Stainless Steel Terminals</td>
<td>A</td>
<td>1</td>
</tr>
<tr>
<td>2711P-RGST12W</td>
<td>Hygienic gasket, blue silicone For 12-in. Series A Stainless Steel Terminals</td>
<td>A</td>
<td>1</td>
</tr>
<tr>
<td>2711P-RGST9WB</td>
<td>Hygienic gasket, blue, silicone, with ribs For 9-in. Series B or C Stainless Steel Terminals</td>
<td>B or C</td>
<td>1</td>
</tr>
<tr>
<td>2711P-RGST12WB</td>
<td>Hygienic gasket, blue, silicone, with ribs For 12-in. Series B or C Stainless Steel Terminals</td>
<td>B or C</td>
<td>1</td>
</tr>
</tbody>
</table>

(1) Gasket material is compliant with FDA 21 CFR 177.2600.

**IMPORTANT**

Before you select the appropriate replacement gasket, you must identify the series of the PanelView Plus 7 Performance Stainless Steel terminal. The terminal’s series information is located on the terminal’s product nameplate label. In the following table, gaskets that are listed for use on Series B or C terminals are not certified for use on Series A terminals, and gaskets that are listed for use on Series A terminals are not certified for use on Series B or C terminals.

**Ethernet Cables**

See the Industrial Ethernet Media Brochure, publication 1585-BR001, for recommended Ethernet cables and media solutions.

See the USB to Serial Adapter Quick Start Guide, publication GMSC10-QS003, for information on USB to serial port adapters.
Chapter 2

Install the PanelView Plus 7 Performance Terminal

This chapter describes how to install a PanelView terminal in the door or wall of a NEMA rated, UL Type rated, or IP rated enclosure. For instructions on how to install the PanelView terminal on a machine, pedestal, or wall, see the ArmorView™ Plus 7 Installation Instructions, publication 2711P-IN013.

ATTENTION: Do not use a PanelView Plus 7 Performance terminal for emergency stops or other controls critical to the safety of personnel or equipment. Use separate hard-wired operator interface devices that do not depend on solid-state electronics. Some configurations of the ArmorView Plus 7 terminal include a separate emergency stop button that can be hard-wired.
ATTENTION: Environment and Enclosure

This equipment is intended for use in a Pollution Degree 2 industrial environment, in overvoltage Category II applications (as defined in IEC 60664-1), at altitudes up to 2000 m (6561 ft) without derating.

The terminals are intended for use with programmable logic controllers. Terminals that are AC powered must be connected to the secondary of an isolating transformer.

This equipment is considered Group 1, Class A industrial equipment according to IEC CISPR 11. Without appropriate precautions, there may be difficulties with electromagnetic compatibility in residential and other environments due to conducted or radiated disturbances.

Korean Radio Wave Suitability Registration - When so marked this equipment is registered for Electromagnetic Conformity Registration as business equipment (A), not home equipment. Sellers or users are required to take caution in this regard.

이 기기는 업무용 (A 급 ) 전자파적합기기로서 판 매자 또는 사용자는 이 점을 주의하시 기 바라 며 , 가정외의 지역에서 사용하는 것을 목적으로 합니다 .

This equipment is supplied as open-type equipment. It must be mounted within an enclosure that is suitably designed for those specific environmental conditions that will be present and appropriately designed to prevent personal injury resulting from accessibility to live parts. The interior of the enclosure must be accessible only by the use of a tool. The terminals meet specified NEMA, UL Type, and IEC ratings only when mounted in a panel or enclosure with the equivalent rating. Subsequent sections of this publication may contain additional information regarding specific enclosure type ratings that are required to comply with certain product safety certifications.

In addition to this publication, see the following:
- Industrial Automation Wiring and Grounding Guidelines, publication 1770-4.1, for additional installation requirements.
- NEMA 250 and IEC 60529, as applicable, for explanations of the degrees of protection provided by different types of enclosure.

ATTENTION: Wiring and Safety Guidelines

Use publication NFPA 70E, Electrical Safety Requirements for Employee Workplaces, IEC 60364 Electrical Installations in Buildings, or other applicable wiring safety requirements for the country of installation when wiring the devices. In addition to the NFPA guidelines, here are some other guidelines to follow:

- Employ only qualified electricians to wire the device in accordance with local, state, and national codes.
- Connect the device and other similar electronic equipment to its own branch circuit.
- Protect the input power by a fuse or circuit breaker rated at no more than 15 A.
- Route incoming power to the device by a separate path from the communication lines.
- Cross power and communication lines at right angles if they must cross.
- Communication lines can be installed in the same conduit as low-level DC I/O lines (less than 10V).
- Shield and ground cables appropriately to avoid electromagnetic interference (EMI). Grounding minimizes noise from EMI and is a safety measure in electrical installations.

For more information on grounding recommendations, see the National Electrical Code published by the National Fire Protection Association.
Hazardous Locations

This section provides information for hazardous locations.

The following information applies when operating this equipment in hazardous locations.

When marked, these products are suitable for use in "Class I, Division 2, Groups A, B, C, D"; Class I, Zone 2, Group IIC hazardous locations and nonhazardous locations only. Each product is supplied with markings on the rating nameplate indicating the hazardous location temperature code. When combining products within a system, the most adverse temperature code (lowest "T" number) may be used to help determine the overall temperature code of the system. Combinations of equipment in your system are subject to investigation by the local Authority Having Jurisdiction at the time of installation.

The terminals(1) have a temperature code of T4 when operating in a 55 °C (131 °F) maximum ambient temperature. Do not install product in environments where atmospheric gases have ignition temperatures less than 135 °C (275 °F).

---

**WARNING: EXPLOSION HAZARD**

- Do not disconnect equipment unless power has been removed or the area is known to be nonhazardous.
- Do not disconnect connections to this equipment unless power has been removed or the area is known to be nonhazardous. Secure any external connections that mate to this equipment by using screws, sliding latches, threaded connectors, or other means provided with this product.
- Substitution of components may impair suitability for Class I, Division 2.
- Peripheral equipment must be suitable for the location in which it is used.
- The battery in this product must be changed only in an area known to be nonhazardous.
- All wiring must be in accordance with Class I, Division 2 wiring methods of Article 501 of the National Electrical Code and/or in accordance with Section 18-1J2 of the Canadian Electrical Code, and in accordance with the authority having jurisdiction.

---

**AVERTISSEMENT : RISQUE D'EXPLOSION**

- Couper le courant ou s'assurer que l'environnement est classé non dangereux avant de débrancher l'équipement.
- Couper le courant ou s'assurer que l'environnement est classé non dangereux avant de débrancher les connecteurs.
- Fixer tous les connecteurs externes reliés à cet équipement à l'aide de vis, loquets coulissants, connecteurs filetés ou autres moyens fournis avec ce produit.
- La substitution de composants peut rendre cet équipement inadapté à une utilisation en environnement de Classe I, Division 2.
- Les équipements périphériques doivent s’adapter à l’environnement dans lequel ils sont utilisés.
- S’assurer que l’environnement est classé non dangereux avant de changer la pile ou le module horloge temps réel de ce produit.
- Tous les systèmes de câblage doivent être de Classe I, Division 2, conformément aux méthodes de câblage indiquées dans les Articles 501 du National Electrical Code (Code Electrique National) et/ou conformément à la Section 18-1J2 du Canadian Electrical Code (Code Electrique Canadien), et en fonction de l’autorité de juridiction.

---

(1) The ArmorView Plus 7 terminal is not certified for use in hazardous locations.
**Required Circuit Port Parameters for USB Peripheral Devices**

This product contains USB host ports that comply with hazardous location environments. Field wiring compliance requirements are provided in compliance with the National Electrical Code, Article 500.

**Figure 1 - PanelView Plus 7 Performance Terminal Control Drawing**

PanelView Plus 7 Performance terminals provide two, separately powered USB host ports. Table 12 defines the circuit parameters of these USB host ports.

**Table 12 - Circuit Parameters for USB Host Ports**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Parameter Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>$V_{oc\ (USB)}$</td>
<td>5.25V DC</td>
<td>Open circuit voltage of each host USB port. The maximum applied voltage rating, $V_{max\ (peripheral)}$, of each USB peripheral device shall be greater than or equal to $V_{oc\ (USB)}$. $V_{max\ (peripheral)} \geq V_{oc\ (USB)}$ (as appropriate)</td>
</tr>
<tr>
<td>$I_{oc\ (USB)}$</td>
<td>1.25 A</td>
<td>Maximum output current of each host USB port. The maximum current, $I_{max\ (peripheral)}$, to which each USB peripheral device can be subjected shall be greater than or equal to $I_{oc\ (USB)}$. $I_{max\ (peripheral)} \geq I_{oc\ (USB)}$</td>
</tr>
<tr>
<td>$C_{a\ (USB)}$</td>
<td>10 μF</td>
<td>This value is the maximum total capacitance that can be connected to each USB host port. The total capacitance of each USB peripheral device and its associated cable must not exceed the indicated value. The maximum total capacitance, $C_{i\ (peripheral)}$, and cable capacitance of each separate USB peripheral device shall be less than or equal to $C_{a\ (USB)}$. $C_{i\ (peripheral)} + C_{cable\ (USB)} \leq C_{a\ (USB)}$</td>
</tr>
<tr>
<td>$L_{a\ (USB)}$</td>
<td>15 μH</td>
<td>This value is the maximum total inductance that can be connected to each USB host port. The total inductance of each USB peripheral device and its associated cable must not exceed the indicated value. The maximum total inductance, $L_{i\ (peripheral)}$, and cable inductance of each separate USB peripheral device shall be less than or equal to $L_{a\ (USB)}$. $L_{i\ (peripheral)} + L_{cable\ (USB)} \leq L_{a\ (USB)}$</td>
</tr>
</tbody>
</table>

**Application Information**

Per the National Electrical Code, the circuit parameters of associated field-wiring apparatus for use in hazardous locations shall be coordinated with the host product such that their combination remains nonincendive. PanelView Plus 7 Performance terminals and the USB peripheral devices shall be treated in this manner.

The USB peripheral devices and their associated cabling shall have circuit parameters with the limits given in Table 12 for them to remain nonincendive when used with the PanelView Plus 7 Performance terminal USB host ports.

If cable capacitance and inductance are not known, use the following values from ANSI/ISA-RP 12.06.01-2003:

$C_{cable} = 197$ pF/m (60 pF/ft)  
$L_{cable} = 0.7$ μH/m (0.20 μH/ft)
Nonincendive field wiring must be wired and separated in accordance with 501.10(B)(3) of the National Electrical Code, ANSI/NFPA 70, or other local codes as applicable. This associated nonincendive field wiring apparatus has not been evaluated for use in combination with another associated nonincendive field wiring apparatus.

**Mounting Considerations**

Consider the following when mounting the terminal:
- Mount the terminal at a height suitable for most operators. You can mount the cabinet at a different level than the operator floor.
- Use appropriate lighting. Do not operate the terminal in direct sunlight.
- Terminals are rated to operate at mounting angles between 0…180°.

Since the ArmorView Plus 7 terminals are pre-mounted in a custom enclosure for easy deployment, you may skip the following sections about mounting. For instructions on how to mount the ArmorView Plus 7 terminal, see the ArmorView Plus 7 Installation Instructions, publication 2711P-IN013.

**Figure 2 - Acceptable and Unacceptable Mounting Positions**

### ATTENTION:
Failure to follow these guidelines can result in personal injury or damage to the panel components.
Chapter 2

Mounting Clearances

Plan for adequate space around the terminal, inside the enclosure, for ventilation and cabling. Consider heat that is produced by other devices in the enclosure.

The ambient temperature around the terminal must be 0...55 °C (32...131 °F), except for the 19-in. Series A terminal, which has an ambient temperature requirement of 0...50 °C (32...122 °F). The ambient temperature for the 19-in. Series B terminal (Series C for the Stainless Steel terminals) is 0...55 °C (32...131 °F).

Table 13 - Minimum Required Clearances

<table>
<thead>
<tr>
<th>Product Area</th>
<th>Minimum Clearance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top</td>
<td>51 mm (2 in.)</td>
</tr>
<tr>
<td>Bottom</td>
<td>102 mm (4 in.)</td>
</tr>
<tr>
<td>Sides</td>
<td>25 mm (1 in.) on side without an SD card</td>
</tr>
<tr>
<td></td>
<td>102 mm (4 in.) on side with an SD card</td>
</tr>
<tr>
<td>Back</td>
<td>0 mm (0 in.) (1)</td>
</tr>
</tbody>
</table>

(1) When mounting a stainless steel terminal on a panel thicker than 3.66 mm (0.144 in.), the minimum clearance is from the mounting clip, not the back of the terminal.

Panel Guidelines

The terminals are panel-mount devices that mount in the door or wall of a NEMA rated, UL Type rated, or IP rated enclosure:

- Panels must have a thickness of 1.5...4.8 mm (0.060...0.188 in.).
- The material strength and stiffness of the panel must be sufficient to hold the terminal and maintain an appropriate seal against water and dust.
- The panel surface must be flat and free of imperfections to maintain an adequate seal, and NEMA and UL Type ratings.

Panel Cutout Dimensions

Use the template that is shipped with your terminal to mark the cutout dimensions.

Table 14 - Panel Cutout Dimensions - PanelView Plus 7 Performance Terminals

<table>
<thead>
<tr>
<th>Terminal Size</th>
<th>Input Type</th>
<th>Height, mm (in.)</th>
<th>Width, mm (in.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.5-in.</td>
<td>Keypad and touch</td>
<td>142 (5.59)</td>
<td>237 (9.33)</td>
</tr>
<tr>
<td></td>
<td>Touch</td>
<td>142 (5.59)</td>
<td>184 (7.24)</td>
</tr>
<tr>
<td>9-in.</td>
<td>Touch</td>
<td>162 (6.38)</td>
<td>252 (9.92)</td>
</tr>
<tr>
<td>10.4-in.</td>
<td>Keypad and touch</td>
<td>224 (8.82)</td>
<td>335 (13.19)</td>
</tr>
<tr>
<td></td>
<td>Touch</td>
<td>224 (8.82)</td>
<td>269 (10.59)</td>
</tr>
<tr>
<td>12.1-in.</td>
<td>Touch</td>
<td>218 (8.58)</td>
<td>312 (12.28)</td>
</tr>
<tr>
<td></td>
<td>Touch</td>
<td>290 (11.42)</td>
<td>353 (13.90)</td>
</tr>
<tr>
<td>19-in.</td>
<td>Touch</td>
<td>383 (15.08)</td>
<td>457 (17.99)</td>
</tr>
</tbody>
</table>
Prepare For Panel Mounting

**IMPORTANT** To mount a stainless steel terminal, skip this section and continue with Mount the Stainless Steel Terminal in a Panel on page 38.

Before mounting a terminal in a panel, read this section and the entire installation procedure on page 35.

**IMPORTANT** Catalog number 2711P-RMCP mounting levers (black) are used with the PanelView Plus 7 Performance terminals. Do not use gray mounting levers; they are not compatible with PanelView Plus 7 Performance terminals.

Mounting levers insert into the slots around the bezel to secure the terminal in the panel. The number of levers varies by terminal size.

Each slot has six notches with alignment marks that are locking positions for a lever. The thickness of the panel in which you mount the terminal determines the locking position that is required to maintain a NEMA/UL Type seal.

### Table 15 - Lever Locking Positions

<table>
<thead>
<tr>
<th>Mounting Slot</th>
<th>Lever Lock Position</th>
<th>Panel Thickness Range</th>
<th>Typical Gauge</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>1.50…2.01 mm (0.060…0.079 in.)</td>
<td>16</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>2.03…2.64 mm (0.080…0.104 in.)</td>
<td>14</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>2.67…3.15 mm (0.105…0.124 in.)</td>
<td>12</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>3.17…3.66 mm (0.125…0.144 in.)</td>
<td>10</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>3.68…4.16 mm (0.145…0.164 in.)</td>
<td>8/9</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>4.19…4.80 mm (0.165…0.188 in.)</td>
<td>7</td>
</tr>
</tbody>
</table>

Always orient a mounting lever vertically before inserting it into a slot. This method is the only way to slide the mounting lever knob within the slot for positioning. After sliding the mounting lever to a specific notch, rotate the mounting lever toward the panel to lock it in position. The flat side of the mounting lever must come into contact with the panel.
Initially, you secure the terminal in the panel by sliding each mounting lever to a position that is one or two notches greater than the final lock position. For example, if the final lock position is 3, slide each mounting lever to position 4 or 5. Follow the sequence specific to the terminal size shown in Figure 3 on page 34.

You then adjust each lever to its final lock position in the same sequence. See Figure 3 on page 34.

**TIP** If the lock position is 6, slide lever to large end of slot or insertion hole.

**IMPORTANT** This process equalizes the pressure of the levers against the panel at a gradual rate reducing the probability of broken clamps.

This figure shows the lever orientation and lock sequence for a 10.4-in. touch terminal.
This 10.4-in. touch terminal has all levers that are locked in position 3, which is appropriate for a panel thickness of 2.67…3.15 mm (0.105…0.124 in.).
IMPORTANT: The mounting lever orientations that are shown are required to maintain NEMA, UL Type, and IP seals. If you require a NEMA, UL Type, or IP seal, do not use a mounting lever in a different orientation than shown.
Mount the Aluminum Terminal in a Panel

**IMPORTANT** To mount a stainless steel terminal, skip this section and continue with Mount the Stainless Steel Terminal in a Panel on page 38.

The terminals are designed for single-person installation. No tools are required except for the tools that are used to make the panel cutout.

To mount the terminal in a panel, follow these steps.

**ATTENTION:**
Disconnect all electric power from the panel before making the panel cutout.
Make sure that the area around the panel cutout is clear and that the panel is clean of any debris, oil, or other chemicals.
Make sure that metal cuttings do not enter any components that are installed in the panel, and that the edges of the cutout have no burrs or sharp edges.
Failure to follow these warnings can result in personal injury or damage to panel components.

1. Cut an opening in the panel by using the panel cutout template that shipped with the terminal, or the cutout dimensions in Table 14 on page 30.
2. Verify that the sealing gasket is present on the terminal.
   This gasket forms a compression seal. Do not use sealing compounds.

3. Insert and stabilize the terminal in the panel cutout.
   a. Insert levers in the top corner slots by using the orientation in Figure 3 on page 34, and rotate the curved side of the levers toward the panel.

**TIP** The mounting levers for PanelView Plus 7 Performance terminals are black (catalog number 2711P-RMCP).
Do not use gray mounting levers; they are not compatible with PanelView Plus 7 Performance terminals.
b. Tilt the terminal into the panel cutout and guide upward into the cutout so that the levers are behind the panel.

**TIP** The levers help to prevent the terminal from falling out of the panel.

c. Pull the top of the terminal toward you to verify that the levers are still in place and the terminal is stabilized in the panel.

d. Insert the remaining levers in the slots by using the orientations for your terminal in Figure 3 on page 34. The direction that you rotate the levers varies for each terminal size.

4. Slide and rotate each lever to a notch that is one or two positions greater than the final lock position, starting with the first lever in the sequence. For example, if the final lock position is 3, slide the lever to notch 4 or 5.

**TIP** Use the alignment marks or previous marks you made on the bezel to help position the levers and identify the final slot position.

a. See Figure 15 on page 31 to get the final lock position of the levers.
b. See Figure 3 on page 34 to get the locking sequence.
Chapter 2

5. Adjust each lever to its final lock position by using the same locking sequence in Figure 3 on page 34.

a. Unlock lever one in the sequence by rotating it away from the bezel.

b. With the lever positioned vertically to the slot, slide the lever to the final locking position in Table 15 on page 31.

The outer notch of the lever aligns with the bezel indentation.

c. Carefully rotate the lever back toward panel.

---

**IMPORTANT** Do not use tools or excessive force to rotate the mounting levers. The mounting levers are rotated and secured by hand.

---

**TIP** A broken mounting lever does not damage the terminal.

The mounting levers are designed to break off the pin if they are over torqued. This breakage helps to prevent damage to the terminal bezel. If a pin is broken, you can turn the lever around and use the lever in another location. See Figure 3 on page 34 for details and restrictions.

---

d. Lock the remaining levers to their final position.

---

---
6. Verify that all levers are in the correct locked position.

**ATTENTION:** All levers must be in the correct and same locked position to provide an adequate gasket seal between the terminal and the panel. Rockwell Automation assumes no responsibility for water or chemical damage to the terminal or other equipment within the enclosure because of improper installation.

The notch on the outside of lever shows its locked position.

These two views show levers that are locked in position 3.

---

**Mount the Stainless Steel Terminal in a Panel**

Mounting clips secure the stainless steel terminals in a panel. The number of clips varies by terminal size. Tools that are required for installation include panel cutout tools, a large slotted or Phillips screwdriver, and a torque wrench for tightening the mounting clips.

**ATTENTION:**
- Disconnect all electric power from the panel before making the panel cutout.
- Make sure that the area around the panel cutout is clear and that the panel is clean of any debris, oil, or other chemicals.
- Make sure that metal cuttings do not enter any components that are installed in the panel, and that the edges of the cutout have no burrs or sharp edges.
- Failure to follow these warnings can result in personal injury or damage to panel components.

To mount the stainless steel terminal in a panel, follow these steps.

1. Cut an opening in the panel by using the panel cutout template that shipped with the terminal, or the cutout dimensions in **Table 14 on page 30**.

2. Place the terminal screen-down on a clean, flat surface.

Be careful not to scratch or damage the terminal screen.
3. Position the gasket on the bezel, with the gasket alignment plugs facing the bezel alignment features.
   This gasket forms a compression seal. Do not use sealing compounds.

   **IMPORTANT** Slip the inside corners of the gasket under the corners of the bezel shroud.

4. Press each gasket alignment plug into the bezel alignment feature.
   The alignment plugs hold the gasket to the bezel.

5. Place the terminal in the panel cutout.
   Hold the terminal so it does not fall out of the panel.
6. Position the backing plate over the terminal.

**IMPORTANT** Make sure that the flat side of the backing plate faces away from the panel, as shown in the drawing.

7. Slide the ends of the mounting clips into the slots on the terminal.
8. Tighten the mounting clip screws by hand until the backing plate contacts the panel uniformly.
9. Torque the mounting clip screws to 2.3...2.6 N•m (20...23 lb•in) by using the specified sequence.

   The clips will loosen as the adjacent clip is tightened.
10. Repeat step 9 until all the mounting clips are at the specified torque.

   **ATTENTION:** Tighten the mounting clips to the specified torque to provide a proper seal and to prevent damage to the product. Rockwell Automation assumes no responsibility for water or chemical damage to the product or other equipment within the enclosure because of improper installation.
Outdoor Installation

ATTENTION: Failure to follow the recommended installation practices for outdoor use will substantially reduce product life and void product warranty.

When using a 2711P terminal outdoors, you must follow the recommendations outlined below to maximize the field life of the front bezel and display:

- Add UV protection and shielding (sun shade or sun visor)
- Manage terminal temperature
- Install a protective overlay
- Consider terminal orientation
- Select a proper enclosure

Ultraviolet (UV) and infrared radiation can reduce the field life of any electronic terminal. While the materials used in the terminal bezels provide long field life, that life can be improved by proper installation and by following the suggested guidelines.

UV radiation from the sun causes all plastics to fade or yellow and become brittle over time. Using a sacrificial antiglare overlay (see Table 6 on page 23) helps protect the front of the terminal from direct exposure to UV radiation, and by avoiding direct sunlight exposure, this overlay greatly increases its field life. Another recommendation for UV protection is a shield to shade the terminal from the direct rays of the sun. This also helps reduce the solar heating caused by direct sun exposure. When installing a sun shield that closes over the display, the temperature between the sun shield and the display cannot exceed the maximum temperature of the display, which is 55 °C (131°F). Adequately ventilate all sun shields to help prevent excess heat rise on the terminal display.

Use stirring fans or active cooling in high altitude and high ambient temperature locations to keep the internal enclosure temperature below 55 °C (131°F).

Ensure the ambient temperature the product is operating in does not fall below its minimum rated 0°C (32°F).

The temperature differential between the inside of the terminal enclosure and the front panel must be minimized to reduce the potential for condensation and possible pressure variation between the inside and outside of the product.

Avoid placing the terminal on the south (north in the southern hemisphere) or west side of the cabinet. This reduces the heat rise due to solar heating during the hottest part of the day.

Mount the terminal vertically to minimize solar heating on the display. Do not mount the terminal in a sloped enclosure if it exposes the terminal to direct sunlight.
Chapter 2

Protect the terminal from water and dust by mounting it in a proper enclosure following the instructions in the PanelView Plus 7 Performance Terminals Product Information, publication 2711P-PC007. The terminals meet specified NEMA, UL Type, and IEC ratings only when properly mounted in a panel or enclosure with the equivalent rating. Other sections of this publication may contain additional information regarding specific enclosure type ratings that are required to comply with certain product safety certifications.

Remove and Replace Power Terminal Block

The product has a three-pin terminal block for power connections. You can remove the terminal block for ease of installation, wiring, and maintenance.

**WARNING:** Explosion Hazard

If you connect or disconnect wiring while the power is on, an electric arc can occur. An electric arc can cause an explosion in hazardous location installations. Verify that the power is off and the area is nonhazardous before proceeding. Failure to turn power off can result in electric shock or damage to the terminal.

The terminal block has different markings for AC and DC power connections. Use a 0.6 x 3.5 mm screwdriver for terminal block wiring.

**Table 16 - Wire Specifications for Power Input Terminal Block**

<table>
<thead>
<tr>
<th>Wire Type</th>
<th>Dual-wire Size(1)</th>
<th>Single-wire Size</th>
<th>Strip Length</th>
<th>Wire Torque</th>
<th>Mounting Torque</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stranded or solid Cu 90°C (194°F)</td>
<td>0.3 ... 1.3 mm²</td>
<td>0.3 ... 2.1 mm²</td>
<td>7 mm (0.28 in.)</td>
<td>0.4 ... 0.5 N-m</td>
<td>0.15 ... 0.2 N-m</td>
</tr>
<tr>
<td>22 ... 16 AWG</td>
<td>22 ... 14 AWG</td>
<td></td>
<td></td>
<td>(3.5 ... 4.4 lb-in)</td>
<td>(1.3 ... 1.8 lb-in)</td>
</tr>
</tbody>
</table>

(1) Two-wire maximum per terminal.

To remove the terminal block, follow these steps.

1. Loosen the two screws that secure the terminal block.

2. Gently pull the terminal block away from the connector.

---

(1) Series C for PanelView Plus 7 Performance Stainless Steel terminals.
To install the terminal block, follow these steps.

1. Reattach the terminal block to the connector until seated.

   **ATTENTION:** Do not use excessive force to press the terminal block into position. The terminal blocks are keyed to fit the DC or AC connector. If the terminal block does not fit into the connector, verify that you have the correct terminal block. See Table 7 on page 23.

2. Tighten the two screws that secure the terminal block to the connector.

### Connect to DC Power

Terminals with a 24V DC power supply have these power ratings:

- 24V DC nominal (18...30V DC)
- 50 W maximum (2.1 A at 24V DC)

**ATTENTION:** The power supply is internally protected against reverse polarity. To avoid damage to the terminal:

- Do not connect DC+ or DC- to the earth ground terminal.
- Do not connect AC power, or more than 30V DC, to the power terminal block.

Terminals with a DC power input support operation from a safety extra low voltage (SELV) or protective extra-low voltage (PELV) 24V DC power supply. Supported power supplies include catalog numbers 1606-XLP95E, 1606-XLP100E, or 2711P-RSACDIN.

**ATTENTION:** Use a SELV or PELV supply as required by local wiring codes for your installation. The SELV and PELV power sources provide protection so that under normal and single fault conditions, the voltage between conductors and earth ground does not exceed a safe value.

You can power the terminal from the same power source as other equipment by using a DC power bus.

To connect the operator terminal to a DC power source, follow these steps.

1. Verify that the wiring is not connected to a power source.

2. Strip 7 mm (0.28 in.) of insulation from the ends of the wires.
3. Secure the DC power wires to the marked terminals (+ and –) on the terminal block.

4. Secure the earth ground wire to the GND terminal on the terminal block.

The GND terminal must be connected to a low-impedance earth ground.

5. Apply power to the operator terminal.

**Connect to AC Power**

Terminals with an AC power supply have these power ratings:
- 100...240V AC (50...60 Hz)
- 105VA maximum

**ATTENTION:** Improper wiring of the power terminals can result in voltage at the communication connector shells.

Do not apply power to the terminal until all wiring connections have been made. Failure to do so can result in electric shock.

Do not connect stainless steel terminals to AC power. Stainless steel terminals are only compatible with DC power.

To connect the operator terminal to an AC power source, follow these steps.

1. Verify that the wiring is not connected to a power source.
2. Strip 7 mm (0.28 in.) of insulation from the ends of the wire.
3. Secure the AC power wires to the marked terminals (L1 and L2N) on the terminal block.

4. Secure the protective earth ground wire to the marked terminal on the terminal block.

The protective earth terminal must be connected to a low-impedance earth ground.

**ATTENTION:** The earth ground connection to ground is mandatory. This connection is required for noise immunity, reliability, and Electromagnetic Compliance (EMC) with the European Union (EU) EMC Directive for CE marking conformance. This connection is required for safety by Underwriters Laboratory.

5. Apply power to the operator terminal.

**Connect to a Network**

The two Ethernet ports connect to controllers on an EtherNet/IP network by using standard Ethernet connections. These network types are supported:

- [Device Level Ring Network Topology on page 48](#)
- [Linear Network Topology on page 49](#)
- [Star Network Topology on page 50](#)

Each of these EtherNet/IP network topologies supports applications that use Integrated Motion over an EtherNet/IP network, if necessary.

**IMPORTANT** The terminal has dual-Ethernet ports but only one device IP address.

**Ethernet Ports**

The Ethernet port has two 10/100Base-T connectors for network communication and supports MDI/MDI-X connections and DLR network topology as indicated by the DLR network icon.
The terminal connects to an EtherNet/IP network by using a CAT5, CAT5E, or CAT6 twisted-pair, Ethernet cable with RJ45 connectors.

**Performance Terminals**

**Stainless Steel Terminals**

**IMPORTANT** To help prevent accidental disconnection of the Ethernet cable, follow these steps:

- Secure the Ethernet cable to minimize vibration at the connector, and reduce the chance that personnel working inside the panel can accidentally disconnect the cable.
- Do not install the Ethernet cable too tightly. Leave some slack in the cable to help prevent pulling on the cable when the panel door is opened and closed.

The maximum cable length between the Ethernet ports and a 10/100Base-T port on an Ethernet hub (without repeaters or fiber) is 100 m (328 ft).

**WARNING:** In hazardous locations, do not connect or disconnect any communication cable with power that is applied to this device or any device on the network. An electric arc can cause an explosion in hazardous location installations. Make sure that the power is off or the area is nonhazardous before proceeding.
Each Ethernet port has two indicators that provide the status of activity.

**Table 17 - Ethernet Connector Pinout**

<table>
<thead>
<tr>
<th>Connector</th>
<th>Pin</th>
<th>Pin Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>View of RJ45 Connector</td>
<td>1</td>
<td>TD+</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>TD-</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>RD+</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>Unused</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Unused</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>RD-</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>Unused</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>Unused</td>
</tr>
<tr>
<td>Shield Connection</td>
<td>No direct connection (AC coupled to chassis GND)</td>
<td></td>
</tr>
</tbody>
</table>

**Table 18 - Ethernet Status Indicators**

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link Integrity</td>
<td>Green</td>
<td>On when a link is present.</td>
</tr>
<tr>
<td>Activity</td>
<td>Yellow</td>
<td>Blinks when activity is detected on Ethernet link.</td>
</tr>
</tbody>
</table>
Device Level Ring Network Topology

A DLR network is a single-fault tolerant ring network that is intended for the interconnection of automation devices. This topology is also implemented at the device level. No additional switches are required.

**TIP** A DLR network has supervisor nodes and ring nodes. The PanelView Plus 7 Performance terminal operates only as a ring node on the network.

DLR network topologies automatically convert to linear network topologies when a fault is detected. The conversion to the new network topology maintains communication of data on the network. The fault condition is typically detected and corrected.

For more information on DLR network topology, see the EtherNet/IP Embedded Switch Technology Application Guide, publication **ENET-AP005**.

**Figure 4 - PanelView Plus 7 Performance Terminal in a DLR Topology Network**
**Linear Network Topology**

A linear network topology is a collection of devices that are daisy-chained together across an EtherNet/IP network. Devices capable of connecting to a linear network topology use embedded switch technology to remove the need for a separate switch, as required in Star network topologies.

**TIP** The PanelView Plus 7 Performance terminal with dual Ethernet ports can be attached in the middle, or at the end, of a linear network.

**Figure 5 - PanelView Plus 7 Performance Terminal in a Linear Topology Network**
**Star Network Topology**

A star network topology is a traditional EtherNet/IP network that has multiple devices that are connected to each other via an Ethernet switch.

*Figure 6 - PanelView Plus 7 Performance Terminal in a Star Topology Network*

---

**Initial Startup — Series A Terminals**

The first time that you start the system, the terminal goes through its startup sequence and launches FactoryTalk® View ME Station in Configuration mode.

To change the action that occurs at startup, follow these steps.

1. Press Terminal Settings.
2. Tap Startup Options.

You can configure these options:
- Launch FactoryTalk View ME Station in Configuration mode (default).
- Launch the Windows desktop. (This functionality is available on series A terminals only. Series B terminals (Series C for Stainless Steel terminals) launch the Control Panel).

**TIP** Terminals are initially shipped with desktop access disabled. You can also configure the terminal to allow desktop access.

For more information on how to change the start-up option and desktop access, see Configure Start-up Options on page 84.
Initial Startup — Series B Terminals

Initial startup for Series B terminals (Series C for Stainless Steel terminals) differs from initial startup for Series A terminals. To complete initial startup for Series B terminals (Series C for Stainless Steel terminals), complete the steps shown in the following sections. For more information about initial startup of Series B terminals (Series C for Stainless Steel terminals), see the PanelView Plus 7 Performance Series B Terminals Quick Start, publication 2711P-QS002.

Calibrate the PanelView Terminal

1. Connect the terminal to an appropriately-rated DC power source.

**WARNING:** Series B terminals (Series C for Stainless Steel terminals) are designed for use with DC power only. Do not apply AC power or attempt to insert an AC terminal block (gray in color) into a Series B terminal (Series C for Stainless Steel terminals). For additional information about how to connect to DC Power, see Connect to DC Power on page 43.

After the initial power up, the terminal displays the Calibration Menu screen.

**TIP** For the following steps, if you do not have a keyboard or mouse connected to your terminal, you can tap commands and icons on the screen.

2. On the Calibration Menu screen, tap Touch Screen Calibration.

3. In the Touch Screen Calibration dialog box, tap Yes.
4. On the first calibration screen, calibrate the touch screen boundaries as prompted.

a. Carefully tap the blue portion of the target as close to the edge as possible and slide it off the edge of the display.

The target moves after your finger slides off the display.

b. Repeat as the target moves around the screen.

The terminal saves these settings and then displays the second calibration screen.

5. On the second calibration screen, calibrate the touch screen as prompted:

a. Carefully tap and hold the center of the target for at least 1 second.

The target moves after you do this.

b. Repeat as the target moves around the screen.

6. To save the calibration settings, tap the screen, as prompted.

**IMPORTANT** If this is not done within 30 seconds, the settings are not saved.
7. In the Success dialog box, tap OK.
8. Tap Exit Calibration Menu.
9. In the Exit Calibration Menu dialog box, tap Yes.

The terminal reboots and displays the first Welcome to PanelView Plus screen.

10. Review the information on this screen, and then tap the Next button.

The terminal displays the second Welcome to PanelView Plus screen.

**TIP** For all of the following PanelView screens, if you do not have a keyboard or mouse connected to your terminal, tap inside a field to display an on-screen keyboard. On the keyboard, tap each character for the information you want to enter. When you are finished entering the information, tap the X in the upper-right corner of the keyboard. The keyboard closes and the information appears in the appropriate field.
11. In the Administrator password field, type a password for the PanelView Plus Windows 10 IoT Core Control Panel.
   The only requirement for the password is that it must be between 1 and 64 characters.

12. Retype the password in the Confirm password (must match password above) field.

13. Tap Next.
   The terminal displays the Network Adapters setup screen.

14. Type information about your network into the following fields:
   - Automatic address—The default setting is On, which means that the system provides dynamic IP addresses. If you prefer to use a static IP address, turn this field Off by tapping the button indicator and sliding it to the left. The Automatic DNS field becomes inactive, and the following fields become active so that you can type your information into them:
     - IP address
     - Subnet Mask
     - Gateway
   - Automatic DNS—The default setting is On, which means that the system generates DNS information for you. If you prefer to specify your own DNS information, turn this field Off by tapping the button indicator and sliding it to the left. The following fields become active so that you can type your information into them:
     - Preferred DNS
     - Alternate DNS
   **TIP** If the Automatic DNS field is inactive, you may first need to turn the Automatic address field On by tapping that button indicator and sliding it to the right. Then slide the Automatic DNS button indicator to the right to turn that field Off.
15. Tap the Next button.
   The terminal displays a verification screen.

16. Tap Save and Reboot.
   **TIP** If you need to change your network settings after this initial setup, you can do that in FactoryTalk View ME Station by tapping Terminal Settings [F4] > Networks and Communications > Network Connections > Network Adapters.

   The terminal restarts and displays the PanelView Plus Firmware Update Utility screen.

   **IMPORTANT** If a USB Storage Device is not plugged into the terminal, the Update from USB Storage button is not visible on the screen. Plug in a USB storage device and the button is automatically added.

17. Continue with **Update the System Firmware on page 57**.
Chapter 2

Update the System Firmware

You can update the firmware on your terminal by using one of the following methods:

- USB storage device
- ControlFLASH™ client, which is available in the following formats:
  - ControlFLASH Plus™
  - ControlFLASH

Update the Firmware Using a USB Storage Device

1. Access the Rockwell Automation Product Compatibility and Download Center (PCDC) at rok.auto/pcdc.
2. On the home page, click Available Versions.
3. Click the Select a Product link, and in the Select a Product dialog box, type PanelView Plus 7 Performance in the search field, and then click the Search button.
4. Select PanelView Plus 7 Performance, and then select B for the Series B (Series C for Stainless Steel terminals) firmware.
5. Click the Show Downloads icon for the desired firmware version for PanelView Plus 7 Performance (Series B (Series C for Stainless Steel terminals)).

**TIP** Firmware for Series B terminals (Series C for Stainless Steel terminals) start at version 12.XXX.
6. Select and download the CAB Files for the desired firmware version.

7. After the .ZIP file has downloaded, extract the contents to the root of the USB Storage Device.

   **TIP** Use a USB Storage Device with at least 8 GB of storage available. Any Windows file system (including FAT32 or NTFS) is acceptable.

8. Insert the removable storage device into one of the USB ports located at the bottom of the PanelView terminal.

9. Tap Update from USB Storage and wait for the firmware update to complete.

**IMPORTANT** Do not download the DMK file. It does not work to update firmware via a USB Storage Device.
Before the update starts, the terminal displays the warning message shown in the following graphic. As the message states, do not remove the USB storage device while the file is being copied. Wait until you are prompted to remove the USB storage device.

10. Tap OK when you are ready to continue.

While the firmware is updating, the terminal displays the update status. When the update is complete, the terminal displays the message shown in the following graphic.

It is recommended that you remove the USB Storage device when prompted with the message shown in the image.

11. Tap OK to continue.

When the update is complete, the terminal reboots again and then displays the Password Entry screen.

12. Continue with Enter a Password on page 69.
Update the Firmware Using ControlFLASH Client

The following ControlFLASH clients are available to update the firmware:

- ControlFLASH Plus
- ControlFLASH

Before you can use ControlFLASH Plus or ControlFLASH, you must download the DMK file from the Product Compatibility and Download Center (PCDC).

Download the ControlFLASH or ControlFLASH File

1. Access the Rockwell Automation Product Compatibility and Download Center (PCDC) at rok.auto/pcdc.
2. On the home page, click Available Versions.
3. Click the Select a Product link, and in the Select a Product dialog box, type PanelView Plus 7 Performance in the search field, and then click the Search button.
4. Select PanelView Plus 7 Performance, and then select B for the Series B firmware (C for Series C Stainless Steel terminals).
5. Click the Show Downloads icon for the desired firmware version for PanelView Plus 7 Performance (Series B (Series C for Stainless Steel terminals)).

TIP Firmware for Series B terminals (Series C for Stainless Steel terminals) start at version 12.XXX.
6. Select and download the DMK file for the desired firmware version.

   ![PanelView Plus Firmware Update Utility](image)

7. Save the DMK file in the desired Firmware Kits location.
   The default location is
   C:\Users\Public\Documents\RockwellAutomation\Firmware Kits

8. On the PanelView terminal, under System Firmware, tap the Start Update Utility button.

   ![PanelView Plus Firmware Update Utility](image)

**Update the Firmware Using ControlFLASH Plus**

For details about how to install ControlFLASH Plus software, see the ControlFLASH Plus Quick Start Guide, publication CFP-QS001.

**IMPORTANT** Use ControlFLASH Plus, version 4, or higher. The following procedure uses ControlFLASH Plus, version 4.

1. After you save the DMK file in the desired Firmware Kits location, launch ControlFLASH Plus.

2. Browse to and select the PanelView Plus 7 Performance Series B terminal (series C if it is a Stainless Steel terminal).
3. Click Next.

![ControlFLASH Plus screen](image1)

A series of status changes occur on the ControlFLASH Plus screen and on the PanelView terminal.

4. Confirm that the information is correct, and then click Flash.

![ControlFLASH Plus screen](image2)
On the ControlFLASH Plus screen, the Status field displays the Transmitting update status.

On the PanelView terminal, the status changes to CONNECTED: transferring updates...
Once the firmware file transmission is complete, on the ControlFLASH Plus screen, the Status field displays the Polling for power-up status.

On the PanelView terminal, the status changes to PLEASE WAIT: verifying and preparing updates...
The PanelView terminal reboots, and on the ControlFLASH Plus screen, the Flash Results dialog box displays a Succeeded message.

5. Click Close, and then click Done.

When the firmware update is complete, the terminal reboots and displays moving gears while the update installs.

6. Continue with Enter a Password on page 69.
Update the Firmware Using ControlFLASH

For information on how to install ControlFLASH, see the ControlFLASH User Manual, publication 1756-UM105.

IMPORTANT Use ControlFLASH, version 15.05, or higher. The following procedure uses ControlFLASH, version 15.05.

To use the ControlFLASH software to update the firmware in a PanelView Plus 7 Performance Series B terminal (Series C for Stainless Steel terminals), follow these steps.

1. Click Start>Programs>FLASH Programming Tools>ControlFLASH.
2. Make sure that you know the required information in the Welcome dialog box, then click Next.
3. Select the catalog number of the PanelView Plus 7 Performance Series B terminal (Series C for Stainless Steel terminals) that you want to update and click Next.
4. Browse to and select the device to update on the EtherNet/IP™ network and click OK.

5. Select the firmware revision to install and click Next.

6. Read the Danger information in the Summary dialog, then click Finish.
7. Click Yes to confirm that you want to update the target device.

![ControlFLASH window with the question 'Are you sure you want to begin updating the target device?' with Yes and No buttons]

The update starts and can take several minutes to complete.

![Progress dialog box showing firmware details and progress]

**IMPORTANT**  Do not cycle power to the terminal during this process or the firmware update does not complete successfully.

When the firmware is sent to the terminal, the terminal resets and performs diagnostics.

The Update Status dialog box opens when the update is complete. If the update was successful, the Status area is green.

![Update Status dialog box showing successful update]

8. Click OK.

If the update fails, the status area is red and reads Update failure. For troubleshooting information, see the ControlFLASH User Manual, publication 1756-UM105.

9. Close the ControlFLASH software.

10. Continue with Enter a Password on page 69.
Enter a Password

After the PanelView terminal is updated with the desired firmware version, the terminal displays the Change Desktop Access Password screen. The password that you enter here is used to exit ME Station and access the Windows 10 IoT Core Control Panel menu.

**TIP** If you need to change (reset) your password after this initial setup, you can do that in FactoryTalk View ME Station by clicking or tapping Terminal Settings [F4] > Desktop Access Setup > Reset Password [F4].

1. On the Change Desktop Access Password screen, in the Password field, type a password that meets the following criteria:
   - Contains from 8 to 20 characters
   - Contains at least one lowercase and one uppercase character
   - Contains at least one numerical or special character
   - Is not any form of the word password

   **TIP** If you do not have a keyboard or mouse connected to your terminal, tap the Set Password button to display an on-screen keyboard. On the keyboard, tap each character for your password. When you are finished typing the password, tap the Enter button. The password appears in the Password field.

   **TIP** The buttons that appear next to the other fields on the Change Desktop Access Password screen, for example, Confirm Password, Set Challenge, and Set Response, display the same on-screen keyboard. Use the on-screen keyboard for these fields as described in the previous Note.
2. Tap the Confirm password field, and type the password again.
3. Tap the Challenge question field, and type a question.

**TIP**  The challenge question is used to reset the password.

4. Tap the Challenge response field, and type the answer to the challenge question.

The response needs to be a minimum of 6 characters.

5. Tap OK.

The terminal displays the FactoryTalk View ME Station startup screen.

6. Continue with Transfer Runtime Files (.mer) on page 71.
Transfer Runtime Files (.mer)

You can transfer project files (.mer) to your terminal by using one of the following methods:

- Transfer Utility (via ethernet)
- Removable storage (USB drive or SD card)

Transfer Utility

To transfer runtime files (.mer) by using the Transfer utility, complete the following steps:

1. From the FactoryTalk View Studio application on your PC, click Tools, and then click Transfer Utility.

2. In the Transfer Utility dialog box, click the ellipsis to the right of the Source file field, browse to the location of the .mer file, and select the .mer file.

3. In the Select destination terminal field, browse to the location of the PanelView Plus 7 Series B terminal (Series C for Stainless Steel), and select it.
4. Click Download.

The runtime file (.mer) file is downloaded to your PanelView terminal.
Configure Terminal Settings

FactoryTalk View ME Station

FactoryTalk® View ME Station is the runtime environment of the terminal. This environment lets you configure start-up options, load and run HMI applications, adjust terminal settings, access the Windows desktop (Series A terminals only), and perform other terminal operations.

When you restart the terminal, one of these actions occurs depending on the configured start-up option:

- FactoryTalk View ME Station launches in Configuration mode (factory default).
- FactoryTalk View ME .mer application runs.
- Windows desktop launches (Series A terminals only).
Chapter 3

IMPORTANT • To access Configuration mode from an HMI application on the terminal, press Goto Configuration Mode. This button is added to application screens in FactoryTalk View Studio software during application development. The application stops running but is still loaded.
  • If your application does not have a Goto Configuration Mode button, see Enter Configuration Mode on Startup on page 85 for details on how to access Configuration mode.
  • To access Configuration mode from the Windows desktop (available only on Series A terminals), double-click the FTViewME Station icon.

Figure 7 - FactoryTalk View ME Station Configuration Menu

Table 19 - Terminal Operations

<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Application [F1]</td>
<td>Open a dialog box where you select a .mer application to load in the device. You must load an application before you can run it. The name of the loaded application appears under Current Application.</td>
</tr>
<tr>
<td>Run Application [F2]</td>
<td>Run the .mer application that is loaded in the terminal.</td>
</tr>
<tr>
<td>Application Settings [F3]</td>
<td>Open a menu of application-specific settings, such as device shortcuts defined for the loaded .mer application. Device shortcuts are read only. For example, CLX is the device shortcut for a ControlLogix® controller.</td>
</tr>
<tr>
<td>Terminal Settings [F4]</td>
<td>Open a menu of options to modify terminal settings.</td>
</tr>
</tbody>
</table>
| Delete Log Files Before Running [F5] | Toggle between Yes and No.  
  • Select Yes to delete all data log files, alarm history, and alarm status files before running the application.  
  • Select No to run the application without deleting log files. |
### Table 19 - Terminal Operations (Continued)

<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset [F7]</td>
<td>Reset the terminal and launch an HMI application, FactoryTalk View ME Station software, or the Windows CE desktop (Series A terminals only). The action that occurs depends on the configured startup-option.</td>
</tr>
<tr>
<td>Exit [F8]</td>
<td>Exit FactoryTalk View ME Station. If desktop access is allowed, you can access the desktop (Series A terminals only).</td>
</tr>
<tr>
<td>Device, IP Address, Subnet (Display only)</td>
<td>Identifies the device name, IP address, and subnet of the terminal on a connected Ethernet network. The network information is updated every 60 seconds. If the terminal is disconnected from the network, the IP address and subnet appear as 0.0.0.0.</td>
</tr>
</tbody>
</table>

**TIP** On devices with a keypad and a touch screen, you can press a function key or the touch screen button to access an operation. For example, to access terminal settings:
- Press the F4 function key, or
- Press the Terminal Settings touch screen button
Terminal Settings

The terminal has settings that you can adjust that are not specific to the application.

1. Press Terminal Settings from the FactoryTalk View ME Station dialog box.
2. Select an option by using the up and down cursor.
   - On touch screen terminals, touch the up or down cursor.
   - On keypad terminals, press the corresponding key on the keypad.
3. Press Enter to access the selected function.

Table 20 - Terminal Settings

<table>
<thead>
<tr>
<th>Select This Option:</th>
<th>If You Want to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarms</td>
<td>Close the alarm display on the terminal when an operator acknowledges the newest alarm. By default, the alarm display is closed.</td>
</tr>
<tr>
<td>Diagnostics Setup</td>
<td>Forward diagnostic messages from a remote log destination to a computer that runs diagnostics.</td>
</tr>
<tr>
<td>Display</td>
<td>Adjust the brightness of the display, configure the screen saver, and enable/disable the touch screen cursor.</td>
</tr>
<tr>
<td>Desktop Access Setup</td>
<td>Allow or restrict access to the desktop. Set or reset the desktop password. Series A terminals exit to the desktop. Series B terminals (Series C for Stainless Steel terminals) exit to the Control Panel.</td>
</tr>
<tr>
<td>File Management</td>
<td>Copy application files and font files to the terminal, an SD card, or a USB drive. You can also delete application files or log files.</td>
</tr>
<tr>
<td>Font Linking</td>
<td>Link a font file to a base font loaded on the terminal.</td>
</tr>
<tr>
<td>Input Devices</td>
<td>Configure settings for the keypad, attached keyboard, mouse, or touch screen, including touch screen calibration. You can also choose between a popup character input or popup keyboard for string input.</td>
</tr>
<tr>
<td>File Integrity Check</td>
<td>Check the integrity of the .mer application file and runtime files by logging details to a file integrity check log. You can view and clear this log at any time.</td>
</tr>
<tr>
<td>Networks and Communications</td>
<td>Configure Ethernet and other communication settings for an application. KEPServer Driver Configuration is a new option available on both Series A and Series B terminals (Series C for Stainless Steel terminals).</td>
</tr>
<tr>
<td>Print Setup</td>
<td>Configure settings to print displays, alarm messages, or diagnostics messages generated by the application.</td>
</tr>
<tr>
<td>Startup Options</td>
<td>Specify whether the terminal launches the desktop, an application, or FactoryTalk View ME Station Configuration mode on startup.</td>
</tr>
<tr>
<td>System Event Log</td>
<td>Display system events that are logged by the terminal, and clear events from the log.</td>
</tr>
<tr>
<td>System Information</td>
<td>Display power, temperature, battery, and memory details for the terminal. You can also view the firmware revision for FactoryTalk View ME Station, and other software loaded on the terminal. Technical support information.</td>
</tr>
<tr>
<td>Time/Date/Regional Settings</td>
<td>Set the date, time, language, and numeric format used by terminal and applications.</td>
</tr>
<tr>
<td>Certificates Management</td>
<td>Import and view certificates on the terminal.</td>
</tr>
</tbody>
</table>
When you activate a data entry field, a keyboard opens. For fields that require numeric values only, 0…9 and the decimals are enabled.

### Soft Keyboard

When you activate a data entry field, a keyboard opens. For fields that require numeric values only, 0…9 and the decimals are enabled.

![Soft Keyboard Controls](image)

<table>
<thead>
<tr>
<th>Select This Key</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHF</td>
<td>Switch keys between their shifted and unshifted state.</td>
</tr>
<tr>
<td>CAP</td>
<td>Switch between lowercase and uppercase characters.</td>
</tr>
<tr>
<td>SPACE</td>
<td>Enter a space between characters in the Display Area.</td>
</tr>
<tr>
<td>Backspace</td>
<td>Delete the previous character (to the left of the cursor) in the Display Area.</td>
</tr>
<tr>
<td>Select</td>
<td>Select a character and enter it in the Display Area.</td>
</tr>
<tr>
<td>Left, Right, Up, Down Arrow</td>
<td>Select the character to the left, right, above, or below the currently selected character.</td>
</tr>
<tr>
<td>Enter</td>
<td>Accept the entered characters and return to the previous dialog box.</td>
</tr>
<tr>
<td>ESC</td>
<td>Cancel the current operation and return to the previous dialog box.</td>
</tr>
</tbody>
</table>

To enter characters in the display area above the keyboard, follow these steps.

1. Select a character on the keyboard:
   - On a touch screen terminal, touch a key.
   - On a keypad terminal, press the arrow keys to navigate to a key.
2. Press Select to copy the character to the display area.
3. Press Enter when done to exit the keyboard.
Load and Run Application

To run a FactoryTalk View ME .mer application on the terminal, you must first load the application. You can load the application from internal storage (nonvolatile memory) in the terminal, an SD card, or a USB drive.

To load and run an application on the terminal, follow these steps.

1. Press Load Application from the FactoryTalk View ME Station dialog box.

2. Press Source to select the location of the file to load:
   - Internal Storage - nonvolatile memory of the terminal.
   - External Storage 1 - SD card that is loaded in the card slot.
   - External Storage 2 - USB drive that is loaded in the USB host port.

   **TIP**  The path for Machine Edition files on the terminal is My Device\Application Data\Rockwell Software\RSViewME\Runtime.
   The path for Machine Edition files on the SD card or USB drive is \Rockwell Software\RSViewME\Runtime.

3. Select an .mer file from list by using the up and down cursor keys.

4. To load the selected application, press Load.

   You are asked if you want to replace the current communication settings for the terminal with the settings that are defined in the application.

5. Select Yes or No.
   - Select Yes to use the communication settings in the application.
   - Select No to use the communication settings of the terminal.

   The application loads and the application name appears at the top of the FactoryTalk View ME Station dialog box.

6. To run the application that you loaded, press Run Application on the FactoryTalk View ME Station dialog box.

   **TIP** Applications generate log files. You can delete log files from the FactoryTalk View ME Station dialog box before running the application. Delete log files to reclaim memory in the terminal.

   To set the application to run on startup or reset, see Run the Loaded Application on Startup on page 86.
You can allow or restrict desktop access on the terminal (Series A\(^{(1)}\) terminals allow Windows CE desktop access. Series B terminals exit to the Control Panel). From the desktop, you can perform system and control panel operations, use file viewers, the web browser, and the media player. You can allow temporary access, then disable desktop access to help prevent unauthorized changes.

**TIP** Terminals are shipped from the factory with desktop access disabled.

With restricted access, the only way to access the desktop is to enter a password. Each terminal has a default password and challenge question.

<table>
<thead>
<tr>
<th>Default Password Credentials</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password</td>
<td>password (case sensitive)</td>
</tr>
<tr>
<td>Challenge question</td>
<td>What is the opposite of lock?</td>
</tr>
<tr>
<td>Challenge answer</td>
<td>unlock (case sensitive)</td>
</tr>
</tbody>
</table>

**TIP** Rockwell Automation recommends that you change the default password and challenge question and answer to something unique for your installation.

### Enable Desktop Access

To enable desktop access, follow these steps.

1. Press Terminal Settings, then choose Desktop Access Setup.
2. To select Allow, press Desktop Access.
   
   The Enter Password dialog box opens.

   Each time that you change desktop access from disallow to allow, you must enter a password. The default password is ‘password’.

3. To type the password, press Password.
4. Press Enter.
5. To return to Desktop Access Management, press Enter again.

Notice that the password is no longer set.

6. Press OK to exit Desktop Access Management, then Close to exit terminal settings and return to the FactoryTalk View ME Station dialog box.

7. To access the desktop, press Exit.

When desktop access is enabled, you are not required to enter a password.

Disable Desktop Access

IMPORTANT To restrict desktop access, the start-up option must be set to either Go to Configuration Mode or Run Current Application. See page 84 for details.

To restrict desktop access, define a desktop password and challenge question:

- The password lets you access the desktop from FactoryTalk View ME Station when pressing Exit.
- The challenge question and response lets you change the password with the Reset function.
To disable desktop access, follow these steps.

1. Press Terminal Settings, then choose Desktop Access Setup.
2. To select Disallow, press Desktop Access.

The Set Password button is enabled.

**IMPORTANT** If an error message displays, you can change the startup option to Go to Configuration Mode or Run Current Application.

You cannot restrict access to the desktop if Startup Options is configured for Do not start FactoryTalk View ME Station.

3. See **Set a Desktop Password on page 82** to define a new password and challenge question.
Set a Desktop Password

On Series B terminals (Series C for Stainless Steel terminals), the desktop password is used to exit ME into the Windows Control Panel.

**IMPORTANT** When you restrict access to the desktop, you must define a new password and challenge question.

To define a new desktop password, follow these steps.

1. Press Set Password.
   
   The Desktop Access Set Password dialog box opens.

2. Press Set Password, enter an 8…20 character password, then press Enter.

   **IMPORTANT** You must correctly enter this password before accessing the desktop.

3. Press Set Challenge to enter a challenge question that you must correctly respond to when resetting the desktop password.

4. Press Set Response to enter a response to the challenge question, then press Enter.

5. Press OK.
   
   The Desktop Access Management Dialog shows that a password and challenge question are set.

6. Press OK to return to terminal settings.

**IMPORTANT** Secure your password and challenge question for future use. To clear and reset the password, you must correctly respond to the challenge question. If you forget the response, the only way to clear the password is to restore the factory default settings on the terminal. See Factory default on page 224.
Reset the Desktop Password

To clear and change the current password, you must correctly respond to the current challenge question. If you do not remember the response, you must restore the terminal to its factory defaults. See Maintenance Mode Operations — Series A Terminals on page 224.

**IMPORTANT** You can reset the password and challenge questions if access to the desktop is restricted or set to disallow.

To reset the desktop password, follow these steps.

1. Press Reset Password from the Desktop Access Management dialog box.

2. Press Answer Challenge and enter the correct response to the current challenge question.

3. Press Clear Password to clear the current password and challenge question.

   The dialog box shows the updated status of the password and challenge information.

4. Press Close.

5. Refer to Set a Desktop Password on page 82 to set a new password and challenge question.

   After clearing the password, you must set a new desktop password or change the desktop access to allow.
Configure Start-up Options

You can specify what action the terminal takes on startup or a reset.

<table>
<thead>
<tr>
<th>This Start-up Option</th>
<th>Performs This Action</th>
<th>Typical System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not start FactoryTalk View ME Station</td>
<td>Launches the Windows desktop on startup (available only on Series A terminals. This option is not available on Series B terminals. (Series C for Stainless Steel terminals)).</td>
<td>Open</td>
</tr>
<tr>
<td>Go to Configuration Mode</td>
<td>Launches FactoryTalk View ME Station in Configuration mode on startup (factory default).</td>
<td>Closed</td>
</tr>
<tr>
<td>Run Current Application</td>
<td>Runs the FactoryTalk View ME application that is loaded in the terminal on startup.</td>
<td>Closed</td>
</tr>
</tbody>
</table>

**IMPORTANT** When desktop access is restricted, the start-up option must be set to Run Current Application or Go to Configuration Mode (default). See page 79 for details on how to allow or restrict desktop access.

**TIP** You can also launch the desktop by pressing Exit on the FactoryTalk View ME Station dialog box.

Disable FactoryTalk View ME Station on Startup

To launch the desktop on startup, you must disable FactoryTalk View ME Station.

**TIP** You can also launch the desktop by pressing Exit on the FactoryTalk View ME Station dialog box.

To disable FactoryTalk View ME Station on startup, follow these steps.

1. Press Terminal Settings, then choose Startup Options.

2. Press On Startup until ‘Do not start FactoryTalk View ME Station’ is selected.

   **TIP** On Series A terminals only, desktop access must be set to allow or you get a warning. See Enable Desktop Access on page 79.

3. Press OK.
Chapter 3
Enter Configuration Mode on Startup

To launch FactoryTalk View ME Station in Configuration mode on startup, follow these steps.

1. Press Terminal Settings, then choose Startup Options.
2. To select Go to Configuration Mode, press On Startup.
3. To view or change optional settings, press Configuration Mode Options.

4. To specify whether you want to load the current application on startup, press Load Current Application.
5. To specify what configuration settings are used when the loaded application is run, press Replace RSLinx® Enterprise Communications:
   - To use the RSLinx communication settings in the terminal, select No.
   - To replace the terminal settings with the communication settings in the application, select Yes. Any changes to RSLinx device addresses or driver properties on the terminal are lost.
6. To return to the previous dialog box, press OK.
7. To return to terminal settings, press OK.

TIP  On Series B terminals, the Do not start FactoryTalk View ME Station option is not available and is grayed out. (1)

(1) Series C for Stainless Steel terminals.
Run the Loaded Application on Startup

To run the FactoryTalk View .mer application that is loaded in the terminal on startup, follow these steps.

1. Press Terminal Settings, then choose Startup Options.
2. To select Run Current Application, press On Startup.
3. To view or change optional settings, press Run Options.

If the application is not loaded, the options are disabled.

4. To specify what configuration settings are used when running the application, press Replace FactoryTalk Linx Communications:
   - To use the RSLinx communication settings in the terminal, select No.
   - To replace the terminal settings with the communication settings in the application, select Yes. Any changes to RSLinx device addresses or driver properties on the terminal are lost.
5. To specify what action to take with the log files on startup, press Delete Log Files On Every Power Cycle:
   - To delete all log files (data, alarm history, alarm status) generated by the terminal before running the application, select Yes. The files are deleted from the system default location.
   - To retain all log files, select No.
6. To return to the previous dialog box, press OK.
7. To return to terminal settings, press OK.
Configure Controller Address

You can configure communication information for your application and controller by using FactoryTalk® Linx software.

**TIP** You can also configure communication information for your application and controller by using FactoryTalk View Studio software.

To edit the device address of the controller, follow these steps.

1. Press Terminal Settings, then choose Networks and Communications>FactoryTalk Linx Communications.

![Configure Controller Address Diagram]

2. Select the controller in the tree.

3. To view the device name and current address, press Edit Device.

4. To modify the address, press Device Address.

   The input panel opens with the current address.

5. Enter the address in the input panel and press Enter.

6. Press OK.

Updates do not take effect until the terminal is restarted.

Configure Ethernet Settings

The terminal has a built-in Ethernet driver. You can modify the Ethernet information for your device:

- IP address of terminal on network including link speed
- Device name that identifies terminal on network
- User name and password to access network resources
- Enable or disable either Ethernet port to configure for DLR, star, or linear network topologies
Set the Ethernet Address of the Terminal

Some networks automatically assign an IP address to Ethernet devices if Dynamic Host Configuration Protocol (DHCP) is enabled. If DHCP is disabled, you can manually enter an IP address.

To view or enter an IP address for your terminal, follow these steps.

1. Press Terminal Settings, then choose Networks and Communications>Network Connections>Network Adapters.

2. To view or modify the IP address, press IP Address.

3. To enable or disable DHCP assignment of addresses, press Use DHCP.
   - If DHCP is enabled or set to Yes, IP addresses are automatically assigned to newly attached devices on the network.
   - If DHCP is disabled or set to No, you can manually enter the IP address. Press IP Address, Subnet Mask, and Gateway to enter IP formatted addresses.

   **TIP**
   - IP Address: The format of the IP address is xxx.xxx.xxx.xxx, for example, 10.90.95.15. The first set of decimal numbers is in the range 1…255; the last three sets in the range 0…255. The default is 000.000.000.000.
   - Subnet Mask: Address must be identical to the server subnet mask.
   - Gateway: Optional address.
   - MAC ID: Read-only field.

4. Press OK when done.
   - If prompted, reset the device from the FactoryTalk View ME Station dialog box.

5. Press Close.
Set the Ethernet Link Speed

You can change the rate and mode at which data is transmitted on the Ethernet network. The default setting is Auto. The Auto option automatically configures the speed of the device to match the speed on the local network.

**TIP**  The Auto option is preferred because it determines the actual speed and duplex setting of the connected device on the Ethernet network. If you select a manual option, make sure that the speed and duplex setting for the connected device on the Ethernet network is identical. If the settings are different, there can be decreased network performance and errors.

1. Press Terminal Settings, then choose Networks and Communications>Network Connections>Network Adapters.
2. To access the Ethernet link settings, press Settings.
3. To change the rate at which data is transmitted over the Ethernet network, press Ethernet Configuration.
4. To return to the Network Adapters dialog box, press OK.
Define Name Server Addresses

You can define Name Servers addresses for the EtherNet/IP network adapter. These addresses are automatically assigned if DHCP is enabled for the adapter.

1. Press Terminal Settings, then choose Networks and Communications>Network Connections>Network Adapters.

2. Press Name Servers.

3. To enter a corresponding name server address, press a button.

4. Press OK when done.

TIP Primary WINS and Secondary WINS are not available on Series B terminals (Series C for Stainless Steel terminals).

Configure the Ethernet Ports

To configure the Ethernet ports of the terminal, follow these steps.

1. Press Terminal Settings, then choose Networks and Communications>Network Connections>Network Adapters.

2. To access the Ethernet link settings, press Settings.
3. To enable or disable the ports that you want to use for your network configuration, press Ethernet Link1 and Ethernet Link2.

4. To select Auto, press Ethernet Configuration.

5. To save the configuration, press OK.

6. Restart the terminal for the changes to take effect.

You can also configure the Ethernet ports as a system default for a closed system. See Configure the Ethernet Ports on page 154.

**View the Network Diagnostic Data**

To view the network data, follow these steps.

1. Press Terminal Settings, then choose Networks and Communications>Network Connections>Network Adapters>Network Diagnostics.
The table provides a description of Network Status text.

<table>
<thead>
<tr>
<th>Status Text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Status</td>
<td></td>
</tr>
<tr>
<td>Normal</td>
<td>If network topology is Linear/Star, the network status is always normal.</td>
</tr>
<tr>
<td>Ring Fault</td>
<td>A non-fatal error condition exists.</td>
</tr>
<tr>
<td>Loop Detected</td>
<td>This value can only occur in a Linear/Star topology. This status occurs when an unexpected loop occurs in the network. It may not be possible for the terminal to report this condition (the terminal may not be capable of detecting frames that it has sent).</td>
</tr>
<tr>
<td>Network Topology</td>
<td>Identifies the network configuration as Linear/Star or Ring.</td>
</tr>
</tbody>
</table>

2. Press Close to exit the Network Diagnostic data.

**Modify Device Name of Terminal**

Each terminal has a unique name that identifies it on the network.

1. Press Terminal Settings, then choose Networks and Communications>Network Connections>Device Name.

2. To view or edit the default device name, press Device Name.

   ![Device Name Interface](image)

   **TIP** The device name has 1…15 characters:
   - First character must be an upper or lowercase letter a…z, A…Z.
   - The other characters can be a…z, A…Z, 0…9, or - (hyphen).

3. To modify the description for the device, press Device Description.

   **TIP** The description is a maximum of 50 characters. The default description is Rockwell Automation plus the device catalog number.

4. Press OK.
Copy Files on Terminal

You can copy FactoryTalk View ME application (.mer) files or font files between nonvolatile memory of the terminal and a USB drive, or SD card.

1. Press Terminal Settings, then choose File Management > Copy Files > Copy Applications or Copy Fonts.

2. To select the location of the file you want to copy, press Source:
   - Internal Storage - nonvolatile memory of the terminal.
   - External Storage 1 - SD card that is loaded in card slot of terminal.
   - External Storage 2 - USB drive that is loaded in USB host port of terminal.

3. Select a file that appears in the list for the selected storage area.

4. Press Destination on the same dialog box.

5. To select the storage location to copy the file, press Destination.
   The destination must be different than the source location.

6. To copy the selected file to the target location, press Copy.
   If the file exists, you are asked if it is okay to overwrite the file. Respond by selecting Yes or No.

   **TIP**  FactoryTalk View ME Station software looks for .mer files in the folder \\My Device\Application Data\Rockwell Software\RSViewME\Runtime\ and font files in the folder \\Rockwell Software\RSViewME\Fonts\.
Delete Files from Terminal

You can delete FactoryTalk View ME application .mer files or font files that reside in nonvolatile memory of the terminal, a USB drive, or an SD card.

1. Press Terminal Settings, then choose File Management>Delete Files>Delete Applications or Delete Fonts.

2. To select the storage location of the application or font file you want to delete, press Source:
   - Internal Storage - nonvolatile memory of the terminal.
   - External Storage 1 - SD card that is loaded in card slot of terminal.
   - External Storage 2 - USB drive that is loaded in USB host port of terminal.

3. Select a file that appears in the list for the selected storage area.
4. Press Delete.
5. Select Yes or No when asked if you want to delete the selected application or font file.

Delete Log Files

You can delete log files, alarm history files, and alarm status files from the System Default location of the terminal. The application generates these files during runtime.

1. Press Terminal Settings>File Management>Delete Files>Delete Log Files.
   You are asked to confirm the deletion of the files.
   Do you want to delete all FactoryTalk View ME Station Log Files?
2. Select Yes or No.

Log files not in the System Default location are not deleted.
Display Settings

For the terminal display, you can change its brightness, configure the screen saver, or disable the screen cursor.

Adjust Display Intensity

You can adjust the intensity of the backlight in 10% increments from 0…100%. At 0%, the backlight is minimally visible. You can use the default intensity of 100% or adjust the intensity for runtime operations.

1. Press Terminal Settings, then choose Display>Display Intensity.

   ![Display Intensity Settings]

   **TIP** Startup Intensity is not available on Series B terminals (Series C for Stainless Steel terminals).

2. To switch between Default intensity and Runtime intensity, press Startup Intensity.
   - If you select Runtime, the start-up screens use the runtime intensity.
   - If you select Default, the start-up screens use the default setting of 100%.

3. To increase or decrease the intensity for runtime operations, press the up or down cursors.

4. To save changes, press OK.

Configure the Screen Saver

**TIP** Screensaver is not available in the initial Series B release (Series C for Stainless Steel terminals); it will be added at a later date.

A screen saver image appears on the terminal display when no user activity has been sensed for a certain time. The default idle time is 10 minutes. You can adjust the idle time and intensity level of the screen saver, disable the screen saver, or disable the screen saver image.

1. Press Terminal Settings, then choose Display>Screen Saver.
2. To change the idle period for activating the screen saver, press Screen Saver.
   To disable the screen saver, select Disabled.

3. To increase or decrease the brightness intensity of the screen saver, press the up and down cursors.

4. To access the screen saver image setting, press Advanced Settings.
   a. To disable or enable the current screen saver, press Screen Saver Image.
      See Screen Saver on page 130 for details on how to change the screen saver image.
   b. To return to the Screen Saver dialog box, press OK.

5. To exit and return to terminal settings, press OK.

**Disable the Screen Cursor**

**TIP**  This is an unsupported feature on Series B terminals (Series C for Stainless Steel terminals).

The terminal has a screen cursor that you can disable or enable.

1. Press Terminal Settings, then choose Display > Cursor.

2. To disable or enable the cursor, press Enable Cursor.

3. To exit and return to terminal settings, press OK.
Input Device Settings

You can adjust settings for input devices that are used by the terminal including the keypad, touch screen, attached keyboard or mouse, and string entry popup.

Configure Keyboard or Keypad Settings

**TIP** This is an unsupported feature on Series B terminals (Series C for Stainless Steel terminals). The Keyboard/Keypad configuration page is removed from Series B terminals (Series S for Stainless Steel terminal).

You can adjust settings for keys on the terminal or an attached keyboard.

1. Press Terminal Settings, then choose Input Devices>Keyboard/Keypad.

2. Press Repeat Rate to specify the number of times a key repeats itself per second when held down.

   Valid values are 0, 2...30. Values are device-dependent for an attached keyboard, but typically the same.

3. Press Repeat Delay to select the time that elapses per second before a key is repeated.

   Values are device-dependent. Unsupported values are dimmed.

4. Press OK when done.
Calibrate the Touch Screen

To calibrate PanelView Plus 7 Performance Series A terminals with a touch screen, follow these steps. For information on how to calibrate the Series B terminals (Series C for Stainless Steel terminals), see Initial Startup — Series B Terminals on page 52.

**IMPORTANT** Use a plastic stylus with a minimum tip radius of 1.3 mm (0.051 in.) A stylus is more precise than a finger and also helps to protect the screen.

1. Press Terminal Settings, then choose Input Devices>touch screen>Calibration.

   Carefully press and briefly hold stylus on the center of the target. Repeat as the target moves around the screen.

2. Follow the instructions on the screen.

   When the calibration is complete, a message appears to indicate the measurement of new calibration settings.

<table>
<thead>
<tr>
<th>On This Type of Terminal:</th>
<th>Do This:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touch screen only</td>
<td>• Press the screen to register saved data.</td>
</tr>
<tr>
<td></td>
<td>• Wait for 30 seconds to cancel saved data and keep the current settings.</td>
</tr>
<tr>
<td>Keypad and touch screen</td>
<td>• Press the Enter key to accept new settings.</td>
</tr>
<tr>
<td></td>
<td>• Press the Esc key to cancel and keep the current settings.</td>
</tr>
</tbody>
</table>
Set the Double-tap Sensitivity for a Touch Screen

You can set and test the sensitivity of both speed and physical distance between touch screen presses.

**TIP** The process is identical for setting and testing the sensitivity of mouse clicks. To adjust the sensitivity of mouse clicks, press Terminal Settings, then choose Input Devices>Mouse.

1. Press Terminal Settings, then choose Input Devices>touch screen>Double Tap Sensitivity.

2. To set the sensitivity of touch screen presses, double-tap Set.

3. To test the sensitivity of touch screen presses, double-tap Test.
   The Test button reverses its foreground and background colors.

4. Press OK when done.

Change the Popup for String Entry

You can use a string popup for character input instead of the popup keyboard or input panel.

1. Press Terminal Settings, then choose Input Devices>String Popup.

2. To select the preferred method for character input, press Invoke pop-up character input instead of pop-up keyboard.

3. Press OK.
Change Popup Input Color Settings

You can change the popup input color settings for your terminal.

1. Press Terminal Settings, then choose Input Devices.

2. In the Input Devices dialog box, choose Pop-Up Input Color Settings.
3. In the Pop-up Input Color Settings dialog box, choose the input element for which you want to change the color: Keypad, Keyboard, or Character input.

4. Choose each of the color areas you want to modify for the input element, for example, Back color, and then select a color for that area.

5. To save the color changes, click OK.

The new colors are changed for that input element, as shown in the following example.
Configure Print Options

You can configure settings to print displays, alarm messages, or diagnostic messages from FactoryTalk View ME applications. The setup to print displays and messages are the same; advanced settings are different.

**TIP** The following information applies to PanelView Plus 7 Performance Series A terminals. Series B terminals (Series C for Stainless Steel terminals) support the Internet Printing Protocol (IPP). On Series B terminals (Series C for Stainless Steel terminals), if a network printer is plugged in at terminal startup, the printer will be automatically detected and there is no requirement to configure printer drivers. However, the IPP service needs to be enabled for this automatic detection to work. See Services Screen on page 174 for information on how to enable this service.

PanelView™ Plus 7 Performance Series A terminals support selected printers. For a list of supported printers, go to [https://rockwellautomation.custhelp.com](https://rockwellautomation.custhelp.com) and search the Knowledgebase for keywords ‘Printers Supported on PanelView Plus’.

PanelView Plus 7 Performance Series A terminals support selected Canon, Epson, Hewlett-Packard, and Brother printers. Printer installation is plug-and-play. Supported printers are automatically mapped to appropriate driver. Printers that do not configure automatically to the appropriate driver can be installed manually.

To access the print setup, follow these steps.

1. Press Terminal Settings, then choose a Print Setup> option:
   - Alarm Print Setup
   - Diagnostic Setup
   - Display Print Setup

The Print Setup dialog box shows installed printers that are available to the FactoryTalk View ME application. The list of printers that shows depends on what printers you install.
The terminals are not shipped with pre-configured printers so initially the dialog box is empty.

**TIP**  Series B terminals (Series C for Stainless Steel terminals) have a pre-configured printer driver. With the IPP service enabled on Series B terminals (Series C for Stainless Steel terminals), if an IPP printer is detected it automatically appears in the printer selection list.

The PDF printer driver is available by default on Series A and Series B terminals (Series C for Stainless Steel terminals).

2. Select an installed printer.

**TIP**  The printer you select must be in the control panel Printers applet.

A failed attempt to automatically install a printer is reported in the system event log.

A printer that does not install automatically can be installed manually by using the control panel in Windows Explorer.
3. To access these options, press Advanced Settings:
   - Options to print displays include print orientation, draft mode, and color.
   - Options to print diagnostic and alarm messages determine when to print messages that are sent to the network or USB port.

<table>
<thead>
<tr>
<th>Print Messages After</th>
<th>Default Value</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified number of messages</td>
<td>60 messages</td>
<td>When the queue has 60 messages, the messages are printed regardless of how long they have been in the queue. You can change the number of messages.</td>
</tr>
<tr>
<td>500 messages or timeout period, whichever is first</td>
<td>168 hours (7 days)</td>
<td>If the queue has 350 messages after 168 hours, the 350 messages are printed. You can change the timeout period.</td>
</tr>
<tr>
<td>Specified number of messages or timeout period, whichever is first</td>
<td>60 messages 168 hours (7 days)</td>
<td>If the queue has 60 messages after 24 hours, then the 60 messages are printed. You can change the number of messages and the timeout period. For example, the number of messages is set to 75 and the timeout period is set to 48 hours. If the queue has 75 messages after 24 hours, then the 75 messages are printed before the set timeout of 48 hours. If the queue has 15 messages after 48 hours, the 15 messages are printed after the set timeout period.</td>
</tr>
</tbody>
</table>

4. Press OK when done.

5. Press OK to return to terminal settings.
Configure Diagnostics

You can log diagnostics to a remote computer for troubleshooting.

To configure and forward diagnostics to a computer, follow these steps.

1. Press Terminal Settings, then choose Diagnostic Setup.

A list of diagnostic nodes appears.

TIP To access Remote Log or Message Routing setup, select the node then press Edit.

The Remote Log destination forwards messages to a Windows computer that runs diagnostics. The IP address and port number identify the computer.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>IP address of the remote Windows computer.</td>
<td>xxx.xxx.xxx.xxx</td>
</tr>
<tr>
<td>Port</td>
<td>The port that is used to communicate with the remote Windows computer.</td>
<td>4445 (default)</td>
</tr>
</tbody>
</table>

Select Message Routing to access the following dialog boxes:

- Remote Log
- FactoryTalk View Diagnostics List

Each dialog box shows a list of message that can be sent to a destination. Cursor to a message, then press On/Off to enable or disable the message. Messages with checked boxes are enabled. Messages with cleared boxes are disabled.

Audit Message Logging lets you log messages as Audit or Information.
Check Integrity of Application Files

It is good practice to periodically check the integrity of the .mer application that is loaded in the terminal and the runtime files. Errors, warnings, and information messages are logged to a file. You can view the log and clear items from the log.

**TIP** Runtime files allow applications to run on the terminal. If the terminal is not functioning correctly, a review of the logs can identify an error in a runtime file.

1. Press Terminal Settings, then choose File Integrity Check.

2. Press either of the Enable options to disable integrity checks of the .mer application or the runtime files.

   Integrity checks are automatically performed on the application .mer file and runtime files. If you disable either of these functions, the files are not checked and the log file is not updated.

3. To save changes, press OK.

To view the log generated by runtime files, follow these steps.

1. Press View Log from the File Integrity Check dialog box.

2. To display details for that event, select an event and press More Details.

3. To clear all details from the log, press Clear All.

4. To return to previous dialog box, press Close.
View and Clear the System Event Log

Note: The following information applies to PanelView Plus 7 Performance Series A terminals. For Series B terminals (Series C for Stainless Steel terminals), the Control Panel contains the System Event Log.

The System Event Log displays warnings, errors, and events logged by the terminal. The log provides a time stamp of when each event occurred and text that describes the event. If the event log is full when a new event occurs, the oldest entry is removed to accommodate the new event.

2. To display details for the event, select an event and press More Details.
3. Press Clear All to clear all events in the log.
4. Press Close.

Enable or Disable the Alarm Display

The terminal displays each alarm as it occurs in the alarm display or alarm banner. When the operator acknowledges the most recent alarm, the alarm display closes or remains open. The default is to close the alarm display.

1. Press Terminal Settings, then choose Alarms.
2. Press “Close Alarm Display When Newest Alarm Acknowledged” to toggle between Yes or No.
   - Yes closes the alarm display when the newest alarm is acknowledged.
   - No leaves the alarm display open when newest alarm is acknowledged.

3. Press OK.

**Display System Information**

You can view terminal and firmware revision information for software that is installed on a terminal.

**View Terminal Information**

You can view the following read-only information:
- Total power on time in minutes
- Processor temperature
- Battery voltage and state
- Memory that is allocated and used
- Random access memory (RAM) memory usage during runtime

To view status information for your terminal, follow these steps.

1. Press Terminal Settings, then choose System Information>Terminal Information.

   ![Terminal Information Screen]

   Processor temperature must be less than 90 °C (194 °F).

**IMPORTANT** Over-temperature messages are recorded in the system event log:
- 85 °C (185 °F) issues a warning message.
- 90 °C (194 °F) issues an error message.
Battery voltage must be at least 2.75V DC.

<table>
<thead>
<tr>
<th>Battery State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GOOD</td>
<td>Good battery condition.</td>
</tr>
<tr>
<td>FAILING</td>
<td>Low battery. Replace the battery.</td>
</tr>
<tr>
<td>BAD</td>
<td>Battery is missing or bad. Replace the battery.</td>
</tr>
</tbody>
</table>

2. To view information about storage RAM, program RAM, and available nonvolatile memory, press Memory Allocation.

3. To return to previous dialog box, press Close.

4. To troubleshoot anomalies by showing RAM used by the application at runtime, press Runtime RAM Usage.

5. To return to the previous dialog, press OK.

6. Press Close until you return to terminal settings.
Chapter 3

View FactoryTalk View ME Station Information

You can view firmware and version information for components that are installed on your terminal and access technical support information.

1. Press Terminal Settings, then choose System Information> About FactoryTalk View ME Station.

2. To display the support telephone number and website, press Technical Support.

3. Press Close until you return to terminal settings.
Time and Date Settings

You can change the date, time, time zone, and regional settings for terminal operations.

**TIP**  Set the time zone before you change the current date and time on the terminal.

Change the Time Zone on Terminal

You can view or modify the current time zone on the terminal. Time zones are installed with the operating system. Changing the time zone adjusts the current time and date to match the time zone.

The clock in the terminal records the time when files are created or modified on the terminal. You can change the time and time zone of the clock.

1. Select Terminal Settings, then choose Time/Date/Regional Settings>Time Zone.

2. To select a time zone, press the up or down cursor.
   
   Daylight Saving Time is enabled for all time zones except Japanese, which does not support daylight savings. The clock is adjusted automatically when Daylight Saving Time changes.

3. Optionally, press Daylight Savings to enable or disable Daylight Saving Time for a time zone.

4. Press Close when done.

5. To return to the previous dialog box, press OK.
Chapter 3

Change the Current Date on Terminal

To adjust the date on the terminal, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional Settings>Date.

2. To change the current values above the button, press Year, Month, and Day:
   - Year is four digits in the range 1980...2099
   - Month is in the range 1...12
   - Day is in the range 1...31 and validated by month

3. Press OK when done.

Change the Current Time on Terminal

To adjust the time on the terminal, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional Settings>Time.

2. To change the current values, press Hour, Minute, and Seconds:
   - Hour range is 0...23 (24-hour format)
   - Minute and second range is 0...59

3. Press OK when done.
Regional Settings

You can change the format to display dates, times, and numerics to match the standards of a country or region. Languages are installed with the operating system. Before changing regional settings, you must select a language.

To select a language that is installed on the terminal, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional Settings>Language.

2. To select a language, press the up and down cursors.

3. Press OK.

The selected language shows under Current Language on the Regional Settings dialog box.

Change the Decimal Separator

You can change the decimal separator that is used in numeric formats for the selected language. The default separator is a period.

1. Select Terminal Settings, then choose Time/Date/Regional Settings>Numeric Format.

- The default separator is shown.

2. Enter a maximum of three characters for the new separator.

3. Press OK.
Change the Time Format for a Language

To change the format of the time for the selected language, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional Settings>Time Format.

2. The current time appears in the selected format.

3. To adjust the formats, press the appropriate selections.

The sample format changes as you make selections.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Format</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12 hour</td>
<td>h:mm:ss tt (default) h = 12-hour time display, no leading zero</td>
<td>7:23:02 AM or 1:13:31 PM</td>
</tr>
<tr>
<td></td>
<td>tt = AM or PM symbol</td>
<td>11:43:59 AM</td>
</tr>
<tr>
<td></td>
<td>hh:mm:ss tt</td>
<td>07:23:02 AM or 01:13:31 PM</td>
</tr>
<tr>
<td></td>
<td>hh = 12-hour time display with leading zero</td>
<td>11:43:59 PM</td>
</tr>
<tr>
<td>Time Format</td>
<td></td>
<td></td>
</tr>
<tr>
<td>24 hour</td>
<td>H:mm:ss</td>
<td>7:03:42 or 1:13:32</td>
</tr>
<tr>
<td></td>
<td>H = 24-hour time display, no leading zero</td>
<td>23:43:59</td>
</tr>
<tr>
<td></td>
<td>HH:mm:ss</td>
<td>07:03:42 or 01:13:22</td>
</tr>
<tr>
<td></td>
<td>HH = 24-hour time display with leading zero</td>
<td>23:43:59</td>
</tr>
<tr>
<td>AM Symbol</td>
<td>Characters to indicate AM. If the time format is set to a 12-hour time</td>
<td>AM (default)</td>
</tr>
<tr>
<td></td>
<td>display (h:mm:ss tt or hh:mm:ss tt), you can modify the AM symbol.</td>
<td>12 character max</td>
</tr>
<tr>
<td>PM Symbol</td>
<td>Characters to indicate PM. If the time format is set to a 12-hour time</td>
<td>PM (default)</td>
</tr>
<tr>
<td></td>
<td>display (h:mm:ss tt or hh:mm:ss tt), you can modify the PM symbol.</td>
<td>12 character max</td>
</tr>
<tr>
<td>Separator</td>
<td>Characters that separate fields in time format.</td>
<td>: (default)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 character max</td>
</tr>
</tbody>
</table>

4. Press OK.
Change the Short Date Format for a Language

To change the short date format for the selected language, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional Settings>Short Date Format.

   ![Short Date Format Settings](image)

   2. To change the short date format, press Format.

      The date updates in the Sample area as you make changes.

   3. To change the character between date elements, press Separator.

      The separator can be three characters. The default separator is – or /.

   4. Press OK when done.

Change the Long Date Format for a Language

To change the long date format for the selected language, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional Settings>Long Date Format.

   ![Long Date Format Settings](image)

   2. To change the long date format, press Format.

      The date updates in the Sample area as you make changes.

   3. Press OK when done.
The PanelView Plus 7 Performance Series B terminals (Series C for Stainless Steel terminals) allow you to select a KEPServer driver.

1. Select Terminal Settings.

2. In the Terminal Settings dialog box, select Networks and Communications.
3. In the Networks and Communications dialog box, select KEPServer Driver Configuration.

4. Use the arrow keys to highlight the desired drivers, and then click the On/Off button to select the drivers.
5. Click OK when you are finished.

**IMPORTANT** A terminal reset is necessary for the settings to take effect.

6. Click Yes and Restart your computer.

Certificate Management (Series B Only)$^{(1)}$

The PanelView Plus 7 Performance Series B terminals (Series C for Stainless Steel terminals) allow you to import and update certificates for your terminal.

Before you can use the Certificate Import tool, you need to copy the certificates to the Certificates folder by. You can do this by using Control Panel>Explore>File Explorer.
After you copy the certificates to the Certificates folder, complete the following steps to copy the certificates to your terminal.

1. Select Terminal Setting, and then select Certificates Management.

2. In the Certificates dialog box, select the certificate in the list, and then click the Import button.
   The certificates are imported to your PanelView terminal.
Chapter 4

Windows CE Operating System — Series A Terminals

Operating System Features

The PanelView™ Plus 7 Performance terminals run the Windows CE 6.0 operating system (OS) providing the following features:

- Command shell
- Command processor
- Console window
- Windows Explorer shell
- Common dialog box
- Control panel
- Network user interface
- Soft keyboard input panels
- PDF reader
- Mouse and touch screen support with right-click support.

TIP Touch the screen for 1 second or longer for a right-click.

- VNC server and client viewer
Application Support

The Windows CE operating system supports these applications:

- .NET Compact Framework, version 3.5 or later
- C++ libraries and runtimes
- Component services DCOM/COM/OLE
- Message queuing MSMQ
- MSXML, version 3.0 or later
- Microsoft foundation classes (MFC) for devices, version 9.0 or later
- Active template library (ATL)
- ActiveSync
- Cabinet (CAB) file installer/uninstaller
- ToolHelp application programming interface (API)
- Error reports (generator, transfer driver, control panel)

Scripting Support

The Windows CE operating system supports these scripting features:

- Batch/Command (BAT and Cmd files)
- CS-Script
- JScript

Network Support

The Windows CE 6.0 operating system supports these network features:

- Winsock support
- Network utilities - ipconfig, ping, route
- Network Driver Architecture (NDIS)
- Windows Networking API/Redirector
- Wired Local Area Network, 802.3, 802.5
Server Support

The Windows CE 6.0 operating system supports these servers.

**Table 22 - Windows CE 6.0 Server Support**

<table>
<thead>
<tr>
<th>Server</th>
<th>Default State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web server</td>
<td>Enabled</td>
<td>The web server delivers content, such as web pages, by using the HTTP protocol over the web.</td>
</tr>
<tr>
<td>FTP server</td>
<td>Enabled</td>
<td>File Transfer Protocol (FTP) is a standard network protocol for exchanging files over the Internet (TCP/IP-based network).</td>
</tr>
<tr>
<td>UPnP server</td>
<td>Enabled</td>
<td>Universal Plug and Play (UPnP) is a set of networking protocols that lets devices install and connect to a network.</td>
</tr>
<tr>
<td>File Server</td>
<td>Disabled</td>
<td>A network protocol that provides shared access to files, printers, serial ports, and miscellaneous communication between computers on a network.</td>
</tr>
<tr>
<td>VNC server</td>
<td>Disabled</td>
<td>Virtual Network Computing (VNC) is a graphical desktop sharing system that you can use to remotely control another computer. It transmits keyboard/mouse events from one computer to another, over a network.</td>
</tr>
<tr>
<td>ViewPoint Server</td>
<td>Enabled</td>
<td>A web server application that provides remote user access via a web browser to the FactoryTalk® View Machine Edition HMI application that is running on the terminal. ViewPoint software is a Rockwell Automation product.</td>
</tr>
</tbody>
</table>

Extended Features

The PanelView Plus 7 Performance terminals support these additional desktop applications that are not available on the PanelView Plus 7 Standard terminals.

**Table 23 - Operating System with Extended Features**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Software</th>
<th>Icon</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Internet Explorer" /></td>
<td>Microsoft Internet Explorer 6 web browser with Silverlight 2</td>
<td><img src="image" alt="Office" /></td>
<td>Microsoft Office 2003 PowerPoint file viewer</td>
</tr>
<tr>
<td><img src="image" alt="Flash" /></td>
<td>Adobe Flash Lite 3.1 ActiveX plug-in for Internet Explorer 6</td>
<td><img src="image" alt="Office" /></td>
<td>Microsoft Office 2003 Word file viewer</td>
</tr>
<tr>
<td><img src="image" alt="Remote Desktop" /></td>
<td>Microsoft Remote Desktop Connection</td>
<td><img src="image" alt="Office" /></td>
<td>Microsoft Office 2003 Excel file viewer</td>
</tr>
<tr>
<td><img src="image" alt="Player" /></td>
<td>Microsoft media player 6.4 and 7.0 OCX</td>
<td><img src="image" alt="Image" /></td>
<td>Westtek JETCET PDF viewer</td>
</tr>
<tr>
<td><img src="image" alt="WordPad" /></td>
<td>Microsoft WordPad text editor</td>
<td><img src="image" alt="Image" /></td>
<td>Image viewer</td>
</tr>
</tbody>
</table>
Chapter 4

Windows Explorer

Use one of these methods to access Windows Explorer from the desktop:

• Open the My Device icon.
• Choose Start>Programs>Windows Explorer.

A few folders contain items specific to the PanelView Plus 7 Performance platform.

<table>
<thead>
<tr>
<th>Folder</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Data</td>
<td>Contains FactoryTalk View Machine Edition application files. Path: \Application Data\Rockwell Software\RSViewME</td>
</tr>
<tr>
<td>VFS (Virtual File System)</td>
<td>Contains firmware files and backup/restore files for the current system image. Path: \VFS\Platform Firmware</td>
</tr>
</tbody>
</table>

Taskbar

From the taskbar, you can access the Start menu, device IP information, the current language and time, input panels, and open programs.

To turn the taskbar on or off, follow these steps:

1. Choose Start>Settings>Taskbar>Start Menu.
2. Clear or check the Auto Hide checkbox.

   **TIP** On touch screen terminals, touch the bottom of the display to recover the taskbar when in Auto Hide mode.

Soft Input Panels

The operating system offers different input panels for entering data. You can access the input panels from the taskbar or the control panel. From the taskbar, click the input panel icon and choose the input panel (keyboard) that you want to use:

• CHT Chajei IM (Chinese)
• CHT Phonetic IM (Chinese)
• Keyboard (small keyboard)
• LargeKB (large keyboard)
• MS Kana IM (Japanese)
• MS Roma IM (Japanese)
• Hide Input Panel (closes the keyboard)

   **TIP** The input panel icon changes depending on which input panel you select.
Windows Control Panel

Applications in the Windows control panel let you view and configure system and terminal settings. For example, you can monitor hardware performance, perform a touch screen calibration, or adjust screen saver settings.

**TIP** Most terminal settings are also available in FactoryTalk View ME Station Configuration mode.

The language of the control panel applications is based on the language set for the operating system. English is the default.

Use one of these methods to access the control panel:

- Choose Start>Settings>Control Panel.
- Open My Device on the desktop, then double-click Control Panel.

This chapter covers control panel applications specific to the terminal.

**TIP** From the View menu, you can change the size of the icons or see a brief description of each.

**TIP** Many control panel applications have scroll bars to allow you to view information on smaller displays.
Backup and Restore

The Backup and Restore application lets you back up the current system image on the terminal, then restore that image to the same terminal or other HMI devices. This function is useful if you want to copy the same system image to multiple HMI devices.

**TIP** You can back up a system image to a USB drive or SD card. Rockwell Automation recommends using a USB drive or SD card with a minimum of 1 GB of available space. For applications with a large file system, use a minimum of 2 GB of available space.

A typical backup image includes the following items:

- File system
- Firmware image
- Windows registry
- Optional user configuration data

To include user configuration data in the backup image, click Advanced Network & Display Settings in the Backup & Restore dialog box.

**Table 24 - Advanced Network Display Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Ethernet Network | • DHCP-enabled or fixed IP address  
|                | • Primary and secondary DNS  
|                | • Primary and secondary WNS  
|                | • Speed and duplex settings                                                 |
| USB network    | USB IP address and subnet mask, Gateway, DHCP-enabled or fixed IP address   |
| Network        | Device name                                                                  |
| Display        | • Display brightness  
|                | • Screen saver dimmer timeout                                               |

**Perform a Backup**

To perform a backup, follow these steps.

1. Insert a USB drive or SD card into the appropriate slot on the terminal.
2. In the control panel, double-click the Backup & Restore icon.
3. Click the browse... button on the Backup tab.

4. Select the target location for the back-up file:
   - USB Storage if you use a USB drive
   - Storage Card2 if you use an SD card
   - Target folder if you back up the file to the terminal

5. Type a name for the back-up file.
   Back-up files have the .pvb file type.

6. Click OK.

7. Click Backup to start the process.
   A progress bar shows the status of the operation. The backup can take a few minutes. You receive notification when the backup completes.

8. Click OK.
   If a file exists, you are asked if you want to overwrite the current file.

9. To close the Backup & Restore dialog box, click Exit.

   TIP To verify the .pvb file was successfully created, double-click My Device and select the target location for the backup. If the .pvb file was not successfully created, use a USB drive or SD card with more available space.

   Rockwell Automation recommends using a USB drive or SD card with a minimum of 1 GB of available space. For applications with a large file system, use a minimum of 2 GB of available space.
**Restore a Back-up Image**

To restore or clone a back-up image to a storage device, follow these steps.

1. Insert the USB drive or SD card into the appropriate slot of the target device.
2. In the control panel, double-click Backup & Restore.
3. Click the Restore tab.
4. To select the back-up file to restore, click the...browse button.
5. Select the location of the back-up file:
   - USB Storage if you use a USB drive
   - StorageCard2 if you use an SD card
6. Select the .pwb back-up file that you want to restore.
7. Click OK.
8. Click Restore.
   The restore includes advanced network and display settings if you selected this option when performing the backup.
9. To start the restore, click Yes.
The terminal starts the restore process, which takes few minutes.

When the restore completes successfully, the terminal restarts.

**IMPORTANT**

Do not remove the USB drive, SD card, or power off the terminal during a restore. These actions can corrupt the firmware.

If the restore fails, reset the terminal from the maintenance menu.

See *Maintenance Mode Operations — Series A Terminals on page 224* for details.

When the restore completes successfully, the terminal restarts.

**Display Properties**

Use Display Properties to control the desktop background image and appearance, the brightness of the backlight, and screen saver settings.

**Desktop Background**

The Background tab in Display Properties controls the background bitmap on the desktop. The default bitmap is ‘abclocknight’.

You can select another image from the pull-down menu or browse the system for a bitmap image. Custom images are in the \Windows folder.
**Desktop Appearance**

The Appearance tab in Display Properties controls the visual style and colors of the desktop and other window elements.

![Display Properties](image)

Two custom schemes and images provide for day or night viewing. When you change schemes, you must also change the image on the background tab.

<table>
<thead>
<tr>
<th>Scheme</th>
<th>Desktop Color</th>
<th>Background Logo</th>
</tr>
</thead>
<tbody>
<tr>
<td>AB Day</td>
<td>Blue</td>
<td>abclocknight</td>
</tr>
<tr>
<td>AB Night</td>
<td>Black</td>
<td>abclockday</td>
</tr>
</tbody>
</table>

**Backlight Intensity**

You can adjust the intensity of the backlight in 10% increments from 0…100%. At 0%, the backlight is minimally visible.

![Display Properties](image)

**Screen Saver**

The screen saver extends the life of the display. When the terminal is idle for a continuous period, the screen saver dims the backlight and displays a moving image. When deactivated, the display brightness returns to its normal level.

![Display Properties](image)
The Screen Saver tab in Display Properties lets you perform these actions:

- Change the idle timeout for the screen saver. The default is 10 minutes.
  When the screen saver activates, the dimmer controls the backlight intensity. You set the brightness of the dimmer in range 0…100%. The default intensity is 10%. At 0%, the backlight is minimally visible.
- Browse the system for another screen saver bitmap. The default screen saver is SSFloat.bmp. Click Add or Remove to change screen saver bitmap. The system recognizes bitmaps in the ‘\Windows folder.
- Disable the screen saver by clearing the ‘Start screen saver after’ checkbox.

**Cursor**

The Advanced tab in Display Properties lets you enable or disable the visible cursor that you see on the display. The cursor is visible by default.

**Screen Rotation**

The Advanced tab in Display Properties lets you rotate the screen on the terminal. The default is 0°.

After you change the screen rotation, you have to calibrate the Touch Screen.

1. Plug in a USB mouse to the terminal.
2. Restart the terminal.
3. Use the mouse to calibrate the Touch Screen.
4. See Calibrate the Touch Screen on page 98 for calibration details.
Chapter 4

Hardware Monitor

The Hardware Monitor provides continuous voltage, and temperature, load information for the terminal.

Processes

The Processes tab in the Hardware Monitor shows all processes that are running on the terminal, and the memory usage of each process.

System Event Log

The System Event Log in the Hardware Monitor shows warnings, errors, events, and information.

The log provides a date and time stamp of each event, and text that describes the event. The maximum size of the log is 1 MB, approximately 4,000 records. If the log exceeds 1 MB, the oldest 512K of information is removed. You can perform these operations on the log file:

- Press Export Log to export the log file to a CSV file (*.csv) in the Windows folder. The default file name is SystemLog.csv.
- To clear all events from the log, press Clear Log.
- To view more details on a selected event, press Details.
Monitors

The Monitors tab in the Hardware Monitor provides continuous voltage, temperature, and load information for the terminal.

Battery Voltage

The Monitors tab gives a visual status and voltage reading of the battery for the real-time clock. The battery voltage updates at powerup, then every hour.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Battery</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depleted</td>
<td>Less than 2.0V indicates a dead battery or no power.</td>
</tr>
<tr>
<td>Low</td>
<td>2.0…2.74V</td>
</tr>
<tr>
<td>Normal</td>
<td>2.75V or higher</td>
</tr>
</tbody>
</table>

An event is logged to the system event log for a low or depleted battery.

Temperatures

The Monitors tab gives a visual status and reading of the current temperature of the logic board. The temperature updates every ten minutes.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Logic Board</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>–</td>
</tr>
<tr>
<td>Normal</td>
<td>25…94 °C (77…201 °F)</td>
</tr>
<tr>
<td>High</td>
<td>95 °C (203 °F) and higher</td>
</tr>
</tbody>
</table>

An event is logged to the system event log for a failed temperature sensor.

**IMPORTANT** A high temperature condition causes an automatic restart attempt. Restart attempts continue indefinitely until the system is cool enough to resume normal operation. High temperature conditions are logged to the system event log.
Use the Logo Manager to change the logo that appears on the splash screen at startup and the default screen saver image. The default splash-screen image is the Allen-Bradley logo (ablogo.bmp).

The logo can be a .bmp, .jpg, .gif, or .png image. A 90 x 90 pixel, 16-bit color image provides a good result.

Before applying the new logo, you can do the following:
- Preview the logo on the splash screen.
- Resize image to fit the fixed area of the splash screen.

To apply a new logo the splash screen and the screen saver, follow these steps.

1. Double-click Logo Manager in the control panel.

The Logo Manager opens with the current logo.

2. Click Load.

3. Select the location of the new image you want to load:
   - A folder on the terminal.
   - Storage Card2 - SD card
   - USB Storage - USB drive

4. Select the image file to load.

5. Verify that the file type is correct.

6. Click OK.
The new logo appears in the Logo Manager dialog box.

7. Check 'Preview entire screen' to view the logo on the splash screen. If the logo is truncated or too small, check 'Stretch/shrink image to fit' to resize the logo to fit the area.

8. If satisfied with the preview, click Apply. A dialog box confirms that the splash screen was updated. The default screen saver, ssfloat.bmp, is updated with the new image.

9. Click OK, then click Exit to close the Logo Manager.
User Accounts

User Accounts let you create NT LAN manager (NTLM) user accounts to authenticate client connections when using the FTP, web, and file servers. A user account consists of a user name and a password.

**TIP**  
NTLM is the security protocol that provides authentication, integrity, and confidentiality to users on Windows operating systems. NTLM is still included to support Windows 2000, 2002, and 2003 server systems.

To add a user account, follow these steps.

1. Double-click User Accounts in the control panel.

2. In the user name field, type a name.

3. To clear the field and type a password, click in the Password field. Asterisks display as you type the password.

4. Reenter the password in the Confirm pwd field.

5. Click Add User.

6. Click OK to acknowledge the new user account.

The new user name is added to the list.
7. Repeat steps 1 through 6 to add additional user accounts.
8. When done, click X to close the dialog box.

To remove a user account, follow these steps.

1. Select a name from the user name list.
2. Click Remove User.
3. To confirm the removal of the selected user account, click Yes.
   The user account list is permanently deleted from the list.
4. To close the User Account Manager, click X.

**TIPU** Users who are entered in authentication lists of FTP, web, or file server configurations are removed when user accounts are deleted.

**Services**

The Services application shows servers the PanelView Plus 7 Performance platform supports. You can enable (start) or disable (stop) each server.

The buttons are color-coded:
- Green indicates that the server is running and automatically started at system startup.
- Red indicates that the server is not running.
- Gray indicates that the server is not available on the platform.

To enable or disable a server, press the corresponding button and the color changes accordingly.
Network Server Configuration

The Network Server Configuration application configures settings for VNC, FTP, web, Kepware, and file server activities on an Ethernet network.

VNC Server Configuration

The terminal provides two VNC client viewers:

- Vncviewer.exe is in the /Windows folder on the terminal desktop. You can deploy this viewer to a personal computer to connect, view, and control a PanelView Plus 7 terminal. See these sections for details:
  - VNC Connection Requiring a Password for View-only Operations on page 139
  - VNC Connection with Separate Passwords for View and Control Operations on page 141

- Another viewer on the terminal lets you establish a VNC connection to another PanelView Plus 7 terminal. To access this viewer, click Start>Programs>VNC Viewer. See these sections for details:
  - Establish a VNC Connection Between a Local Terminal and a Remote Terminal on page 143
  - Close a VNC Connection to a Remote Terminal on page 144
  - Make a New VNC Connection to a Remote Terminal on page 145
  - Transfer Files Between a Local and a Remote Terminal on page 145

The VNC Server tab in the Network Server Configuration dialog box configures settings for a client device to view or control the terminal over a VNC connection.

<table>
<thead>
<tr>
<th>VNC Parameter</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>General View Only</td>
<td>Check this option to let users view terminal displays over a VNC connection. If you uncheck View Only, users can control and view terminal displays over a VNC connection. If security is disabled, users are not required to enter a password when connecting to the terminal.</td>
<td>Enabled for view only</td>
</tr>
</tbody>
</table>
### VNC Connection Requiring a Password for View-only Operations

The default VNC configuration enables view-only access to the terminal without requiring a password. This configuration requires the VNC viewer that you copy from your terminal to a computer.

**TIP** Copy vncviewer.exe, in the /Windows folder on the terminal, to your computer and install the TightVNC software.

To configure a VNC connection that requires a password to view terminal displays, follow these steps.

1. From the control panel, click Server Config.

2. On the VNC Server tab, check these items:
   - View only (no remote control)
   - Enable security
3. Select View-only password, then enter a seven-character password in the field that opens.

4. Click OK

5. Restart the server when prompted to apply new settings.

To launch a VNC connection to view terminal operations, follow these steps.

1. On your computer, choose Start>Programs>TightVNC>TightVNC Viewer.

2. Enter the IP address of your terminal and click Connect.

   **TIP** Click the network connection icon in the system tray to view the IP address of the terminal.

3. Enter the View-only password that is defined on the terminal and click OK.

   The PanelView VNC Server opens the current view of the terminal on your desktop. You can view but not control terminal operations.

4. When finished, close the PanelView VNC Server.
VNC Connection with Separate Passwords for View and Control Operations

You can configure the VNC server to require separate passwords for view-only and control operations. This example uses the VNC viewer that is deployed to a computer to connect to the terminal.

**TIP** Copy vncviewer.exe, in the /Windows folder on the terminal, to your computer and install the TightVNC software.

To configure the VNC server to require a separate password for view-only and control operations, follow these steps.

1. From the control panel, click Server Config.

![Server Config](image)

2. On the VNC Server tab, do the following:
   - Clear View only (no remote control).
   - Check Enable security.

3. Select Password, then enter a password for control privileges.
   
   Passwords are a maximum of seven characters.

![Network Server Configuration](image)

4. Select View-only password, then enter a password for view-only privileges.

5. Click OK, then restart the service when prompted to apply new settings.
To launch a VNC connection to enable control of the terminal, follow these steps.

**TIP** To launch a VNC connection on your computer that requires a password for view-only operations, see VNC Connection Requiring a Password for View-only Operations on page 139 and follow steps 1 through 4.

1. On your computer, choose Start>Programs>TightVNC>TightVNC Viewer.

2. Click Options.

3. Clear View only (inputs ignored).

4. Click OK.
5. Enter the IP address of your terminal and click Connect.

   **TIP** Click the network connection icon in the system tray to view the IP address of the terminal.

   The Standard VNC Authentication dialog box opens.

   ![Standard VNC Authentication dialog box]

6. Enter the control password that is defined on the terminal and click OK.

7. On your computer, perform some actions to verify that you have control of the terminal.

8. When finished, close the PanelView VNC Server.

**Establish a VNC Connection Between a Local Terminal and a Remote Terminal**

To establish a VNC connection from a local terminal to a remote terminal, follow these steps.

1. Access the Windows desktop of the local terminal.

2. On the local terminal (viewer) desktop, choose Start>Programs>VNC Viewer.

   ![New TightVNC Connection]

3. Enter the IP address of the remote terminal that you want to connect to and click Connect.

   **TIP** Select an IP address from the pull-down menu, or enter an IP address by using a USB keyboard or soft input panel (see Soft Input Panels on page 124).

   A Status message displays while the connection is being made. The messages can cycle as the status changes.

   ![TightVNC Connection]

   The message ‘Please wait - initial screen loading’ can also display after the connection has been made and while the desktop of the remote terminal is loading.
After the screen has loaded, the desktop of the remote terminal displays on the local terminal. You can now access the features and functions of the remote terminal.

Close a VNC Connection to a Remote Terminal

To close a VNC connection between a local terminal and a remote terminal, follow these steps.

1. Establish a VNC connection from a local terminal to a remote terminal (see page 143).
2. On the local terminal, right-click PanelView VNC Server.
   
   **TIP** Touch the screen for 1 second or longer for a right-click.

3. Click Close.

   The VNC connection to the remote terminal is closed.

   **TIP** Click PanelView VNC Server to toggle between the remote terminal (server) and local terminal (viewer) views.
**Make a New VNC Connection to a Remote Terminal**

To make a new VNC connection to another terminal, follow these steps.

1. Establish a VNC connection from a local terminal to a remote terminal (see page 143).
2. Click the New connection icon in the menu bar.
3. Enter the IP address of the new remote terminal that you want to connect to and click Connect.

**TIP** Select an IP address from the pull-down menu, or enter an IP address by using a USB keyboard or soft input panel on the local terminal (viewer) (see Soft Input Panels on page 124).

The local terminal creates a VNC connection to the new terminal.

**Transfer Files Between a Local and a Remote Terminal**

You can perform these tasks with the TightVNC File Transfer dialog box:

- Transfer files and folders between connected terminals
- Rename a selected file or folder
- Create a folder
- Delete a selected file or folder

To transfer files between the local terminal and the remote terminal, follow these steps.

1. Establish a VNC connection from a local terminal to a remote terminal (see page 143).
2. Click the Transfer files icon in the menu bar.
3. Select the folder or files that you want to transfer.
4. Click the upload (>>) or download (<<) files icon.
5. Click Yes.
6. Click Refresh to view the change (in needed).

Web Server Configuration

The web server tab in the Network Server Configuration application configures settings that are used for HTTP web activities. These parameters are standard Microsoft Windows CE parameters.

TIP Click OK in the title bar of the dialog box to apply new settings. You are asked if you want to restart the service immediately.
### Table 28 - Web Server Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin Users</td>
<td>Specifies a list of users who are allowed to administer web activities.</td>
<td>ADMIN</td>
</tr>
<tr>
<td></td>
<td>When selected, enter a list of user names, which are separated by semicolons, in the field that opens at the bottom of the dialog box.</td>
<td></td>
</tr>
<tr>
<td>Basic Authentication</td>
<td>Check this option to require a user name and password to access the web server.</td>
<td>Disabled (unchecked)</td>
</tr>
<tr>
<td>Default Web Page</td>
<td>Specifies default web pages that users can access.</td>
<td>default.htm; index.htm</td>
</tr>
<tr>
<td>Allow Directory Browsing</td>
<td>Check this option to let users browse directories on a web server.</td>
<td>Disabled (unchecked)</td>
</tr>
<tr>
<td>Max Connections</td>
<td>Specifies the maximum number of incoming web connections.</td>
<td>256</td>
</tr>
<tr>
<td>Log File Directory</td>
<td>Specifies the path where the log file is stored. This file logs web activity.</td>
<td>windows\www</td>
</tr>
<tr>
<td>Max Log Size</td>
<td>Specifies the maximum size of the log file that is stored in the log file directory. A new log file is created, when the current log file reaches its maximum size.</td>
<td>32768 bytes</td>
</tr>
<tr>
<td>NTLM Authentication</td>
<td>Check this option to require a valid user name and password to access the web server. If NTLM Authentication is enabled, you must enter a valid user name in the Admin Users field. NTLM user accounts are defined in the User Account Manager of the control panel.</td>
<td>Enabled (checked)</td>
</tr>
</tbody>
</table>


FTP Server Configuration

The FTP Server tab in Network Server Configuration defines settings that are used to exchange files over a network. These parameters are standard Microsoft Windows CE parameters.

Table 29 - FTP Server Parameters

<table>
<thead>
<tr>
<th>FTP Parameters</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default Directory</td>
<td>Specifies a storage location on the terminal where users can transfer files. The directory that users come to when they first connect to the FTP server.</td>
<td>\Temp\</td>
</tr>
<tr>
<td>Idle Timeout</td>
<td>Specifies an idle period after which inactive control connections are closed during a data transfer. An FTP session requires one control connection, plus one data connection, during file transfers. Without a timeout, the FTP server process can be left pending indefinitely if the corresponding client crashes without closing the control connection.</td>
<td>300 seconds (5 minutes)</td>
</tr>
<tr>
<td>Debug Output Channels</td>
<td>Specifies the number of debug output channels.</td>
<td>2</td>
</tr>
<tr>
<td>Debug Output Mask</td>
<td>Specifies the port number of the output mask that is used for debugging.</td>
<td>23</td>
</tr>
<tr>
<td>Base Directory</td>
<td>Specifies the path where the FTP log file and other support files are stored.</td>
<td>\Windows</td>
</tr>
<tr>
<td>Log Size</td>
<td>Specifies the maximum size of the file that logs FTP activities. The log file is stored in the base directory. A new log file is created, when the current log file reaches its maximum size.</td>
<td>4096 bytes</td>
</tr>
<tr>
<td><strong>Security Parameters</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use Authentication</td>
<td>Check this option to require a valid NTLM user name and password to access the FTP server. If authentication is enabled, you must enter one or more valid user names in the User List field. NTLM user accounts are defined in the User Account Manager of the control panel.</td>
<td>Enabled (checked)</td>
</tr>
<tr>
<td>Allow Anonymous Logins</td>
<td>Check this option to let anyone connect to the FTP server. Anonymous logins do not require a user name and password.</td>
<td>Enabled (checked)</td>
</tr>
<tr>
<td>Allow Anonymous Uploads</td>
<td>Check this option to let users logged on anonymously to upload (or write) files to the FTP server (or default directory). If unchecked, users that are logged on anonymously cannot upload (or copy) files from the server.</td>
<td>Disabled (unchecked)</td>
</tr>
<tr>
<td>Allow Anonymous VRoots</td>
<td>Check this option to let users logged on anonymously to access virtual roots.</td>
<td>Disabled (unchecked)</td>
</tr>
<tr>
<td>User List</td>
<td>Specifies the NTLM users that can access the FTP server and exchange files to or from the default directory. When selected, you can enter a list of NTLM user names, which are separated by semicolons, in the field that opens at the bottom of the dialog box. User names and passwords are defined in the User Account Manager of the control panel.</td>
<td>None</td>
</tr>
</tbody>
</table>

TIP Click OK in the title bar of the dialog box to apply new settings. You are asked if you want to restart the service immediately.
**FTP Anonymous Login and Upload**

With the default FTP security options, you can log on anonymously to the terminal and copy files between your computer and the default FTP folder on the terminal.

To establish an FTP connection to the terminal by using anonymous logins and file transfers to and from the FTP folder, follow these steps.

1. On your computer, open the web browser or any folder.
2. To determine the IP address of your terminal, click the Network Connection icon in the system tray.
3. Type the terminal IP address in the address field.

A connection is established to the \Temp folder, the default FTP directory on the terminal. The terminal shows two files.

**TIP** If Allow Anonymous Uploads is unchecked, you can copy files from the default FTP folder on the terminal but not to the folder.

If you launch the FTP connection from your web browser, this view can appear.

To see the folder view, choose Open FTP site in Windows Explorer from the Page pull-down menu.

**EXAMPLE** Use this syntax for the IP address: ftp://ipaddress_of_the_terminal. For example, ftp://192.168.124.96
4. Transfer files between your computer and the FTP folder on the terminal:
   - Drag or copy a file from the FTP folder to your computer.
   - Drag or copy a file from the computer to your FTP folder.

**FTP Connection Requiring User Authentication**

You can require a user name and password before establishing an FTP connection. On the FTP Server tab, check Use Authentication. Select User List and enter a valid user name in the field that opens at the bottom of tab.

To establish an FTP connection to the terminal by first entering a valid user name and password, follow these steps.

1. On your computer, open any folder or the browser.
2. Determine the IP address of your terminal by clicking the Network Connection icon in the system tray.
3. Type the terminal IP address in the Windows Explorer address field.
4. Click OK if the FTP Folder Error dialog box appears.
5. From the File menu, choose Login As.

---

**TIP** You can create user names and passwords in the User Accounts application of the control panel. See User Accounts on page 136.

**EXAMPLE** Use this syntax for the IP address:
For example, ftp://192.168.124.96

---

**TIP** The user name must be in the User List of the FTP configuration and previously configured as a valid account in the User Accounts application.
6. Type a valid user name and password.
7. Click Log On.

The default FTP directory on the terminal opens. You can transfer files to or from this folder.

**File Server**

The File Server tab in Network Server Configuration has settings that allow shared access to files, printers, serial ports, and miscellaneous communication between computers on a network. These parameters are standard Microsoft Windows CE parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adapter List</td>
<td>Provides a list of valid adapters.</td>
<td><em>(all adapters)</em></td>
</tr>
<tr>
<td>Max Printer Swap Size</td>
<td>Specifies the maximum size of the printer swap file.</td>
<td>4096 bytes</td>
</tr>
<tr>
<td>Security Options</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use Authentication</td>
<td>Check this option to require a valid NTLM user name and password to access the file server. If authentication is enabled, you must enter one or more valid user names in the User List field. NTLM user accounts are defined in the User Account Manager of the control panel.</td>
<td>Disabled (unchecked)</td>
</tr>
<tr>
<td>User List</td>
<td>Specifies a list of valid NTLM users who are allowed to access the file server. When selected, you can enter a list of NTLM user names, which are separated by semicolons, in the field that opens at the bottom of the dialog box. User names and passwords are defined in the User Account Manager of the control panel.</td>
<td>None</td>
</tr>
</tbody>
</table>
**KEPServer Configuration**

The Kepware Server tab in Network Server Configuration lets you select Kepware communication drivers for connected devices.

**TIP** For a complete list of Kepware drivers, go to [http://www.rockwellautomation.com/knowledgebase](http://www.rockwellautomation.com/knowledgebase) and search the Knowledgebase for keywords ‘Kepware Drivers for PanelView Plus’.

**IMPORTANT** Click OK in the title bar to apply new settings. You are asked if you want to restart the service immediately. **You must also restart the terminal.**

---

**System Information**

The System Information application provides tabs to view and set system-wide properties for your terminal.

**General Information**

The General tab of System Information shows the current version of the Windows CE operating system, the processor type, speed, and available memory.
Chapter 4

Startup Options

The Startup Options tab of System Information lets you set these start-up options:

- Show or hide the battery warning
- Launch the terminal as open or closed
- Configure the Ethernet ports for DLR, star, or linear topology
- Disable or enable Safe mode
- Show or hide system watchdog errors

Battery Warnings

If the battery is low, missing, or depleted, a warning appears each time that the terminal starts up.

**TIP**
- The terminal can operate without a battery if the accuracy of the date and time is not critical.
- When replacing the battery, you can verify the accuracy of the system date and time from the desktop control panel or the terminal settings in FactoryTalk View ME Station.

You have three options for handling the battery.

<table>
<thead>
<tr>
<th>Battery Warning Startup Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always show at startup (continue with startup)</td>
<td>Shows the battery warning at startup with ME Station software running behind it (default)</td>
</tr>
<tr>
<td>Always show at startup (halt startup)</td>
<td>Shows the battery warning at startup but halt boot process until you press OK.</td>
</tr>
<tr>
<td>Never show at startup</td>
<td>Hides the battery warning at startup.</td>
</tr>
</tbody>
</table>

Startup Options

Use the Shell options to launch an open or closed desktop at startup and to set the visual appearance of button controls.
Chapter 4

Boot Option

The boot options provide a way for you to enter Safe mode at startup.

<table>
<thead>
<tr>
<th>Shell Startup Options</th>
<th>Description</th>
</tr>
</thead>
</table>
| Type                   | Launches the terminal as an open or closed system at startup:  
  - (Open system) – launches the Windows CE desktop on startup.  
  - (Closed system) (default) – launches FactoryTalk View ME Station  
    Configuration mode on startup.  
  You can also allow or restrict desktop access within FactoryTalk View ME  
  Station Configuration mode by pressing Terminal Settings>Desktop Access  
  Setup. See Windows CE Desktop Access — Series A Terminals on page 79. |
| User Interface Button Controls | Sets the visual appearance of control buttons at startup:  
  - Windows XP Style (default)  
  - Windows 95 Style |

<table>
<thead>
<tr>
<th>Safe Mode Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not detect Safe mode request at startup</td>
<td>Disables Safe mode detection during startup (default).</td>
</tr>
<tr>
<td>Detect Safe mode request at startup</td>
<td>Displays a small white box in the lower left corner of the terminal display during startup. Press and hold the white box to enter Safe mode. Safe mode lets you bypass a loaded FactoryTalk View ME application and go directly to Configuration mode. If you do not press the white box, the system boots up normally. Another way to enter Safe mode is to access Maintenance mode. See Maintenance Mode Operations — Series A Terminals on page 224.</td>
</tr>
</tbody>
</table>

Configure the Ethernet Ports

The ‘Network (On-board Embedded Ethernet Switch - DLR)’ provides options to configure the on-board Ethernet switch of the terminal for the network topology. You can also configure the Ethernet ports from the terminal menus. See Configure the Ethernet Ports on page 90.

After changing the selections, restart the terminal.

<table>
<thead>
<tr>
<th>Port (Link) Configuration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port 1 (Link 1) and Port 2 (Link 2) Enabled</td>
<td>Enables Link 1 and Link 2 Ethernet connections for DLR configuration.</td>
</tr>
<tr>
<td>Port 1 (Link 1) Only Enabled</td>
<td>Enables Link 1 Ethernet connection for star or linear configuration.</td>
</tr>
<tr>
<td>Port 2 (Link 2) Only Enabled</td>
<td>Enables Link 2 Ethernet connection for star or linear configuration.</td>
</tr>
</tbody>
</table>
Watchdog Errors

You can show or hide watchdog errors at startup.

<table>
<thead>
<tr>
<th>Watchdog Error Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always show watchdog errors at startup</td>
<td>Shows the fatal watchdog error (error 02) at startup and halts the normal boot process (default). The system launches the maintenance window with the watchdog error displayed. You can continue booting from this window. See Maintenance Mode Operations — Series A Terminals on page 224 for details. The error is logged to the System Event log.</td>
</tr>
<tr>
<td>Never show watchdog errors at startup</td>
<td>Hides the errors at startup and adds the error to the system event log.</td>
</tr>
</tbody>
</table>

Advanced Diagnostics

Advanced diagnostics are for technical support use to diagnose and resolve system errors. They are not for use in a normal production environment.

Device Name

The Device Name tab of System Information identifies your terminal to other devices on the network by providing a device name and description.

**TIP** Device names must be unique. Duplicate names conflict and cause network problems.
**Touch Properties**

Touch Properties is accessible on devices with a touch screen. It lets you calibrate the touch screen and set the sensitivity of touch screen taps.

**Calibration**

The Calibration tab lets you recalibrate the touch screen if your device is not responding appropriately to taps. Follow the instructions in the dialog box to recalibrate.

**Double-tap**

The Double-Tap tab lets you set and test the double-tap sensitivity of the touch screen taps.
PDF Reader

The PDF reader provides typical view and search functions. You can run this reader from the Windows desktop or a command prompt.

When viewing a PDF document, you can initiate functions from the menu or toolbar. Bookmarks created in the original PDF appear under bookmarks.

Figure 8 - PDF Reader Workspace

Some viewing functions can be initiated on touch screen terminals by touching or dragging.

Table 31 - Touch Screen Operations

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
<th>Indicator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In or Out</td>
<td>Tap the screen once to zoom in. Tap the screen again to zoom out.</td>
<td>![Zoom Icon]</td>
</tr>
<tr>
<td></td>
<td>If Menu&gt;View&gt;Minimap is chosen, a miniview of the page appears in lower right of workspace. You can tap the gray areas to change view.</td>
<td>![Minimap Icon]</td>
</tr>
<tr>
<td>Navigate pages</td>
<td>Drag your stylus or finger to the right or left to view next and previous pages. An indicator shows the direction you are dragging. A box shows the current page/total page count.</td>
<td>![Navigation Icon]</td>
</tr>
<tr>
<td></td>
<td>Drag up or down the screen to activate the page navigation bar on the right. Move slide bar up or down to navigate pages.</td>
<td>![Navigation Bar Icon]</td>
</tr>
<tr>
<td>Rotate</td>
<td>Drag in a circular, clockwise or counterclockwise direction to rotate the page.</td>
<td>![Rotate Icon]</td>
</tr>
</tbody>
</table>
**Command Prompt Parameters**

To run the PDF reader from the Windows Command Prompt, choose Start>Programs>Command Prompt, and execute the command parameters in Table 32.

**Command Prompt Syntax**

```
Foxitreader "file_path/file-name.pdf" parameter parameter_value
```

- Enclose the file path and file name in double quotes and use forward slashes to separate the file path directories and file name.
- Use spaces to separate the parameter from the file name and optional parameter value.

**Command Prompt Example**

```
Foxitreader "windows/desktop/example.pdf" -p 4
```

This command prompt opens example.pdf in Foxit Reader at page 4.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter Function</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-p</td>
<td>Go to page</td>
<td>Foxitreader &quot;file_path/file.pdf&quot; -p 2</td>
<td>Opens the PDF file to page 2.</td>
</tr>
<tr>
<td>-zw</td>
<td>Fit width</td>
<td>Foxitreader &quot;file_path/file.pdf&quot; -zw</td>
<td>Opens the PDF file and fits the view to the page width.</td>
</tr>
<tr>
<td>-zp</td>
<td>Fit page</td>
<td>Foxitreader &quot;file.pdf&quot; -zp</td>
<td>Opens the PDF file and shows the full page.</td>
</tr>
<tr>
<td>-z</td>
<td>Zoom to</td>
<td>Foxitreader &quot;file.pdf&quot; -z 150</td>
<td>Opens the PDF file and zooms to 150%.</td>
</tr>
<tr>
<td>Multiple parameters</td>
<td>Enter empty spaces between parameters and parameter values</td>
<td>Foxitreader &quot;file_path/file.pdf&quot; -p 2 -zw</td>
<td>Opens the PDF file to page 2 and fits the view to the page width.</td>
</tr>
<tr>
<td>-b</td>
<td>Go to bookmark</td>
<td>Foxitreader &quot;file_path/file.pdf&quot; -b &quot;Bookmark1&quot;</td>
<td>Opens the PDF file to the location specified within Bookmark1.</td>
</tr>
<tr>
<td>-d</td>
<td>Go to named destination</td>
<td>Foxitreader &quot;file_path/file.pdf&quot; -b &quot;Destination1&quot;</td>
<td>Opens the PDF file to the location specified within Destination 1.</td>
</tr>
<tr>
<td>-g</td>
<td>Disable the File&gt;Open command on the Menu and the Open folder button.</td>
<td>Foxitreader &quot;file_path/file.pdf&quot; -g</td>
<td>Opens the PDF file and dims the Menu, File&gt;Open command and the Open button.</td>
</tr>
</tbody>
</table>
Chapter 5

Windows 10 IoT Core Operating System — Series B Terminals

System Features

The PanelView™ Plus 7 Performance Series B(1) terminals run the Windows 10 IoT Core operating system (OS), which provides the following features:

- VNC Server (with SSH encryption(2))
- PDF reader
- Microsoft Office Viewers
- SFTP Server
- Microsoft Edge Web browser
- FactoryTalk ViewPoint
- Internet Printing Protocols (IPP)
- File Explorer

(1) Series C for Stainless Steel terminals.
(2) SSH encryption is not available on the initial release for the following items: VNC Server and Microsoft Office Viewers.
Windows Control Panel

The following sections describe the functionality that is available from the Control Panel. To access the Control Panel, click Exit on the FactoryTalk View ME Station startup screen.

Menu Icons

The main Menu displays icons that allow you to configure various features of your PanelView Plus 7 Performance Series B terminal (Series C for Stainless Steel terminals).

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Menu</td>
<td>When pressed, this button expands the menu bar. Displays the following menus that are available in the Control Panel: System, Network &amp; Wi-Fi, Firmware Updates, Power Options, Touch, Services, Event Log.</td>
</tr>
<tr>
<td></td>
<td>Start</td>
<td>Displays tiles for the following programs: Web Browser, Notifications, File Explorer.</td>
</tr>
</tbody>
</table>
Chapter 5

Table 33 - Menu Icons (Continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Device Info Icon" /></td>
<td>Device Info</td>
<td>Displays the following information about your terminal:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Device Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- IP Address</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- OS Version</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Platform Version</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Bootloader Version</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- DLR Network Switch</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Connected Devices</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The following Network information is displayed:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- IPv4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Status</td>
</tr>
</tbody>
</table>

| ![Web Browser Icon](image) | Web Browser          | Launches the web browser you specified on the Menu Settings screen.        |
| ![Account Management Icon](image) | Account Management | Displays the Account Management page, which allows you to change your password. |
| ![Settings Icon](image) | Settings            | Displays the Menu Settings page, which allows you to set a default page, a web browser home page, and the size, color and scaling of tiles. |
| ![Exit Icon](image)      | Exit                | Closes the Control Panel and launches Machine Edition (ME).                |

**Navigation Icons**

All screens that you access through the Control Panel display a navigation bar at bottom of the screen.

![Navigation Icons](image)

Table 34 - Navigation Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Move Left Icon" /></td>
<td>Moves to the previous screen.</td>
</tr>
<tr>
<td><img src="image" alt="Move Right Icon" /></td>
<td>Moves to the next screen.</td>
</tr>
<tr>
<td><img src="image" alt="Move Up Icon" /></td>
<td>Moves to the top of the current screen.</td>
</tr>
<tr>
<td><img src="image" alt="Move Down Icon" /></td>
<td>Moves to the bottom of the current screen.</td>
</tr>
</tbody>
</table>
Table 34 - Navigation Icons (Continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![icon](image1) | Displays the following information about your terminal:
  - IP Address
  - OS Version
  - Control Panels Version |
| ![icon](image2) | Allows you to toggle between full screen view and partial screen view. |
| ![icon](image3) | Displays a menu with the following options:
  - Set Default Page
  - Quick-Save Log
  - Session Log |

Start Menu

The Start menu displays the applications available on the terminal.

Table 35 - Start Menu Icons

<table>
<thead>
<tr>
<th>Section</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explore</td>
<td><img src="image4" alt="icon" /></td>
<td>Opens a web browser. See Web Browser Menu on page 166</td>
</tr>
<tr>
<td></td>
<td><img src="image5" alt="icon" /></td>
<td>Lists notifications that have occurred since the Control Panel started running (see Figure 9). Exiting out of the Control Panel (by going to ME Station or by resetting the terminal) clears the list. The list is limited to 20 items.</td>
</tr>
</tbody>
</table>
|         | ![icon](image6) | Opens File Explorer, which can be used to view files on the device or copy/move files to and from the terminal to USB storage devices. Each page in File Explorer includes a close button (red button with white X) and an address bar. For more information, see the following illustrations:
  - Figure 10 shows the main File Explorer page.
  - Figure 11 shows the contents of a folder.
  - Figure 12 shows an empty folder. |
The Folders section displays important folders you may need to use. Clicking a folder displays its contents. The following folders are available:

- **ME Apps**—contains your runtime .mer files
- **Temp**—contains any temporary files that are generated as you work in PanelView
- **Documents**—contains document files such as PDFs, text files, etc.
- **Certificates**—contains any certificates you have acquired, for example, ViewPoint if you use HTTPS, or domain authentication if you use SSL

The Drives section displays a removable storage device (USB or SD card) that you plugged in to the terminal.
If you click on a folder, a list of its contents is displayed. Right-clicking a file displays a menu of common operations, such as Copy, Cut, or Rename.

**TIP** You need to have a mouse plugged into the terminal in order to use these commands.

Right-clicking inside a folder displays a menu of operations, such as Move, Sort by, or Refresh, that help you organize your folder. (The Open in Terminal is not functional at this release).

**TIP** You need to have a mouse plugged into the terminal in order to use these commands.
Device Info Menu

The Device Info menu displays name, network, and version information about your PanelView terminal.

Table 36 - Device Info

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Network Information  | If the network cable is not plugged in, there is no information displayed here. If a network cable is plugged in, the following information is shown:  
                             • IPv4—Displays the IPv4 address currently assigned to the terminal.  
                             • Status—Displays the type of access available. Displays Local network access only or Local and Internet access, depending on the internet access availability. |
| Device Name          | Displays the name of the device given by the user. This can be set-up on the out of box first power up or in ME Station - Terminal Settings > Networks and Communications > Network Connections > Device Name. |
| Network              | Displays Ethernet if connected to a network. If no connection is identified, it displays No Internet Connection. |
| IP Address           | Displays the IP address currently assigned to the terminal. If the network cable is not plugged in, the IP Address displays as 0.0.0.0 |
| OS Version           | Displays the Microsoft Windows 10 IoT Core OS version. |
| Platform Version     | Displays the version of bundled firmware from Rockwell Automation. The more… button displays a page that shows versions of additional components. |
| Copyright Info       | Displays the copyright year of the terminal. The more… button displays a complete copyright page. |
| Bootloader Version   | Displays the version of Bootloader that is loaded on the terminal. |
| DLR Network Switch Version | Displays the firmware version of the Device Level Ring Network Switch. |
| Connected Devices    | Displays the device name of any connected USB devices. |
Web Browser Menu

The web browser is a Microsoft Edge browser that supports HTML5. You can view web pages and PDFs by using this browser. The default homepage can be set by going to Settings > Menu Settings > Web Browser > Home page.

**TIP**  Local files cannot be opened with this web browser.
Account Management Menu

The administrator password is used to turn services on/off. The administrator password is also used for the Secure File Transfer Protocol (SFTP) and file server access. This password is different from the password used to exit ME station into the Control Panel (Desktop Access Password).

The initial administrator password is set up as a part of the out of box experience (OOBE). See step 11 on page 55 for this initial setup.

When changing the administrator password, the new password cannot be blank. It must be between 1 and 64 characters. There are no special character requirements; any special characters can be used if desired. We recommend following best practices for passwords to ensure they are as secure as possible.

Table 37 - Account Management Screen

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator—Change Password</td>
<td>Old password</td>
<td>This field is where you type your current password.</td>
</tr>
<tr>
<td></td>
<td>New password</td>
<td>This field is where you type a new password.</td>
</tr>
<tr>
<td></td>
<td>Confirm new password</td>
<td>This field is where you re-type the new password.</td>
</tr>
</tbody>
</table>
Menu Settings Screen

The Menu Settings screen allows you to select which application page and home page you want to use as a default. This screen also allows you to set the size and color of the tiles that are displayed on the terminal.

Use the scroll bar at the right of the screen to view all of the available fields on this screen.

Table 38 - Menu Settings Screen

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Default Page</td>
<td>Allows you to set the application page you want to use as your default page.</td>
</tr>
<tr>
<td>Web Browser</td>
<td>Home Page</td>
<td>Allows you to set the web page you want to use as your default web page.</td>
</tr>
<tr>
<td>Personalization</td>
<td>Tile Width</td>
<td>Allows you to type a number (representing pixels) that defines the width of a tile.</td>
</tr>
<tr>
<td></td>
<td>Tile Height</td>
<td>Allows you to type a number (representing pixels) that defines the height of a tile.</td>
</tr>
<tr>
<td></td>
<td>Scaling Factor</td>
<td>Allows you to type a number (when the Auto Scaling toggle switch is Off) to define how the tiles are scaled.</td>
</tr>
<tr>
<td></td>
<td>Auto Scaling</td>
<td>Allows the application to define (when the toggle switch is On) how the are scaled.</td>
</tr>
</tbody>
</table>
|                  | Tile Color     | Provides the following fields that you can use to determine the color of the tiles on your terminal:  

- Color scale—lets you select the color by sliding a  
  RGB/HSV field—toggles between RGB and HSV values. Select RGB to type numerical values in the Red, Green, and Blue fields. Select HSV to type numerical values in the Hue, Saturation, and Value fields.  
- Hexadecimal field—lets you type in a hexadecimal value to define a color. |
System Screen

The System screen allows you to set the language for your terminal. In addition, you can select the language for your soft keyboard, and the time zone you work in.

![System Screen Screenshot](image)

Table 39 - System Screen

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>Language</td>
<td>Provides a drop-down list that allows you to select the language that is displayed in the Windows Configuration Menu. This has no impact on the language displayed in Machine Edition (ME) Station.</td>
</tr>
<tr>
<td>System</td>
<td>Keyboard layout</td>
<td>Provides a drop-down list that allows you to select the language used for the soft keyboard on your terminal.</td>
</tr>
<tr>
<td>Maintenance Menu</td>
<td>Go to Maintenance</td>
<td>Contains the Go to Maintenance Menu button, which allows you to return to the Maintenance Menu.</td>
</tr>
</tbody>
</table>
Network & Wi-Fi Screen

The Network & Wi-Fi screen displays information about the direct and wi-fi connections of your terminal.

Table 40 - Network & Wi-Fi Screen

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>—</td>
<td>View network properties</td>
<td>Displays the network properties of your terminal, as shown in the following screen capture.</td>
</tr>
<tr>
<td>Direct Connections</td>
<td>—</td>
<td>Displays the connection type of the terminal.</td>
</tr>
<tr>
<td>Wi-Fi</td>
<td>—</td>
<td>Displays information about the Wi-Fi connection available for your terminal. Includes a Refresh button that allows you to refresh the Wi-Fi information.</td>
</tr>
</tbody>
</table>
Firmware Updates Screen

The App Updates screen allows you to obtain updates for the operating system, as well as for applications that you use on the terminal.

Table 41 - Firmware Updates Screen

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PanelView Plus</td>
<td>Firmware Updates —</td>
<td>Contains the Switch to Firmware Update mode button, which allows you to use Control Flash to obtain the latest version of the FactoryTalk View ME Station software.</td>
</tr>
</tbody>
</table>

When you press Switch to Firmware Update mode, a system warning box appears. Click yes to continue into the firmware update mode. The firmware update mode is then displayed, as shown in the following graphic.
Chapter 5

The System Firmware section includes information about the operating system and ME station. This can be updated via ControlFlash or a USB storage device. When updating via ControlFlash, a .dmk file is used. When updating via a USB Storage Device, .CAB files are used.

The Update from USB Storage button is visible only when a USB storage device is plugged in.

For instructions on how to update the firmware, Update the System Firmware on page 57.

The DLR Network Switch Firmware section is new for Series B terminals (Series C for Stainless Steel terminals). This firmware is for the DLR functionality of the terminal.

Power Options Screen

The Power Options screen allows you to choose whether to restart or shut down your terminal.

Table 42 - Power Options Screen

<table>
<thead>
<tr>
<th>Section</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>Restart</td>
<td>Restarts the terminal into ME Station or loads the ME application (if configured to do so).</td>
</tr>
<tr>
<td>-</td>
<td>Shut down</td>
<td>Shuts down the terminal.</td>
</tr>
</tbody>
</table>
Chapter 5

Touch Screen

The Touch screen allows you to recalibrate the touch screen of your terminal if your device does not respond appropriately to taps.

Table 43 - Touch Screen

<table>
<thead>
<tr>
<th>Section</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibration</td>
<td>Go to Calibration Menu</td>
<td>Reboots the terminal and then launches the Calibration menu, which allows you to re-calibrate the sensitivity of the touch screen.</td>
</tr>
</tbody>
</table>
Services Screen

The Services Screen allows you to specify whether or not you want to access various file servers.

**IMPORTANT** The default setting for all toggle switches on this screen is Off. To turn a service On, slide the toggle switch to the right. To turn a service Off, slide the toggle switch to the left.

If you turn any setting on or off, you must enter the administrator password.

<table>
<thead>
<tr>
<th>Section</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>—</td>
<td>ViewPoint Server (HTTP/HTTPS)</td>
<td>Set this switch On to enable the FactoryTalk ViewPoint server. Set this switch Off to disable the FactoryTalk ViewPoint server. This functionality is not available in the initial release.</td>
</tr>
<tr>
<td>—</td>
<td>File Server (SMB)</td>
<td>Set this switch On to enable file sharing. Set this switch Off to disable file sharing.</td>
</tr>
<tr>
<td>—</td>
<td>Internet Printing Protocol (IPP)</td>
<td>Set this switch On to enable printing (if this switch is not set to On, the printer is not recognized in the list of available printers within ME Station). Set this switch Off to disable printing.</td>
</tr>
</tbody>
</table>
Event Log Screen

The Event Log screen lets you select which event logs to generate for your terminal.

Table 45 - Event Log Screen

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
|         |       | Displays a drop-down list that allows you to select an event log to display. The following choices are available.  
• Application—displays events related to software installed on the Windows 10 IoT Core.  
• Parameters—displays the Parameter log.  
• System—displays events related to the Windows 10 IoT Core system.  
• WinCEApplication—displays events related to software installed in the Windows CE App Container.  
• WinCESystem—displays events related to the Windows CE App Container system. |
Chapter 6

Install and Replace Components

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect to USB Ports</td>
<td>178</td>
</tr>
<tr>
<td>Install a USB Printer</td>
<td>179</td>
</tr>
<tr>
<td>Insert an SD Card</td>
<td>183</td>
</tr>
<tr>
<td>Connect a Speaker</td>
<td>184</td>
</tr>
<tr>
<td>Replace the Battery</td>
<td>185</td>
</tr>
<tr>
<td>Install a Protective Overlay</td>
<td>187</td>
</tr>
<tr>
<td>Replace the Stainless Steel Terminal Gasket</td>
<td>189</td>
</tr>
<tr>
<td>Install and Replace Components in the ArmorView Plus 7</td>
<td>See the ArmorView Plus 7 Installation Instructions, publication 2711P-IN013.</td>
</tr>
</tbody>
</table>

ATTENTION: Prevent Electrostatic Discharge (ESD)

This equipment is sensitive to electrostatic discharge, which can cause internal damage and affect normal operation.

Follow these guidelines when you handle this equipment:

• Touch a grounded object to discharge potential static.
• Wear an approved grounding wrist strap.
• Do not touch connectors or pins on component boards.
• Use a static-safe workstation, if available.

ATTENTION: Disconnect all power before installing or replacing any components. Failure to remove power can result in electrical shock or damage to the terminal.

At the end of its life, this equipment should be collected separately from any unsorted municipal waste.

TIP For a complete list of supported devices, go to https://rockwellautomation.custhelp.com and search the Knowledgebase for keywords ‘PanelView Plus Hardware Compatibility List’. 
Connect to USB Ports

The PanelView Plus 7 Performance Series A terminals have two USB 2.0 (type A) host ports. The Series B terminals (Series C for Stainless Steel terminals) have one USB 2.0 port and one USB 3.0 host port. The USB host ports support removable USB drives and a USB printer.

**IMPORTANT** See [Required Circuit Port Parameters for USB Peripheral Devices on page 28](#) for information on how to use the USB host ports and USB peripheral devices in hazardous locations.

**IMPORTANT** The USB host connections are intended for temporary use. Do not use the USB host connections for runtime operations.

Table 46 - USB Connector Pinout

<table>
<thead>
<tr>
<th>USB Port</th>
<th>USB Icon</th>
<th>USB Connector</th>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td><img src="image" alt="USB Icon" /></td>
<td><img src="image" alt="USB Connector" /></td>
<td>1</td>
<td>VCC</td>
<td>+5V</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2</td>
<td>D-</td>
<td>Data -</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3</td>
<td>D+</td>
<td>Data +</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4</td>
<td>GND</td>
<td>Ground</td>
</tr>
</tbody>
</table>

**WARNING:** USB devices that are not powered by the USB port must be within the same enclosure as the terminal. The USB devices must be connected to a ground system common with the terminal or used with a USB hub that provides galvanic isolation.
Connect only externally powered USB hubs to the terminal that are USB 2.0 compatible. Before you attach devices to a USB hub, make sure that the power adapter is connected and powered on.

**USB Cables**

Use only hi-speed, USB 2.0 or higher certified cables for error-free transmissions.

**Install a USB Printer**

**Series A Terminals**

PanelView Plus 7 Performance Series A terminals support the connection of one USB printer such as Canon, Epson, Hewlett-Packard, and Brother. The printers support plug-and-play installation and manual installation if a suitable driver is available. You can connect a printer to a USB port on the terminal.

**Note:** Series B terminals (Series C for Stainless Steel terminals) do not support USB printers. They support only network printing via IPP.

Printers are configured and managed from the Printers application in the desktop control panel. A wizard is supported for each printer type.

<table>
<thead>
<tr>
<th>Table 47 - Support for Printers</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Printer Type</strong></td>
</tr>
<tr>
<td>Local USB</td>
</tr>
<tr>
<td>Network</td>
</tr>
<tr>
<td>RDP/ICA</td>
</tr>
</tbody>
</table>

After configuring a printer, you can access it from desktop applications or from FactoryTalk® View Machine Edition Station. Press Terminal Settings, then choose Print Setup. Applications can also select and share printers.
Plug-and-Play Installation

To install a plug-and-play printer from the Windows desktop, follow these steps. For manual printer installation, see Manual Printer Installation on page 181.

**TIP** This procedure shows a plug-and-play installation for the Hewlett Packard HP Deskjet 5650 printer.

1. Connect the printer to a USB host port on the terminal.
2. Plug the power cord of the printer into an outlet and turn on the printer.
   Windows automatically detects your plug-and-play printer, and in most cases, without requiring you to make any selections.
   The printer is ready to print.
3. Verify printer installation from the desktop control panel by opening the Printers application.
   Notice the icon for the Deskjet 5650C printer. The check mark indicates that this printer is the default.
4. From the File menu, choose Properties to view the properties of the printer.
   ![](Image)
   Printer properties include the printer name, manufacturer and model, print driver, and port-specific parameters.

**IMPORTANT** If automatic plug-and-play installation is not supported for a printer, this error is logged to the System Event log in the Hardware Monitor.

For example, JETCET PRINT was unable to auto-configure printer. To manually configure printer, go to the Printers folder from the Control Panel.
Chapter 6

5. To verify installation, right-click the printer and print a test page.

When printing from an application such as WordPad, a Print dialog box opens where you can adjust settings.

![Print dialog box](image)

**Manual Printer Installation**

To configure a supported printer, follow these steps.

1. Connect the printer to a USB port of the terminal.
2. Plug the power cord of the printer into an outlet and turn on the printer.
3. From the desktop control panel, open Printers.
4. Click Add Local Printer.

![Printers dialog box](image)

5. To configure the printer, follow the Add Local Printer Wizard instructions:
   a. Verify that the connected printer appears on the USB printer port.
   b. Select the manufacture and model of the JETCET printer.
   c. Accept the default printer name or enter another.
   d. To verify the installed printer, print a test page.
   e. Specify whether you want the printer to be shared on the network.

**TIP**
- New printer configurations are retained through a power cycle.
- Printers that are configured through the desktop control panel are also available within FactoryTalk View ME Station when pressing Terminal Settings>Print Setup.
Series B Terminals\(^{(1)}\)

To enable printing on Series B terminals (Series C for Stainless Steel terminals), the Internet Printing Protocol (IPP) service needs to be turned on. By default, this service is turned off.

To enable the Internet Printing Protocol (IPP) Service:

1. Navigate to the Windows Control Panel.
2. Select the Settings Menu (Gear Icon).
4. Under Internet Printing Protocol (IPP), move the slider to the right to turn the service on.
5. Enter the Administrator password when prompted.
6. Verify that the slider is on the right in the on position.

For instructions on how to set up the printing in the Machine Edition environment on the terminal, see Configure Print Options on page 102.

\(^{(1)}\) Series C for Stainless Steel terminals.
Insert an SD Card

An SD card provides extra storage when inserted into the SD card slot of the terminal. Supported cards include catalog numbers 1784-SD1, 1784-SD2, 1784-SDHC8, and 1784-SDHC32. The SD cards are hot-swappable; they can be inserted and removed while the terminal is powered on and running.

**WARNING:** Explosion Hazard

If you remove or insert an SD card while the power is on, an electric arc can occur. This arc can cause an explosion in hazardous location installations. Do not remove and insert the SD card unless power has been removed or the area is known to be nonhazardous.

The SD card slot is accessible from the inside of the panel on the back of the terminal when installed.

To install an SD card in the card slot, follow these steps.

1. Verify that the SD card is locked or unlocked according to your preference.
   - If unlocked, the terminal can write data to or read data from the card.
   - If locked, the terminal can only read data from the card.

2. Insert the SD card firmly into the slot until you hear a click.

   When you hear the click, the card has locked into place.

   To remove the card, push the SD card in slightly and remove then it from the slot.

---

**ATTENTION:** Orient the SD card correctly before you insert the card into the slot. If you force the card into the slot, you can damage the card or the terminal.

The aluminum terminal is shown. The SD card location is the same on the stainless steel terminal.
Connect a Speaker

You can connect a speaker or audio amplifier to the terminal to announce alarms, provide feedback of operator actions, and provide sound during video playback.

TIP

On Series A terminals, the speaker works in the Windows CE operating system (Windows Media Player). On Series B terminals (Series C for Stainless Steel terminals), the speaker works in the Windows 10 operating system (Microsoft Edge Browser). FactoryTalk View ME Station software does not support the speaker.

Note: Series B terminals (Series C for Stainless Steel terminals) support audio through the audio out port and USB audio.

Selecting a Speaker for a Class D Amplifier

<table>
<thead>
<tr>
<th>Speaker Impedance Ω</th>
<th>Test Frequency (KHz)</th>
<th>THD + N (%)</th>
<th>Output Power (W)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Series A</td>
<td>Series B (1)</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>1</td>
<td>2.2</td>
</tr>
<tr>
<td>4</td>
<td>10</td>
<td>2.7</td>
<td>2.5</td>
</tr>
<tr>
<td>8</td>
<td>1</td>
<td>1</td>
<td>1.3</td>
</tr>
<tr>
<td>8</td>
<td>10</td>
<td>1.6</td>
<td>1.8</td>
</tr>
</tbody>
</table>

(1) Series C for Stainless Steel terminals.

ATTENTION: The audio port is nonisolated. Follow these guidelines:
- A connected speaker must be within the same enclosure as the terminal.
- Amplified speakers must be connected to a ground system common with the terminal.
- The audio is provided as a terminal block connection for use in hazardous locations. Connect and tighten wires securely.

The audio port is a class D amplifier output. It has a two-pin terminal block for connecting a 4 ohm or 8 ohm speaker. The audio port can also drive externally amplified speakers.
Chapter 6

Use a 0.4 x 2.5 mm screwdriver for terminal block wiring. The wire length must not exceed 1 m (39 in.).

To connect a speaker to the audio port, follow these steps.

1. Use wire strippers and remove about 5 mm (0.2 in.) of insulation from the ends of the wire.
2. Attach one of the newly exposed wires to the positive (+) terminal and the other to the negative (–) terminal on the operator device.
3. Connect the opposite exposed ends of the wire to the positive (+) and negative (–) terminals on the speaker or amplified speakers.

Replace the Battery

The product has a lithium battery that provides back-up power for the real-time clock and static RAM. The battery can be replaced while the product is mounted in the panel. You need a #1 Phillips screwdriver (#1 Phillips bit) to remove the logic module and access the battery.

Table 48 - Audio Port Wiring

<table>
<thead>
<tr>
<th>Wire Type</th>
<th>Wire Size</th>
<th>Strip Length</th>
<th>Torque Min…Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stranded or solid</td>
<td>0.05…1.3 mm²</td>
<td>5 mm (0.2 in.)</td>
<td>0.22…0.25 N-m</td>
</tr>
<tr>
<td>Cu 90 °C (194 °F)</td>
<td>30…16 AWG</td>
<td></td>
<td>(1.95…2.2 lb-in)</td>
</tr>
</tbody>
</table>

Use a 0.4 x 2.5 mm screwdriver for terminal block wiring. The wire length must not exceed 1 m (39 in.).

To connect a speaker to the audio port, follow these steps.

1. Use wire strippers and remove about 5 mm (0.2 in.) of insulation from the ends of the wire.
2. Attach one of the newly exposed wires to the positive (+) terminal and the other to the negative (–) terminal on the operator device.
3. Connect the opposite exposed ends of the wire to the positive (+) and negative (–) terminals on the speaker or amplified speakers.

Replace the Battery

The product has a lithium battery that provides back-up power for the real-time clock and static RAM. The battery can be replaced while the product is mounted in the panel. You need a #1 Phillips screwdriver (#1 Phillips bit) to remove the logic module and access the battery.

This product contains a sealed lithium battery that may need to be replaced during the life of the product.

At the end of its life, the battery contained in this product should be collected separately from any unsorted municipal waste.

The collection and recycling of batteries helps to protect the environment and contributes to the conservation of natural resources as valuable materials are recovered.
ATTENTION: There is a danger of explosion if the lithium battery or real-time clock module in this product is incorrectly replaced. Do not replace the battery or real-time clock module unless power has been removed and the area is known to be nonhazardous.

Replace the battery only with catalog number 2711P-RY2032 or an equivalent CR2032 coin-cell battery.

Do not dispose of the lithium battery or real-time clock module in a fire or incinerator. Dispose of used batteries in accordance with local regulations.

For safety information on the handling of lithium batteries, including handling and disposal of leaking batteries, see Guidelines for Handling Lithium Batteries, publication AG 5-4.

Perchlorate material – special handling may apply. See www.dtsc.ca.gov/hazardouswaste/perchlorate.

This perchlorate warning only applies to primary Lithium Manganese Dioxide (LiMnO₂) cells or batteries, and products containing these cells or batteries, sold or distributed in California, USA.

To replace the battery, follow these steps.

1. Remove power from the terminal.
2. Loosen the screws that secure the logic module to the back of the display.
3. Carefully lift the logic module away from the display module and turn over to expose the circuit board.
4. Locate the coin-cell battery on the circuit board.

5. To remove the battery, lift the side of the battery.

6. Insert the new battery with the positive (+) polarity up.

7. Reattach the logic module by aligning the connector on the bottom of the logic module with the connector on the back of the display module.

8. Push down on the logic module and make sure it is fully seated.

9. Tighten the screws to a torque of 0.68...0.90 N•m (6...8 lb•in).

Install a Protective Overlay

**IMPORTANT**

Do not use protective overlays with the stainless steel terminals. The protective overlays are not compatible in hygienic applications.

The 12-inch overlay may be used on an ArmorView Plus 7 terminal, but it will only fit the touchscreen portion of the product.

The overlay helps to protect the touch screen and keys from scratches, dust, fingerprints, and external damage from chemicals or abrasive materials. See *Table 6 on page 23* for a list of available overlays.
The protective overlay covers the entire surface of the terminal bezel inside the aluminum perimeter. The overlay has a protective liner that is removed by pulling back on a tab. Do not remove the liner until you are ready to install the overlay.

Before installing the overlay, use a lint-free cloth and a mild glass cleaner or denatured cleaning ethanol (95%) to clean the touch screen surface, and keys, if present. Remove all fingerprints, grease, or dust. Marks that are not removed are trapped underneath the overlay. Grease also affects the adhesion of the overlay.

To apply the protective overlay, follow these steps.

1. Pull the tab from one of the short sides and partially peel the liner away from the adhesive layer.

**IMPORTANT** Follow these guidelines when installing the overlay:

- Make sure that your hands are clean and dry.
- Handle the overlay by its edges to prevent fingerprints or lint. If you do get marks or lint on the overlay, remove them before proceeding.
- Do not touch the adhesive ring.
- Do not use Isopropyl Alcohol, chemicals that contain silicone, or soap to clean the surface of the terminal. Doing so may cause the overlay to not adhere properly to the terminal surface.
- Denatured cleaning ethanol (95%) or a mild glass cleaner is recommended to clean the terminal surface before applying the protective overlay.
Hold the peeled back portion of the protective liner out of the way as you perform the next step.

2. Center the overlay over the bezel and carefully position the adhesive surface on the terminal.
   While the protective liner is still covering the rest of the overlay, verify that it is properly centered.
3. Slowly peel off the rest of the liner while using a soft cloth to press the overlay on the screen.
   Make sure that the overlay lies flat with no bubbles or warps.
4. With a soft cloth or finger, press around the edges of the overlay to seal it, and remove any air bubbles trapped in the adhesive.

**Clean the Overlay**

Use a clean, lint-free cloth, and a mild glass cleaner that leaves no streaks to clean the overlay. Windex or an eye glass cleaner is recommended. Do not use cleaners that contain abrasives.

**Remove the Overlay**

Remove the overlay if it is damaged or needs replacement. Lift a corner and slowly pull off the overlay. Use isopropyl alcohol to remove any residual adhesive. Do not reuse the overlay.

**Replace the Stainless Steel Terminal Gasket**

The hygienic gasket for the stainless steel terminal is blue.

To replace the stainless steel terminal gasket, follow these steps.

1. Remove power from the terminal.
2. Label all wiring and connections so you can attach them correctly later.
3. Remove all wiring and connections.
4. Remove the mounting clips and backing plate.
   Hold the terminal so it does not fall out of the panel.

5. Remove the terminal from the panel.

6. Place the terminal screen-down on a clean, flat surface.
   Be careful not to scratch or damage the terminal screen.

7. Remove the old gasket from the bezel.

8. Clean any dirt or residue from the bezel.

9. Position the new gasket on the bezel, with the gasket alignment plugs facing the bezel alignment features.
   This gasket forms a compression seal. Do not use sealing compounds.

   **IMPORTANT** Slip the inside corners of the gasket under the corners of the bezel shroud.

10. Press each gasket alignment plug into the bezel alignment feature.
    The alignment plugs hold the gasket to the bezel.
11. Place the terminal in the panel cutout.
   Hold the terminal so it does not fall out of the panel.

12. Position the backing plate over the terminal.

13. Slide the ends of the mounting clips into the slots on the terminal.

14. Tighten the mounting clip screws by hand until the backing plate contacts the panel uniformly.

15. Torque the mounting clip screws to 2.3...2.6 Nm (20...23 lb-in) by using the specified sequence.
   The clips will loosen as the adjacent clip is tightened.
16. Repeat step 15 until all the mounting clips are at the specified torque.

ATTENTION: Tighten the mounting clips to the specified torque to provide a proper seal and to prevent damage to the product. Rockwell Automation assumes no responsibility for water or chemical damage to the product or other equipment within the enclosure because of improper installation.

17. Reattach all wiring and connections.
Chapter 7

Update Firmware

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal Firmware</td>
<td>193</td>
</tr>
<tr>
<td>Download Firmware Files (Series A Terminals Only)</td>
<td>194</td>
</tr>
<tr>
<td>Firmware Upgrade Wizard (Series A Terminals Only)</td>
<td>195</td>
</tr>
<tr>
<td>Upgrade Terminal Firmware from a Storage Device (Series A Terminals Only)</td>
<td>195</td>
</tr>
<tr>
<td>Update Terminal Firmware Over the Network (Series A Terminals Only)</td>
<td>199</td>
</tr>
<tr>
<td>Update System Firmware (Series B Terminals Only)</td>
<td>203</td>
</tr>
<tr>
<td>Update DLR Network Switch Firmware (Series B Terminals Only)</td>
<td>213</td>
</tr>
</tbody>
</table>

Terminal Firmware

Firmware components are packaged as execute-in-place (XIP) regions in a System Code (SC) .img file. When the SC .img file is copied to the Virtual File System (VFS) on the terminal, the terminal XIP regions are updated and the terminal restarts automatically. These firmware components are affected during an update:

- FactoryTalk® View Machine Edition Station software
- Communication protocols and drivers including Kepware drivers
- Windows fonts
- Windows CE components
- FactoryTalk components
- User extensions

**Note:** The description of XIP and VFS is only applicable to PanelView Plus 7 Performance Series A terminals.

A firmware update does not affect these terminal components or settings:

- Windows registry
- File system including the FactoryTalk View Machine Edition application that is loaded\(^{(1)}\) in the terminal
- Network parameters including the network device name, DHCP-enabled and static\(^{(2)}\) IP addressing, speed, and duplex setting
- Display settings and screen saver configuration
- Touch screen calibration

\(^{(1)}\) In some cases, the FactoryTalk View ME application can be missing after a firmware update.
\(^{(2)}\) In some cases, static IP addresses have been changed to DHCP-enabled IP address after a firmware update.
Download Firmware Files (Series A Terminals Only)

Note: The following description applies to PanelView Plus 7 Performance Series A terminals only. Series B terminals (Series C for Stainless Steel terminals) use ControlFlash to update firmware (files downloaded from the web are in .dmk format).

Download the appropriate firmware installation package from the Rockwell Automation website. The package is named:

\[ \text{PVP7}_{<\text{terminal family}>}_{x.xx-yyyymmdd}.exe, \]

where:
- \(<\text{terminal family}>\) is the terminal name
- \(x.xx\) is the FactoryTalk View ME software version that is contained in the package
- \(yyyymmdd\) is the date that the package was created

This installation package contains the following:
- Firmware Update Package (FUP) contains an autorun executable and the new firmware files.
- Firmware Upgrade Wizard (FUW), version 6.10 or later, is used to update the terminal firmware by using the contents of the FUP.

To download firmware installation files to your computer, follow these steps.

1. Click [http://ab.rockwellautomation.com](http://ab.rockwellautomation.com) and choose Compatibility and Downloads. (See Product Firmware and Release Notes on page 10.)
2. Click the Get Downloads tab.
3. Click Find Product Downloads.
4. From the All Families pull-down menu, choose PanelView™ Plus 7 Performance terminal.
5. Select a firmware revision, then click Find Downloads.
6. Download the update file (.exe) to a temporary folder on the same drive as FactoryTalk View Machine Edition (ME) software.
7. Run the update file (.exe) installation procedure:
   - The FUW is installed in the FactoryTalk View ME folder.
   - The firmware update package file (.fup) is installed into the folder that is specified during the installation procedure.

**Tip** The FUP name is ME_PVP7\(xX\)_6=8.xx-yyyymmdd

- \(yyyymmdd\) is the date the firmware package was created
- \(8.xx\) is the version of ME contained in this package

You are now ready to run the FUW to update the terminal firmware from a USB drive or SD card or by using a network connection.
Chapter 7

Firmware Upgrade Wizard (Series A Terminals Only)

Note: The following description applies to PanelView Plus 7 Performance Series A terminals only. Series B (Series C for Stainless Steel terminals) terminals use ControlFlash to update the firmware.

The Firmware Upgrade Wizard (FUW) is used to update the terminal firmware. Two methods are provided to update the firmware:

- Create a firmware update card with the contents of the FUP file that you can then load in the terminal to update the firmware. The firmware update card can be a USB drive or an SD card, catalog number 1784-SDx.
- Update firmware in a terminal that is connected to a computer over a direct network connection. The network connection requires a computer running RSLinx Enterprise software, version 5.0 or later. In the FactoryTalk Linx software, you select the terminal that you want to update.

You can run the FUW from within FactoryTalk View Studio software or from the Programs menu on your computer:

- In FactoryTalk View Studio software, from the Tools menu, choose Firmware Upgrade Wizard.
- Choose Start>Programs>Rockwell Software>FactoryTalk View>Tools>ME Firmware Upgrade Wizard.

Upgrade Terminal Firmware from a Storage Device (Series A Terminals Only)

There are two steps to upgrade firmware from a storage device.

1. Create a firmware update card with the required firmware files.
2. To update the firmware, load the card in the target terminal.

The firmware update card can be a USB drive or an SD card.

Create a Firmware Update Card

Note: The following procedure is only available for PanelView Plus 7 Performance Series A terminals.

To copy firmware files to a USB drive or SD card, follow these steps.

1. Insert either a USB drive or an SD card into the appropriate slot on your computer.
2. Run the Firmware Upgrade Wizard:
   - In FactoryTalk View Studio software, from the Tools menu, choose Firmware Upgrade Wizard.
   - Choose Start>Programs>Rockwell Software>FactoryTalk View>Tools>ME Firmware Upgrade Wizard.
3. Follow these steps from the initial Firmware Upgrade Wizard dialog box.
   a. Click Create firmware update card.

   ![Firmware Upgrade Wizard](image)

   b. Select the location of the firmware card by browsing to the root directory of the storage card that is loaded in your computer, for example, E:\.

   The firmware files are copied to this location. You can also specify a folder on the hard disk.
   c. From the Existing terminal type pull-down menu, select a PanelView Plus 7 terminal.
   d. Click Next.

4. Follow these steps from this dialog box.
   a. Browse to the location of the firmware source files on your computer, where the FUP was installed.

   ![Firmware Upgrade Wizard](image)

   b. Choose the firmware revision for the update.
   c. Click Next.

   It can take several seconds for the next dialog box to appear while the FUP is being retrieved.
5. From this dialog box, optionally select the KEPServer drivers that you want included with the firmware, then click Next.

Kepware drivers are already installed on the PanelView Plus 7 Performance terminals.

The final dialog box summarizes your choices for creating the firmware update card.

6. Click Finish to copy the firmware files to the firmware update card.

A progress bar automatically updates as files are copied to the USB drive or SD card.

7. Click OK when the firmware update completes successfully.

8. Remove the USB drive or SD card from your computer.

9. Go ahead to the next section to use this firmware update card to update the terminal firmware.
Update Terminal Firmware by Using Firmware Update Card

The following procedure is only available for PanelView Plus 7 Performance Series A terminals.

---

**IMPORTANT** For information on how to use a USB drive or SD card with the ArmorView Plus 7 terminal, see the ArmorView Plus 7 Installation Instructions, publication 2711P-IN013.

---

To transfer firmware files from the USB drive or SD card to the terminal, follow these steps. Use the firmware update drive or card that you created in the previous section.

**IMPORTANT**
- Do not remove or accidentally disconnect the USB drive or SD card while a firmware update is in process. This action can corrupt the firmware and make the terminal unstable.
- Do not power off the terminal during a firmware update.
- USB hubs can produce unexpected behavior and are not recommended.

1. Insert the USB drive or SD card into the appropriate slot on your terminal.

   The firmware update automatically starts and displays this dialog box.

   ![Firmware Upgrade Card](image)

   Firmware version (Major Minor Patch Build)
   Terminal: 07.00.00 07.00.00
   Upgrade Card: 07.10.00

   The terminal is about to be upgraded with new firmware. FactoryTalk View ME Station and any running applications will be terminated. After updating files, the terminal will be restarted to complete the upgrade.

   Press the Upgrade button to continue. Otherwise, press the Exit button and remove the firmware upgrade card.

2. To start the firmware update, press update or [F7] on the terminal.

   The terminal restarts and displays a progress bar during the update.

   When the update is complete, the terminal restarts, and executes the new firmware.

3. Remove the USB drive or SD card from the terminal.

**IMPORTANT** If the firmware update fails because of a power loss or the firmware update card is inadvertently removed, you can restore the terminal to the factory default firmware. See Maintenance Mode Operations — Series A Terminals on page 224 for details on how to restore the factory default settings.
Update Terminal Firmware Over the Network (Series A Terminals Only)

**Note:** The following procedure is only available for PanelView Plus 7 Performance Series A terminals.

You can update firmware in a terminal that is connected to a computer over a direct network connection. The network connection requires a computer with the Firmware Upgrade Wizard (FUW) and FactoryTalk Linx software, version 5.0 or later.

FactoryTalk Linx software is required so that you can select the terminal on the network.

To copy firmware files to the terminal over a network by using FactoryTalk Linx software and Ethernet communication, follow these steps.

1. Run the Firmware Upgrade Wizard:
   - In FactoryTalk View Studio software, from the Tools menu, choose Firmware Upgrade Wizard.
   - Choose Start>Programs>Rockwell Software>FactoryTalk View>Tools>ME Firmware Upgrade Wizard.

2. Click update firmware on terminal and click Next.

3. Click Yes to continue.

It is not necessary to back up files on PanelView Plus 7 Performance terminals.
4. Click ‘Network connection (using FactoryTalk Linx)’ and click Next.

This connection is the only valid selection for PanelView Plus 7 Performance terminals.

5. Select the terminal for the firmware update.

6. Click Next.
7. Follow these steps from this dialog box.

    a. Browse to the location of the firmware source files on your computer, where the FUP was installed.
       The default location is shown.

    b. Choose the version of the update firmware from the pull-down menu.

    c. Click Next.
       It can take several seconds for the next dialog box to appear while the FUP is being retrieved.

8. From this dialog box, optionally select the KEPServer drivers that you want included in the firmware, then click Next.

    Kepware drivers are already installed on the PanelView Plus 7 Performance terminals.
The final dialog box summarizes your choices for upgrading the terminal firmware.

9. Click Finish to update the firmware in the terminal.
10. Click Yes to continue with the update.

A progress bar updates as firmware files are copied to the terminal.

11. Click OK when the firmware update is complete.

The terminal restarts and executes the new firmware.

**IMPORTANT** If the firmware update fails because of a power loss or the firmware update card is inadvertently removed, you can restore the terminal to the factory default firmware. See *Maintenance Mode Operations — Series A Terminals* on page 224 for details on how to restore the factory default settings.
Update System Firmware
(Series B Terminals Only)(1)

You can update the firmware on your terminal by using one of the following methods:

- USB storage device
- ControlFLASH™ client, which is available in the following formats:
  - ControlFLASH Plus™
  - ControlFLASH

**USB Storage Device**

1. Access the Rockwell Automation Product Compatibility and Download Center (PCDC) at rok.auto/pcdc.
2. On the home page, click Available Versions.
3. Click the Select a Product link, and in the Select a Product dialog box, type PanelView Plus 7 Performance in the search field, and then click the Search button.
4. Select PanelView Plus 7 Performance, and then select B for the Series B firmware (C for Series C for Stainless Steel terminals).
5. Click the Show Downloads icon for the desired firmware version for PanelView Plus 7 Performance (Series B (Series C for Stainless Steel terminals)).

**TIP** Firmware for Series B terminals (Series C for Stainless Steel terminals) start at version 12.XXX.

6. Select and download the CAB Files for the desired firmware version.
7. After the .ZIP file has downloaded, extract the contents to the root of the USB Storage Device.

**TIP** Use a USB Storage Device with at least 8 GB of storage available. Any Windows file system (including FAT32 or NTFS) is acceptable.

8. Insert the removable storage device into one of the USB ports located at the bottom of the PanelView terminal.

9. On the PanelView terminal, in the Control Panel, select Settings, Firmware Updates, Switch to Firmware Update mode.

10. Tap Update from USB Storage and wait for the firmware update to complete.

Before the update starts, the terminal displays the warning message shown in the following graphic. As the message states, do not remove the USB storage device while the file is being copied. Wait until you are prompted to remove the USB storage device.
11. Tap OK when you are ready to continue.

While the firmware is updating, the terminal displays the update status. When the update is complete, the terminal displays the message shown in the following graphic.

![PanelView Plus Firmware Update Utility](image)

It is recommended that you remove the USB Storage device when prompted with the message shown in the image.

12. Tap OK to continue.

When the update is complete, the terminal reboots again and then displays the Password Entry screen.

13. Continue with [Enter a Password on page 69](#).

**ControlFLASH Client**

The following ControlFLASH clients are available to update the firmware:

- ControlFLASH Plus
- ControlFLASH

Before you can use ControlFLASH Plus or ControlFLASH, you must download the DMK file from the Product Compatibility and Download Center (PCDC).

**Downloading the ControlFLASH Plus or ControlFLASH File**

1. Access the Rockwell Automation Product Compatibility and Download Center (PCDC) at [rok.auto/pcdc](http://rok.auto/pcdc).
2. On the home page, click Available Versions.

3. Click the Select a Product link, and in the Select a Product dialog box, type PanelView Plus 7 Performance in the search field, and then click the Search button.

4. Select PanelView Plus 7 Performance, and then select B for the Series B firmware (C for Series C for Stainless Steel terminals).

5. Click the Show Downloads icon for the desired firmware version for PanelView Plus 7 Performance (Series B (Series C for Stainless Steel terminals)).

   **TIP** Firmware for Series B terminals (Series C for Stainless Steel terminals) start at version 12.XXX.

6. Select and download the DMK file for the desired firmware version.

7. Save the DMK file in the desired Firmware Kits location.

   The default location is C:\Users\Public\Documents\RockwellAutomation\Firmware Kits

8. On the PanelView terminal, in the Control Panel, select Settings, Firmware Updates, Switch to Firmware Update mode.

Using ControlFLASH Plus

For details about how to install ControlFLASH Plus software, see the ControlFLASH Plus Quick Start Guide, publication CFP-QS001.

**IMPORTANT** Use ControlFLASH Plus, version 4, or higher. The following procedure uses ControlFLASH Plus, version 4.

1. After you save the DMK file in the desired Firmware Kits location, launch ControlFLASH Plus.
2. Browse to and select the PanelView Plus 7 Performance Series B terminal (series C if it is a Stainless Steel terminal).
3. Click Next.
4. Confirm that the information is correct, and then click Flash.

A series of status changes occur on the ControlFLASH Plus screen and on the PanelView terminal.

On the ControlFLASH Plus screen, the Status field displays the Transmitting update status.

On the PanelView terminal, the status changes to CONNECTED: transferring updates...
Once the firmware file transmission is complete, on the ControlFLASH Plus screen, the Status field displays the Polling for power-up status.

![ControlFLASH Plus screen with Polling for power-up status](image)

On the PanelView terminal, the status changes to PLEASE WAIT: verifying and preparing updates...

![PanelView Plus Firmware Update Utility](image)

The PanelView terminal reboots, and on the ControlFLASH Plus screen, the Flash Results dialog box displays a Succeeded message.

![Flash Results dialog box](image)
5. Click Close, and then click Done.

When the firmware update is complete, the terminal reboots and displays moving gears while the update installs.

6. Continue with Enter a Password on page 69.

Using ControlFLASH

For information on how to install ControlFLASH, see the ControlFLASH User Manual, publication 1756-UM105.

To use the ControlFLASH software to update the firmware in a PanelView Plus 7 Performance Series B terminal (Series C for Stainless Steel terminals), follow these steps.

1. Click Start>Programs>FLASH Programming Tools>ControlFLASH.
2. Make sure that you know the required information in the Welcome dialog box, then click Next.

3. Select the catalog number of the PanelView Plus 7 Performance Series B (Series C for Stainless Steel terminals) terminal that you want to update and click Next.
4. Browse to and select the device to update on the EtherNet/IP™ network and click OK.

5. Select the firmware revision to install and click Next.

6. Read the Danger information in the Summary dialog, then click Finish.
7. Click Yes to confirm that you want to update the target device.

The update starts and can take several minutes to complete.

**IMPORTANT** Do not cycle power to the terminal during this process or the firmware update does not complete successfully.

When the firmware is sent to the terminal, the terminal resets and performs diagnostics.

The Update Status dialog box opens when the update is complete. If the update was successful, the Status area is green.

8. Click OK.

If the update fails, the status area is red and reads Update failure. For troubleshooting information, see the ControlFLASH User Manual, publication 1756-UM105.

9. Close the ControlFLASH software.

10. Continue with [Enter a Password on page 69](#).
Update DLR Network Switch Firmware (Series B Terminals Only)\(^{(1)}\)

The DLR Network Switch Firmware Update is new for Series B terminals (Series C for Stainless Steel terminals). This firmware is for the DLR functionality of the terminal and is separate from the System Firmware update. If the DLR functionality changes in the future, the update must be done using this process. If there is an update available, the .dmk file would be posted on the Product Compatibility and Download Center (PCDC) at rok.auto/pcdc.

This update must be done using Control Flash. It is not possible to do this update via USB flash drive as can be done with the System Firmware update.

To update the DLR Network Switch firmware, follow these steps.

1. On the PanelView terminal, in the Control Panel, select Settings Firmware Updates / Switch to Firmware Update mode.
2. In the DLR Network Switch Firmware section, click Start Update Utility.
3. In the Warning dialog box, click the OK button to proceed with the firmware update.

\(^{(1)}\) Series C for Stainless Steel terminals.
The first progress message appears briefly and indicates that the terminal is connecting to the DLR network switch.

The second progress message appears when the terminal is connected to ControlFLASH and the new firmware is being downloaded to the DLR Network Switch.

The third progress message appears when the download is complete. The terminal then automatically reboots.
4. On your PC, browse to and select the PanelView Plus 7 Performance Series B terminal\(^\text{(1)}\).

5. Click Next.

6. Confirm that the information is correct, and then click Flash.

TIP The Device description states PanelView Plus 7 Performance, PVP7P DLR Network Switch.

On the ControlFLASH Plus screen, the Status field displays the Transmitting update status.

\(^{\text{(1)}}\) Series C if it is a Stainless Steel terminal.
Once the firmware file transmission is complete, on the ControlFLASH Plus screen, the Flash Results dialog box displays a Succeeded message.

7. Click Close.
Chapter 8

Troubleshooting

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>View System Information</td>
<td>217</td>
</tr>
<tr>
<td>Status Indicators</td>
<td>218</td>
</tr>
<tr>
<td>View Network Status Information</td>
<td>219</td>
</tr>
<tr>
<td>Terminal Does Not Start Up</td>
<td>220</td>
</tr>
<tr>
<td>Terminal Restarts Intermittently</td>
<td>220</td>
</tr>
<tr>
<td>Touch Screen Issues</td>
<td>221</td>
</tr>
<tr>
<td>Display Issues</td>
<td>221</td>
</tr>
<tr>
<td>Ethernet Issues</td>
<td>222</td>
</tr>
<tr>
<td>Performance Is Slow</td>
<td>222</td>
</tr>
<tr>
<td>Resistance to Chemicals</td>
<td>222</td>
</tr>
<tr>
<td>Clean the Terminal Display</td>
<td>223</td>
</tr>
<tr>
<td>Ship the Terminal</td>
<td>224</td>
</tr>
<tr>
<td>Maintenance Mode Operations — Series A Terminals</td>
<td>224</td>
</tr>
<tr>
<td>Maintenance Mode Operations — Series B Terminals</td>
<td>225</td>
</tr>
</tbody>
</table>

**IMPORTANT** This document describes troubleshooting procedures for the PanelView® Plus 7 Performance terminal only. If your terminal is part of the ArmorView Plus 7 product, see the ArmorView Plus 7 Installation Instructions, publication 2711P-IN013, for instructions on how to gain physical access to the PanelView Plus 7 Performance terminal. After you gain access, follow the instructions in this chapter for troubleshooting the PanelView Plus 7 Performance terminal.

View system information for the terminal from FactoryTalk View ME Station runtime or from the Hardware Monitor (Series A only) in the control panel.

To view system information for the installed components, follow these steps.

1. Access FactoryTalk View ME Station runtime.
2. Tap Terminal Settings, then choose System Information> About FactoryTalk View ME Station.
Chapter 8

Status Indicators

The back of the terminal has two indicators to identify system status:
- STS indicator (green) indicates that the terminal is on and running
- ERR indicator (red) indicates hardware and firmware faults

At startup, the STS and ERR indicators flash on and off, then the STS indicator flashes to signal progress during startup. If the indicators remain off, check the power cable.

After a successful startup, the STS indicator remains on. Under normal operation, for Series A terminals, the STS indicator will stay on. For Series B terminals (Series C for Stainless Steel terminals), the STS indicator will blink.

Table 49 shows indicator states if the terminal stops during startup.

Table 49 - Fault Indicator States During Terminal Startup

<table>
<thead>
<tr>
<th>ERR (red)</th>
<th>STS (green)</th>
<th>Description</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blinking</td>
<td>Off</td>
<td>Recoverable firmware error.</td>
<td>Reload the firmware.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Recoverable configuration failure.</td>
<td>Restore the terminal to its factory default image. See Restore a Back-up Image on page 128.</td>
</tr>
<tr>
<td>On</td>
<td>On</td>
<td>Fatal hardware error.</td>
<td>Replace the terminal.</td>
</tr>
<tr>
<td></td>
<td>Blinking</td>
<td>Fatal display hardware error.</td>
<td>Replace the terminal.</td>
</tr>
</tbody>
</table>

The aluminum terminal is shown. The status indicators are the same on the stainless steel terminal.
View Network Status Information

Note: The system tray and Network Status Information dialog box described in the following procedure are available only to PanelView Plus 7 Performance Series A terminals.

Series A Terminals Only

To access network status information from the system tray, follow these steps.

1. Double-click the network icon in the system tray.

2. To view the network status, click the Network Status Information tab.

<table>
<thead>
<tr>
<th>Status Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port 1 status and Port 2 status</td>
<td></td>
</tr>
<tr>
<td>Gray</td>
<td>Disabled or unknown.</td>
</tr>
<tr>
<td>Green</td>
<td>Enabled and operating normally.</td>
</tr>
<tr>
<td>Yellow</td>
<td>A non-fatal error condition exists.</td>
</tr>
<tr>
<td>Red</td>
<td>An error condition exists that requires some manual intervention.</td>
</tr>
<tr>
<td>Network Status</td>
<td></td>
</tr>
<tr>
<td>Normal (green color)</td>
<td>If network topology is Linear/Star, the network status is always normal.</td>
</tr>
<tr>
<td>Ring Fault (yellow color)</td>
<td>A non-fatal error condition exists.</td>
</tr>
<tr>
<td>Loop Detected (red color)</td>
<td>This value can only occur in a Linear/Star topology. It occurs when an unexpected loop occurs in the network. It may not be possible for the terminal to report this condition (the terminal may not be capable of detecting frames that it has sent).</td>
</tr>
<tr>
<td>Partial Fault (yellow color)</td>
<td>A non-fatal error condition exists.</td>
</tr>
<tr>
<td>Rapid Fault (red color)</td>
<td>An error condition exists that requires some manual intervention.</td>
</tr>
<tr>
<td>General Information</td>
<td></td>
</tr>
<tr>
<td>Network Topology</td>
<td>Linear/Star</td>
</tr>
<tr>
<td>Ring</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 8

Series A and Series B Terminals (Series C for Stainless Steel terminals)

To access network status information from ME Station, see View the Network Diagnostic Data on page 91.

Terminal Does Not Start Up

If the terminal does not start up normally, check the table for possible causes.

Table 50 - Terminal Does Not Start Up Properly

<table>
<thead>
<tr>
<th>Check For</th>
<th>What to Do</th>
<th>See This Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insufficient power</td>
<td>Make sure that device is receiving adequate power.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Check the DC power requirements.</td>
<td>page 43</td>
</tr>
<tr>
<td></td>
<td>• Check the AC power requirements</td>
<td>page 44</td>
</tr>
<tr>
<td>Improper power wiring</td>
<td>Verify that the power wiring is correct.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Check the wiring specifications.</td>
<td>page 42</td>
</tr>
<tr>
<td></td>
<td>• Check the DC power wiring.</td>
<td>page 43</td>
</tr>
<tr>
<td></td>
<td>• Check the AC power wiring.</td>
<td>page 44</td>
</tr>
<tr>
<td>Status indicators</td>
<td>Check the status indicators during startup.</td>
<td>page 218</td>
</tr>
<tr>
<td>Stalled progress indicator</td>
<td>If a terminal stalls at the progress indicator and does not load an application or configuration screens, reload the firmware or restore factory defaults.</td>
<td>page 128</td>
</tr>
<tr>
<td>Object touching the display</td>
<td>Verify that nothing is pressing against the display or that you are not touching the display during startup.</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>

Terminal Restarts Intermittently

If the terminal restarts intermittently, check the table for possible causes.

Table 51 - Terminal Restarts Intermittently

<table>
<thead>
<tr>
<th>Check For</th>
<th>What to Do</th>
<th>See This Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Improper power wiring</td>
<td>Verify that the power wiring is correct.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Check the wiring specifications.</td>
<td>page 42</td>
</tr>
<tr>
<td></td>
<td>• Check the DC power wiring.</td>
<td>page 43</td>
</tr>
<tr>
<td></td>
<td>• Check the AC power wiring.</td>
<td>page 44</td>
</tr>
<tr>
<td>Over-temperature conditions</td>
<td>Make sure that the processor is not exceeding temperatures for normal terminal operations.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Check the processor temperature.</td>
<td>page 108 or 133</td>
</tr>
<tr>
<td></td>
<td>• Check the System Event log for over-temperature conditions.</td>
<td>page 107 or 133</td>
</tr>
<tr>
<td></td>
<td>• Check for adequate clearances around the terminal in the panel.</td>
<td>page 30</td>
</tr>
<tr>
<td></td>
<td>• Check for proper operating temperature.</td>
<td>page 133</td>
</tr>
</tbody>
</table>
Touch Screen Issues

If the touch screen is not responding correctly to touches with a finger or stylus, check the table.

### Table 52 - Touch Screen Not Responding

<table>
<thead>
<tr>
<th>Check For</th>
<th>What to Do</th>
<th>See This Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Improper calibration</td>
<td>Check for activation points that are offset from touch points. Calibrate the touch screen.</td>
<td>page 98 or page 156</td>
</tr>
<tr>
<td>Non-functioning touch screen</td>
<td>Check the touch screen for damage, such as cuts or excessive wear. If there is damage, replace the terminal.</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Touching multiple input elements</td>
<td>Application screens contain graphic input elements that are configured in the Machine Edition application. When touched, these elements perform operations in a predictable manner. For example, an input element is configured to navigate to a specific screen in the application or start a motor when touched. Multiple operations cannot be conducted simultaneously. Doing so results in an unintended operation. • Do not touch multiple input elements simultaneously. • Do not rest a hand or multiple fingers on the display.</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>

Display Issues

The display is unreadable or dims unexpectedly.

**ATTENTION:** If the display darkens, or if the backlight is not functioning properly, the screen can be difficult to read and use of this touch screen could result in a potentially hazardous outcome. Do not use the touch screen under these circumstances. The design of the system must take into account the possibility of the touch screen losing functionality and unable to be used to maintain or change control of the system. The touch screen shall not be the single point of control of critical functions and is not intended to replace an E-stop.

Design of the system should follow all applicable code and good engineering practice. Factors to consider include:

- The possibility of an unreadable touch screen
- The possibility of an inoperable touch screen
- Unexpected communication errors or delays
- Operator error in the control of the system
- Proper use of E-stops and other safety practices

The user shall provide means to achieve a safe state during anomalies and make sure the system has adequate redundancy for critical functions. Failure to follow these instructions can result in death, serious injury, or equipment damage.

### Table 53 - Dim Display

<table>
<thead>
<tr>
<th>Check For</th>
<th>See These Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low display brightness setting</td>
<td>page 95 or page 130</td>
</tr>
<tr>
<td>Low brightness level of screen saver</td>
<td>page 95 or page 130</td>
</tr>
<tr>
<td>Temperatures outside the operating range</td>
<td>page 108 or page 133</td>
</tr>
</tbody>
</table>
TIP  Extend the life of the backlight by reducing the display brightness, by using the screen saver with reduced brightness, or operating at lower temperatures.

**Ethernet Issues**

Table 54 provides tips for isolating Ethernet anomalies.

**Table 54 - Ethernet Connection Issues**

<table>
<thead>
<tr>
<th>Check for These Issues</th>
<th>What to Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status of invalid Ethernet connection</td>
<td>• Green indicator is on when a link is established.</td>
</tr>
<tr>
<td></td>
<td>• Yellow indicator blinks when activity is detected.</td>
</tr>
<tr>
<td></td>
<td>• Verify network connections.</td>
</tr>
<tr>
<td>Poor cable connections</td>
<td>Check the Ethernet cabling for the following:</td>
</tr>
<tr>
<td></td>
<td>• Make sure that cables are fully connected.</td>
</tr>
<tr>
<td></td>
<td>• Check for cable crimping.</td>
</tr>
<tr>
<td></td>
<td>• Check the Ethernet switch connections.</td>
</tr>
<tr>
<td></td>
<td>• Check the Uplink ports.</td>
</tr>
<tr>
<td>Invalid IP address of terminal</td>
<td>Go to Set the Ethernet Address of the Terminal on page 88. If DHCP is enabled, the terminal automatically acquires a valid IP address from the network after startup. The TCP/IP protocol automatically assigns 169.254.xxx.xxx when it fails to acquire an IP address from the network. In general, an IP address that begins with 169 does not support a network connection.</td>
</tr>
<tr>
<td>Conflicting IP addresses</td>
<td>If DHCP is not enabled and a static IP address is specified, make sure that the IP address does not conflict with the address of another device on the network.</td>
</tr>
</tbody>
</table>

**Performance Is Slow**

If the response time of the application is slow, for example screen changes or text display changes, check for the following issues:

- Application screens contain too many elements.
- If the controller is programmed for feedback, it can cause delays.
- Slow network performance or noise can result in retries.

**Resistance to Chemicals**

The outer surfaces of the terminal including the bezel, touch screen overlay, and panel gasket seal are tested for chemical resistance. Some of the chemicals can cause discoloration, but they do not interfere with the operation of the terminal.

TIP  For more information on chemical resistance of the product, go to [https://rockwellautomation.custhelp.com](https://rockwellautomation.custhelp.com) and search the Knowledgebase for keywords ‘Chemical Resistance PanelView Plus’.

**IMPORTANT**  Do not operate the terminal in direct sunlight. Direct exposure to ultraviolet light can discolor the touch screen.
Clean the Terminal Display

A protective overlay can help extend the life of the terminal and make it easier to clean the display. Table 6 on page 23 provides catalog numbers for overlays.

To clean the display, follow these steps.

1. Remove power from the terminal.
2. To clean the display and to help prevent scratches, use a clean sponge or soft cloth with mild soap or detergent.
3. To avoid water spots, dry the display with a chamois or moist cellulose sponge.

Remove Paint and Grease

To remove paint or grease from the bezel that is properly mounted in a NEMA, UL Type, or IP rated enclosure, follow these steps.

1. Rub lightly with isopropyl alcohol (70% concentration).
2. Use a mild soap or detergent solution to remove residue.
3. Rinse with clean water.

Equipment Wash Downs

ATTENTION: Do not use a high-pressure washer for cleaning the front bezel of the terminal. A high-pressure washer can damage the terminal.

Do not use a high-pressure washer for cleaning vented enclosures. Water can enter the enclosure and damage the terminal and other equipment.

Remove power from the terminal before performing any wash downs. It is possible for screen objects to activate during equipment wash downs if the terminal is powered on.

See Resistance to Chemicals on page 222 for information about exposure to chemicals.
Chapter 8

Ship the Terminal

If you ship the enclosure with the terminal installed, make sure that the terminal is properly secured and protected against damage from impact, sharp objects, or abrasive materials.

**ATTENTION:** Rockwell Automation is not responsible for damage to a product that is shipped or transported while installed in a panel or enclosure.

Maintenance Mode Operations — Series A Terminals

To start the system in Maintenance Mode for diagnostics and repairs, press and hold the white box that shows in the lower left corner of the display during startup.

**TIP** You can also access the Maintenance Mode menu if you attach a USB keyboard and hold down the F1 key.

If an ME application is set to run at terminal startup, press and hold the white box during startup to put the terminal into Safe Mode.

<table>
<thead>
<tr>
<th>Table 55 - Maintenance Mode Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operation</strong></td>
</tr>
<tr>
<td>None</td>
</tr>
<tr>
<td>Safe mode</td>
</tr>
<tr>
<td>Clear all data</td>
</tr>
<tr>
<td>Factory default</td>
</tr>
</tbody>
</table>

Perform maintenance operation in this order to diagnose and repair problems:

- **Safe mode** — stops an application from starting automatically.
- **Clear all data** — removes user-installed applications, user-configuration changes, and user accessible data.
- **Factory default** — returns the terminal to its out-of-box state.
To enter maintenance mode on your Series B terminal (Series C for Stainless Steel terminals), press the Maintenance button that is located on the back of your terminal any time while the terminal is powered up (see Hardware Features on page 14). This button is only available on Series B terminals (Series C for Stainless Steel terminals). It brings up the Maintenance Menu, which you use to restore factory defaults, backup and restore terminal settings, change the display orientation, and calibrate the touchscreen, etc.

Alternatively, the Maintenance Menu can be accessed in the Windows Control Panel, under Settings / System / Go To Maintenance Menu.

### Maintenance Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit Maintenance Menu</td>
<td>Exits Maintenance mode and continues with a normal restart.</td>
</tr>
<tr>
<td>Restore Terminal</td>
<td>Restores a snapshot of a terminal’s state from a USB storage device. The USB storage device must contain a file named PVP7P_Snapshot.wim on the root directory. This operation overwrites existing settings in the OS, FactoryTalk View ME Station, and user accounts.</td>
</tr>
<tr>
<td>Export Audit Logs</td>
<td>Exports logs of terminal information to a USB storage device. Creates a compressed file named PVP7P_AuditLogs.zip on the root of the USB storage device.</td>
</tr>
<tr>
<td>Factory Default</td>
<td>Restores the terminal to the original out-of-box condition.</td>
</tr>
<tr>
<td>Reinitialize Terminal</td>
<td>Resets all data and settings on the terminal.</td>
</tr>
<tr>
<td>Calibrate Touch Screen</td>
<td>Restarts the terminal and boots into the Calibration Menu.</td>
</tr>
<tr>
<td>Backup Terminal</td>
<td>Saves a snapshot of the current state of the terminal to a USB storage device. The USB storage device must be formatted to NTFS and have at least 16 GB of free space. The snapshot includes the OS, FactoryTalk View ME Station, all files, user accounts, programs, settings and data. It creates a file named PVP7P_Snapshot.wim on the root directory of the USB storage device. If this file already exists, it is overwritten.</td>
</tr>
<tr>
<td>Safe Mode</td>
<td>Reboots the terminal to the FactoryTalk View ME Station Configuration Mode. Rebooting the terminal again takes the terminal out of safe mode, and any ME app that was set to run at startup resumes running at startup.</td>
</tr>
<tr>
<td>Change Display Orientation</td>
<td>Changes the display orientation to either landscape (default), portrait, or portrait-flipped. Requires a terminal reboot to take effect.</td>
</tr>
</tbody>
</table>

(1) Series C for Stainless Steel terminals.
Appendix A

Fonts Resident on Terminal

True Type Fonts

The table lists TrueType fonts that are pre-installed on the terminals. The default system font is Tahoma.

**TIP**  
The Arial Unicode MS font contains almost 50,000 characters and provides default language support for many non-Latin languages and scripts including Arabic, Hebrew, Vietnamese, Thai, Hindi (Devanagari), and other Indic languages. The font also includes Chinese, Japanese, and Korean (CJK) support.

On Series A terminals, you can load additional fonts on the system by copying the font files to the \Windows\Fonts folder on the terminal desktop. To access this folder, open the My Device icon on the terminal desktop or choose Start>Programs>Windows Explorer.

**IMPORTANT**  
OpenType fonts (.otf) can contain many extra symbols and characters and can have large files sizes. If you install OpenType fonts, it can result in a reduction in available memory for applications. We recommend that you install only TrueType fonts. If you need an OpenType font, install only the font family that you want to use.

Table 56 - TrueType Fonts (.ttf and .ttc)

<table>
<thead>
<tr>
<th>Font Type</th>
<th>Font Name</th>
<th>File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Latin Fonts</td>
<td>Arial Unicode MS version 1.01</td>
<td>arialuni.ttf</td>
</tr>
<tr>
<td>Arial Black</td>
<td>arialk.ttf</td>
<td></td>
</tr>
<tr>
<td>Arial Bold</td>
<td>arialbd.ttf</td>
<td></td>
</tr>
<tr>
<td>Arial Bold Italic</td>
<td>arialbi.ttf</td>
<td></td>
</tr>
<tr>
<td>Arial Italic</td>
<td>ariali.ttf</td>
<td></td>
</tr>
<tr>
<td>Comic Sans MS</td>
<td>comic.ttf</td>
<td></td>
</tr>
<tr>
<td>Comic Sans MS Bold</td>
<td>comicbd.ttf</td>
<td></td>
</tr>
<tr>
<td>Courier New</td>
<td>Courier New (Subset 1_30)</td>
<td>cour_1_30.ttf</td>
</tr>
<tr>
<td>Courier New Bold</td>
<td>courbd.ttf</td>
<td></td>
</tr>
<tr>
<td>Courier New Bold Italic</td>
<td>courbi.ttf</td>
<td></td>
</tr>
<tr>
<td>Courier New Italic</td>
<td>couri.ttf</td>
<td></td>
</tr>
<tr>
<td>Font Type</td>
<td>Font Name</td>
<td>File Name</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Latin Fonts</td>
<td>Georgia</td>
<td>georgia.ttf</td>
</tr>
<tr>
<td></td>
<td>Georgia Bold</td>
<td>georgiab.ttf</td>
</tr>
<tr>
<td></td>
<td>Georgia Bold Italic</td>
<td>georgiaz.ttf</td>
</tr>
<tr>
<td></td>
<td>Georgia Italic</td>
<td>georgiai.ttf</td>
</tr>
<tr>
<td></td>
<td>Impact</td>
<td>impact.ttf</td>
</tr>
<tr>
<td></td>
<td>Kino</td>
<td>kino.ttf</td>
</tr>
<tr>
<td></td>
<td>Microsoft Logo</td>
<td>mslogo.ttf</td>
</tr>
<tr>
<td></td>
<td>Symbol</td>
<td>symbol.ttf</td>
</tr>
<tr>
<td>Tahoma</td>
<td>Tahoma (Subset 1_07)</td>
<td>tahoma_1_07.ttf</td>
</tr>
<tr>
<td></td>
<td>Tahoma Bold</td>
<td>tahomabd.ttf</td>
</tr>
<tr>
<td>Times New Roman</td>
<td>Times New Roman (Subset 1_30)</td>
<td>times_1_30.ttf</td>
</tr>
<tr>
<td></td>
<td>Times New Roman Bold</td>
<td>timesbd.ttf</td>
</tr>
<tr>
<td></td>
<td>Times New Roman Bold Italic</td>
<td>timesbi.ttf</td>
</tr>
<tr>
<td></td>
<td>Times New Roman Italic</td>
<td>timesi.ttf</td>
</tr>
<tr>
<td>Trebuchet MS</td>
<td>Trebuchet MS</td>
<td>trebuc.ttf</td>
</tr>
<tr>
<td></td>
<td>Trebuchet MS Bold</td>
<td>trebucbd.ttf</td>
</tr>
<tr>
<td></td>
<td>Trebuchet MS Bold Italic</td>
<td>trebucbi.ttf</td>
</tr>
<tr>
<td></td>
<td>Trebuchet MS Italic</td>
<td>trebucit.ttf</td>
</tr>
<tr>
<td>Verdana</td>
<td>Verdana</td>
<td>verdana.ttf</td>
</tr>
<tr>
<td></td>
<td>Verdana Bold</td>
<td>verdanab.ttf</td>
</tr>
<tr>
<td></td>
<td>Verdana Bold Italic</td>
<td>verdanaz.ttf</td>
</tr>
<tr>
<td></td>
<td>Verdana Italic</td>
<td>verdanai.ttf</td>
</tr>
<tr>
<td>Symbols</td>
<td>Webdings</td>
<td>webdings.ttf</td>
</tr>
<tr>
<td></td>
<td>Wingding</td>
<td>wingding.ttf</td>
</tr>
</tbody>
</table>
### Table 56 - TrueType Fonts (.ttf and .ttc) (Continued)

<table>
<thead>
<tr>
<th>Font Type</th>
<th>Font Name</th>
<th>File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PanelView™ Fonts</td>
<td>PV 12 x 24, PV 12 x 8</td>
<td>PV12x24.ttf, PV12x8.ttf</td>
</tr>
<tr>
<td></td>
<td>PV 16 x 24</td>
<td>PV16x24.ttf</td>
</tr>
<tr>
<td></td>
<td>PV 18 x 16, PV 18 x 8</td>
<td>PV18x16.ttf, PV18x8.ttf</td>
</tr>
<tr>
<td></td>
<td>PV 24 x 32</td>
<td>PV24x32.ttf</td>
</tr>
<tr>
<td></td>
<td>PV 32 x 40, PV 32 x 64</td>
<td>PV32x40.ttf, PV32x64.ttf</td>
</tr>
<tr>
<td></td>
<td>PV 4 x 6</td>
<td>PV4x6.ttf</td>
</tr>
<tr>
<td></td>
<td>PV 6 x 16, PV 6 x 24, PV 6 x 8, PV 6 x 9</td>
<td>PV6x16.ttf, PV6x24.ttf, PV6x8.ttf, PV6x9.ttf</td>
</tr>
<tr>
<td></td>
<td>PV 8 x 16, PV 8 x 20, PV 8 x 24</td>
<td>PV8x16.ttf, PV8x20.ttf, PV8x24.ttf</td>
</tr>
<tr>
<td></td>
<td>PV Double High</td>
<td>P double_high.ttf</td>
</tr>
<tr>
<td></td>
<td>PV Double Wide</td>
<td>P double_wide.ttf</td>
</tr>
<tr>
<td></td>
<td>PV Extra Large</td>
<td>P extra_large.ttf</td>
</tr>
<tr>
<td></td>
<td>PV Large</td>
<td>P large.ttf</td>
</tr>
<tr>
<td></td>
<td>PV Small</td>
<td>P small.ttf</td>
</tr>
<tr>
<td></td>
<td>PV Tiny</td>
<td>P tiny.ttf</td>
</tr>
<tr>
<td></td>
<td>PV Very Tiny</td>
<td>P very_tiny.ttf</td>
</tr>
<tr>
<td>East Asian Fonts</td>
<td>Gulim version 2.21 - Korean</td>
<td>gulim.ttc</td>
</tr>
<tr>
<td></td>
<td>MS Gothic version 2.30 - Japanese</td>
<td>gulim.ttc</td>
</tr>
</tbody>
</table>
Notes:
Languages Supported

On Series B terminals (Series C for Stainless Steel terminals), the Maintenance Menu and Windows 10 Control Panel are only available in English. The Windows 10 Control Panel will be updated in the future to support additional languages.

The following languages are supported in Machine Edition (ME) Station:

Table 57 - Available Languages

<table>
<thead>
<tr>
<th>Language</th>
<th>Series A</th>
<th>Series B (1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Afrikaans (South Africa)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Albanian (Albania)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Arabic (Algeria)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Arabic (Bahrain)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Arabic (Egypt)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Arabic (Iraq)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Arabic (Jordan)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Arabic (Kuwait)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Arabic (Lebanon)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Arabic (Libya)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Arabic (Morocco)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Arabic (Oman)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Arabic (Qatar)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Arabic (Saudi Arabia)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Arabic (Syria)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Arabic (Tunisia)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Arabic (U.A.E.)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Arabic (Yemen)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Armenian (Armenia)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Azeri (Cyrillic) (Azerbaijan)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Azeri (Latin) (Azerbaijan)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Basque (Spain)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Belorussian (Belarus)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Bulgarian (Bulgaria)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Catalan (Spain)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Chinese (Hong Kong S.A.R.)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Chinese (Macau S.A.R.)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Chinese (People’s Republic of China)</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
### Table 57 - Available Languages (Continued)

<table>
<thead>
<tr>
<th>Language</th>
<th>Series A</th>
<th>Series B(1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chinese (Singapore)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Chinese (Taiwan)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Croatian (Croatia)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Czech (Czech Republic)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Danish (Denmark)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Dutch (Belgium)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Dutch (Netherlands)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>English (Australia)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>English (Belize)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>English (Canada)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>English (Caribbean)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>English (Ireland)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>English (Jamaica)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>English (New Zealand)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>English (Republic of the Philippines)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>English (South Africa)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>English (Trinidad and Tobago)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>English (United Kingdom)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>English (United States)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>English (Zimbabwe)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Estonian (Estonia)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Faroese (Faroe Islands)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Farsi (Iran) (also known as Persian)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Finnish (Finland)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>French (Belgium)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>French (Canada)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>French (France)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>French (Luxembourg)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>French (Principality of Monaco)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>French (Switzerland)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>FYRO Macedonian (Former Yugoslav Republic of Macedonia)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Georgian (Georgia)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>German (Austria)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>German (Germany)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>German (Liechtenstein)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>German (Luxembourg)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>German (Switzerland)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Greek (Greece)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Gujarati (India)</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
### Table 57 - Available Languages (Continued)

<table>
<thead>
<tr>
<th>Language</th>
<th>Series A</th>
<th>Series B&lt;sup&gt;(1)&lt;/sup&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hebrew (Israel)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Hindi (India)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Hungarian (Hungary)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Icelandic (Iceland)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Indonesian (Indonesia)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Italian (Italy)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Italian (Switzerland)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Japanese (Japan)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Kannada (India)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Kazakh (Kazakhstan)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Konkani (India)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Korean (Korea)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Kyrgyz (Kyrgyzstan)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Latvian (Latvia)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Lithuanian (Lithuania)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Malay (Brunei Darussalam)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Malay (Malaysia)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Marathi (India)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Mongolian (Mongolia)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Norwegian (Bokmål) (Norway)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Norwegian (Nynorsk) (Norway)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Polish (Poland)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Portuguese (Brazil)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Portuguese (Portugal)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Punjabi (India)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Romanian (Romania)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Russian (Russia)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Sanskrit (India)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Serbian (Cyrillic) (Serbia and Montenegro)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Serbian (Latin) (Serbia and Montenegro)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Slovak (Slovakia)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Slovenian (Slovenia)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Spanish (Argentina)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Spanish (Bolivia)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Spanish (Chile)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Spanish (Colombia)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Spanish (Costa Rica)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Spanish (Dominican Republic)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Spanish (Ecuador)</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
**Table 57 - Available Languages (Continued)**

<table>
<thead>
<tr>
<th>Language</th>
<th>Series A</th>
<th>Series B&lt;sup&gt;(1)&lt;/sup&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spanish (El Salvador)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Spanish (Guatemala)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Spanish (Honduras)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Spanish (Mexico)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Spanish (Nicaragua)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Spanish (Panama)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Spanish (Paraguay)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Spanish (Peru)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Spanish (Puerto Rico)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Spanish (Spain)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Spanish (Uruguay)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Spanish (Venezuela)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Swahili (Kenya) (also known as Kiswahili)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Swedish (Finland)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Swedish (Sweden)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Tamil (India)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Tatar (Russia)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Telugu (India)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Thai (Thailand)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Turkish (Turkey)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Ukrainian (Ukraine)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Urdu (Islamic Republic of Pakistan)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Uzbek (Cyrillic) (Uzbekistan)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Uzbek (Latin) (Uzbekistan)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Vietnamese (Viet Nam)</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

<sup>(1)</sup> Series C for Stainless Steel terminals.
Symbols

mer application 73, 74, 78, 86

A
access configuration mode
from an HMI application 74
from the Windows desktop 74
Goto Configuration Mode button 74
accessories 23
ActiveX controls 18, 123
alarms 107
application
backup 126
checking integrity 106
restore 126
atmospheric gases ignition temperature 27
authenticating client connections 136

B
back-up image 128
back-up power 185
battery
back-up power 185
conditions 133
lithium 185
replacement 186
view voltage 133
voltage 108
warnings 153
boot options 154
branch circuit 26
button styles 154

C
cable
  capacitance 28
  inductance 28
  length between the Ethernet ports 46
calibration
touch screen 98, 156
catalog numbers
  accessories 23
  battery replacement 24
  mounting hardware 23
  PanelView Plus 7 performance terminals 22
  power supplies 23
  power terminal blocks 23
  protective overlays 23
  SD cards 24
circuit breaker rating 26
clear all data 224
closed system 19, 154
command prompt
  Foxitreader 158
  parameters 158
  syntax 158
  configuration mode 19
control panel
touch screen calibration 156
cutout dimensions 30

D
date
  settings
  date 112
DC power bus 43
desktop
  rotate 131
desktop access
  disable 81
  enable 79
  factory default state 19
  open versus closed 19
  reset password 83
  restrict 80, 82
  set password 82
device name
terminal 92
DHCP 88
diagnostics
  advanced 155
  configure 105
display settings
  control panel 129

earth ground
  AC 45
  DC 44
electrostatic discharge 177
environment and enclosure notice 26
error indicator 218
ESD
  preventing 177
Ethernet
  connector pinout 47
  driver 87
  duplex setting 89
  link speed 87
  status indicators 47
Ethernet cables 24
event log
  errors 132
  events 132
  warnings 132
explosion hazard 42, 183, 186

F
FactoryTalk View ME
  check file integrity 106
diagnostics 106
fault indicators
  firmware 218
  hardware 218
file server
  configuration 151
firmware upgrades
  fail 202
  firmware upgrade wizard 195
  over network 199
  using storage device 195
fonts 227
Foxitreader 158
FTP security options 149
FTP server
  configuration 148
  parameters 148
  security 148
FUP 194
fuse rating 26
FUW 194

G
galvanic isolation 178

H
hardware specifications
  audio out 15
  Ethernet ports 14
  mounting slot 14
  SD card slot 15
  status indicators 15
  USB device port 15
  USB host ports 15

I
indicator
  ERR 218
  STS 218
input panels 124
IP address
  assign 88

K
KEPServer drivers 152, 197, 201

L
ladder logic 9
language 113
  setting 113
lithium batteries
  handling 153
logs
  application files 106
  runtime files 106

M
maintenance mode 224
ME 9
mount the terminal
  ambient temperature 27
  in a panel 30
  location considerations 27
  minimum clearances 30
  preparation 31

N
network
  file servers 151
  FTP servers 148
  topologies 20
  VNC servers 138
network topology
  device-level ring 48
  linear 49
  star 50

O
open system 19
open versus closed system 19

P
PDF reader 157
power
  AC
    connection 44
    ratings 14, 44
    terminal block 42
  DC
    connection 43
    ratings 14, 43
    terminal block 42
  PELV 43
  SELV 43
  supplies 23
print setup 102
printers 179
product compatibility and download center 10
protective overlay
  catalog numbers 23
  cleaning 189
  installing 188
  removing 189
publications
  download 11

R
release notes 10
RJ45 connector 46

S
safe mode 154, 224
safety notices
  earth ground 43, 44
  electrical arc 42, 46
  electrical shock 42, 44, 177
  emergency stops 25
  explosion hazard 27, 42, 46
  wiring and safety guidelines 26

screen
  rotate 131
screen saver 95
SD card
  installing 183
server
  addresses 90
  enable/disable 137
  file 151
  ftp 148
settings
  appearance 130
  background image 129
  backlight intensity 130
  cursor 131
  language 113
  screen saver 130
  time 112
  time zone 111
shell options 153
soft keyboard controls 77
software versions
  FactoryTalk View Machine Edition (ME)
    Station 17
  FactoryTalk View Studio for Machine Edition
    17
  FactoryTalk ViewPoint 17
startup
  configure 19
  options 20
  sequence 50
startup options 20
static-safe workstation 177
status indicators 218
system
  information 217
  status 218
system event log 107

T
technical support 110
temperature
  code T4 27
  over-temperature messages 108
  view 108
  view current temperature 133
time 112
time zone 111
touch screen
  calibrate 156
  calibration 98
  gestures
    double-tap 17
    drag 17

U
USB
  cables 179
  host ports 28, 178
  hubs 179
  printer 179
USB ports
  installation 28
USB to serial port adapters 24
user accounts 136

V
virtual keyboard 16
VNC
  configure 138
  connection password 139
  connection passwords 139
  control passwords 141
  server parameters 138
  view-only password 141

W
watchdog errors 155
Web server parameters 147
wiring and safety guidelines 26
Rockwell Automation Support

Use these resources to access support information.

<table>
<thead>
<tr>
<th>Technical Support Center</th>
<th>Find help with how-to videos, FAQs, chat, user forums, and product notification updates.</th>
<th>rok.auto/support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledgebase</td>
<td>Access Knowledgebase articles.</td>
<td>rok.auto/knowledgebase</td>
</tr>
<tr>
<td>Local Technical Support Phone Numbers</td>
<td>Locate the telephone number for your country.</td>
<td>rok.auto/phonesupport</td>
</tr>
<tr>
<td>Literature Library</td>
<td>Find installation instructions, manuals, brochures, and technical data publications.</td>
<td>rok.auto/literature</td>
</tr>
<tr>
<td>Product Compatibility and Download Center (PCDC)</td>
<td>Download firmware, associated files (such as AOP, EDS, and DTM), and access product release notes.</td>
<td>rok.auto/pcdc</td>
</tr>
</tbody>
</table>

Documentation Feedback

Your comments help us serve your documentation needs better. If you have any suggestions on how to improve our content, complete the form at rok.auto/docfeedback.

Waste Electrical and Electronic Equipment (WEEE)

At the end of life, this equipment should be collected separately from any unsorted municipal waste.

Rockwell Automation maintains current product environmental compliance information on its website at rok.auto/pec.

Allen-Bradley, ArmorBlock, ArmorView, CompactLogix, ControlLogix, expanding human possibility, FactoryTALK, FLEX, Kinetix, PanelView, POINTI/P, PowerFlex, Rockwell Automation, RSLinx, Stratix, and Studio 5000 Logix Designer are trademarks of Rockwell Automation, Inc.

CIP Sync EtherNet/IP are trademarks of ODVA, Inc.

Microsoft and Windows are trademarks of Microsoft Corporation.

SD and SDHC are trademarks of SD-3C LLC.

Trademarks not belonging to Rockwell Automation are property of their respective companies.

Rockwell Otomasyon Ticaret A.Ş., Kar Plaza İş Merkezi E Blok Kat:6 34752, İçerenköy, İstanbul, Tel: +90 (216) 5698400 EEE Yönetmeliğine Uygundur

Connect with us.  

rockwellautomation.com —— expanding human possibility

AMERICAS: Rockwell Automation, 1201 South Second Street, Milwaukee, WI 53204-2406 USA, Tel: (1) 414.382.2000, Fax: (1) 414.382.4444
EUROPE/MIDDLE EAST/AFRICA: Rockwell Automation NV, Pegasus Park, De Kleetlaan 12a, 1831 Diegem, Belgium, Tel: (32) 2 663 0600, Fax: (32) 2 663 0640
ASIA PACIFIC: Rockwell Automation, Level 14, Core F, Cyberport 3, 100 Cyberport Road, Hong Kong, Tel: (852) 2887 4788, Fax: (852) 2508 1846

Publication 27IP-UM008J-EN-P - April 2022
27IP-UM008J-EN-P - February 2022
Copyright © 2022 Rockwell Automation, Inc. All rights reserved. Printed in the USA.